iontorrent

lon AmpliSeg™ & lon AmpliSeg™ HD Custom

Assay
USER GUIDE

For sequencing on the Genexus™ Integrated Sequencer

for use with:

lon AmpliSeq™ Community Panels
lon AmpliSeq™ Made-to-Order Panels
lon AmpliSeq™ On-Demand Panels

Custom lon AmpliSeg™ & lon AmpliSeq™ HD Panels
Publication Number MAN0028005

Revision B

ThermoFisher
For Research Use Only. Not for use in diagnostic procedures. SCIENTIFIC



Thermo Fisher Scientific GENEART GmbH | Products manufactured at this site:
Im Gewerbepark B35 |

93059 Regensburg | ®* Jon AmpliSeg™ On-Demand Panel
Germany

Life Technologies Corporation | Products manufactured at this site:
7335 Executive Way | )

Frederick, Maryland 21704 USA ® lon AmpliSeg™ Custom panels

® Jlon AmpliSeg™ HD Custom panels
® |on AmpliSegq™ HD Made-to-Order panels
® lon AmpliSeg™ Community Panels

For descriptions of symbols on product labels or product documents, go to thermofisher.com/symbols-definition.
Revision history: MAN0028005 B (English)

Revision Date Description

B 9 July 2024 Updated HD library amplification cycle setting guidelines. See “Guidelines for using custom assays with the
Genexus™ Integrated Sequencer” on page 32.

A.0 12 June 2023 Initial release.

The information in this guide is subject to change without notice.

DISCLAIMER: TO THE EXTENT ALLOWED BY LAW, THERMO FISHER SCIENTIFIC INC. AND/OR ITS AFFILIATE(S) WILL NOT BE
LIABLE FOR SPECIAL, INCIDENTAL, INDIRECT, PUNITIVE, MULTIPLE, OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR
ARISING FROM THIS DOCUMENT, INCLUDING YOUR USE OF IT.

Important Licensing Information: These products may be covered by one or more Limited Use Label Licenses. By use of these
products, you accept the terms and conditions of all applicable Limited Use Label Licenses.

Trademarks: All trademarks are the property of Thermo Fisher Scientific and its subsidiaries unless otherwise specified.

Agencourt and AMPure are trademarks of Beckman Coulter, Inc. Bioanalyzer and Agilent are trademarks of Agilent Technologies,

Inc. Eppendorf LoBind is a trademark of Eppendorf AG. Tecan and Freedom EVO are trademarks of Tecan Group Ltd. TagMan is a
trademark of Roche Molecular Systems, Inc., used under permission and license.

©2023-2024 Thermo Fisher Scientific Inc. All rights reserved.


https://www.thermofisher.com/symbols-definition

Contents

B CHAPTER 1 Productinformation ... 7
lon AMPIISEG™ PANEIS . . oottt e 7
About lon AmpliSeq™ DeSigNer . ... ..o e e 7

lon AMPlISEeq™ Panels . . ..ot e 7

lon AmpliSeq™ Custom panel designs . .......c.ovuiiiiiii i 8

lon AmpliSeq™ On-Demand Panel designs ............coiiiiiiiiiineiinennnn 8

lon AmpliSeq™ Community Panels . ............ it 9

lon AmpliSeq™ HD Made-to-Order panels ...........ciiiiiiiiiii i 9
WOrKEIOW . o e 10
B CHAPTER 2 Reagents, supplies, and required materials ...................... 12
Genexus™ Integrated SeqUENCEr . ... ...ttt 12
Reagents and supplies—lon AmpliSeq™ library chemistry ........................... 12
Genexus™ Library Strips 1 and 2-AS .. ... e 13
Genexus™ BarCodes AS . ... ittt e 13
Genexus™ GX5™ Starter Pack-AS . ... ... i 14
Genexus™ GX7™ Starter Pack-AS . ... ... i 14
Reagents and supplies—lon AmpliSeq™ HD library chemistry ........................ 15
Genexus™ Library Strips1and 2-HD . ... ... o i 15
Genexus™ Barcodes 1-82 HD . ... ..ttt e e 16
Genexus™ GX5™ Starter Pack-HD ... ... e 16
Genexus™ GX7™ Starter Pack-HD . ... ... ... i 16
Shared reagents and supplies . ... .o 17
Genexus™ Templating Strips 3-GX5™ and 4 . ... ....coiiiiii i 17
Genexus™ Templating Strips 3-GX7™ and 4 ...t 18
Genexus™ Primer Pool Tubes and Pipette Tips ..o 18
GX5™ Chip and Genexus™ CoUpIer . ... ...t e 19
GX7™ Chip and Genexus™ Coupler . ...t i et 20
Genexus™ Sequencing Kit . ... e 20
Genexus™ Conical Bottles ... e 21
GenexUS™ Filter . ... e 21
GeneXUS™ CONtrOlS ...ttt e 21
Required materials—general laboratory equipment and supplies ..................... 22
Recommended materials for nucleic acid isolation and quantification ................. 23

lon AmpliSeq™ & lon AmpliSeg™ HD Custom Assay User Guide 3



Contents

B CHAPTER 3 Beforeyoubegin .........oviviiiiiiiii i 25
PreCaUtioNS . . ... s 25

Avoid nucleic acid contamination ........... ... 25

Avoid strong electromagnetic radiation ......... ... .. . o i 25

Protection by equipment . ... . e 25

Guidelines for panel and reagentuse and handling ........... ... oo it 26

Guidelines for preventing contamination .......... ... ... i i i 27

Guidelines for Genexus™ Integrated Sequencer operation ........................... 28

Guidelines for expired reagents and chips ......... .. i 30

Guidelines for nucleic acid isolation and quantification—Nucleic Acid to Result runs . ... 31

B CHAPTER 4 Guidelines for setting up custom assays and sequencing

runs on the Genexus™ Integrated Sequencer .............covviiiiiiiiininnnnn.. 32
Guidelines for using custom assays with the Genexus™ Integrated Sequencer ......... 32
Planning sequencing runs for efficient use of consumables .......................... 35
Guidelines for chip selection . ... ... . i e 36
lon AmpliSeq™ HD sequencing experimentdesign ........... ..., 36
Molecular tag sequencing technology—Important factors ........................... 37

B CHAPTER 5 Assays for use with custom panel files ........................... 39
Importoradd acustom panel ....... ... i 39
Import a custom panel file from Ampliseq.com to Genexus™ Software ............ 41

Add a custom DNA panel file to Genexus™ Software ........................... 43
Add a custom Fusions panel file to Genexus™ Software ......................... 44
Obsolete panels (manager/administrator) .......... ... ... i, 45
Reactivate panels (manager/administrator) ........... ... .. i, 45

Add individual custom panel files to Genexus™ Software ............................ 45
Add reference genome files (manager/administrator) ........................... 46
Add individual target regions files to Genexus™ Software ....................... 46
Hotspots files for use with lon AmpliSeq™ and lon AmpliSeq™ HD custom panels .. 47
Sequence variant baselines . ... 49
Filter chains for use with lon AmpliSeq™ custompanels ............................. 53
Custom assay Creation . . ... ..ot e 54
Create an assay in Genexus™ Software for use with a custompanel .............. 56
Create a liquid biopsy assay in Genexus™ Software ................ ..., 72
Copy an assay (manager/administrator) ............ ... i i i 73
MaANAGE 8SSaAYS . . vt ittt it e 73
View assay details . ... ... e 75
Import an assay (manager/administrator) ........... .. .. . i i 77
Export a custom, locked assay (manager/administrator) ........................ 77
Download assay parameters . . ... ...t e 77

4 lon AmpliSeq™ & lon AmpliSeqg™ HD Custom Assay User Guide



Contents

B CHAPTER G Plan arun ..ottt e e e 78

Before you plan a run ... ... o e e 78

Enter samples in the Genexus™ Software ........ ... ... i i 78

FINd Samples . ..o e 79

Create a new SamPle . ... oo e 82

IMPOrt SAMPIES . . .o e 83

Download a template file for sample creation ......... ... .. ... ... ... .. ... 85

Upload a BAM file to create a sampleorsamples ....... ... .. oo .. 85

Plan a Nucleic Acidto Resultrun . ... .. .. i 86

Plan a Library to Result run .. ... o s 91

Plana BAMto Result run ... ... e 94

B CHAPTER7 Loadthesampleplate ........cccovviiiiiiiiiiiiii i 95
Dilute or concentrate the samples, if needed, then load the sample plate—

Nucleic Acidto Result run . . ... o e 95

Dilute and pool libraries, then load the sample plate—Library to Resultrun ............ 97

Guidelines for library quantification—Library to Resultruns ..................... 97

B CHAPTER 8 Load the sequencerand startarun.....................oooill 98

Before YyoU Degin .. ..ot e 98

Fill Genexus™ Primer POl TUDES . . ..ottt i ettt iia e 101

Load the sequencerand startarun .......... ... i 102

Clear the instrument deck and perfforma UV Clean ............ ... ..., 109

Options for an expired sequencer initialization .......... .. ... ... .. i i, 112

B CHAPTER9 Reviewdataandresults ...........cooiviiiiiiiiiiiiiiiinnnnnnn.. 114

Example resUS . ... e 115

Results navigation baroverview . ......... .. e 116

Review sample results . ... e 118

Download results files forasampleresult ...... ... .. ... ... i, 119

VieW the rUn SUMMIArY . ... e e e ettt ettt 123

The FUN SUMIMAIY .. e e e et e e ettt e et eaaens 124

Review run resSUS . .. ... o e e 127

AssigNn PCR Plate . .. ..o 128

View assay metrics andtherunreport ... o i e 129

Assay metricsandtherunreport ......... .. i e 129

View SequENCINg reSUItS ... ... o e 134

View the QO resUs .. ...t e e e 134

View Key findings . ... ..o 139

View SNV/INDEL results . ... ..ot e et et 144

View fuSION reSUS . ... oo e 148

lon AmpliSeq™ & lon AmpliSeg™ HD Custom Assay User Guide 5



Contents

View more annotations and annotation sources ........... ... .. . il 151
Review the variant pileup view . ... ... 152
Create and assign variant classifications .............. ... .. ... .. o i .. 159
Filter resUItS . . .. e 160
Varant FEPOM . . e 162
View a variant report .. ... e 162
Generate avariant report . ... .. e 163
Reanalyze arun .. ... o e 164
Reanalyze a sample ... ... e 165
Plugins for data analysis . ..........c.c i e 166
Review coverageAnalysis pluginresults ......... ... . i 166
Review molecularCoverageAnalysis pluginresults .................. ... .c..... 170
Customer SUPPOIt ArChive . ... .o e 172
Upload results files to another Genexus™ Integrated Sequencer ..................... 173
APPENDIX A Troubleshootingand FAQS ........c.iiiiiiiiiiii i 174
APPENDIX B Supplemental procedures .........c.covvviiiiiiiiiiiiiiiniennnnn. 175
Expand any lon AmpliSeq™ panel by adding a spike-inpanel ....................... 175
lon AmpliSeq™ Sample ID Panel . ... e e e 176
Add the lon AmpliSeq™ Sample ID Panel to a DNA Custom panel ............... 176
samplelD plugin . . ... s 177
Quantify FFPE DNA with the Qubit™ Fluorometer ........ ... ... ... ... .. il 179
Centrifuge library and templating reagent strips using the Genexus™ Strip
Centrifuge Adapter ... .. o e 180
Genexus™ consumables usetables ....... ... i i i 181
lon AmpliSeq™ HD consumables usetables ............ ... .., 184
APPENDIX C Safety ..o ettt 186
Chemical safety . ... e 187
Biological hazard safety . ........ i s 188
Documentation and SUPPOI .....c.iieii i 189
Customer and technical SUPPOrt . ...ttt i e et e 189
Limited product warranty . ........... i e 189

6 lon AmpliSeq™ & lon AmpliSeqg™ HD Custom Assay User Guide



ll Product information

B 1on AMPISEq ™ PaANEIS . ..ottt e 7
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IMPORTANT! Before using this product, read and understand the information in the “Safety” appendix
in this document.

lon AmpliSeq™ panels

Order lon AmpliSeg™ panels using lon AmpliSeq™ Designer. For more information, visit AmpliSeq.com.

About lon AmpliSeq™ Designer

lon AmpliSeg™ Designer provides tools for designing and ordering next-generation sequencing (NGS)
panels for targeted sequencing applications. Multiple design ordering options are available, from fixed
pre-tested panels that are ready-to-order to fully customizable designs. lon AmpliSeq™ Designer also
provides a variety of public reference genomes for use in design creation as well as an option to upload
a custom FASTA format reference sequence.

When your designs are finalized, lon AmpliSeq™ Designer connects you directly to the Thermo Fisher
Scientific ordering pipeline.

lon AmpliSeq™ Designer Help (Pub. No. MAN0018937) provides information for using lon AmpliSeq™
Designer to design and order panels.

lon AmpliSeq™ panels

lon AmpliSeq™ panels provide pools of primers for the amplification of target regions. The primers
contain proprietary modifications that enable removal of primer sequences during library preparation for
efficient target assessment during sequencing. Multiple primer pools can be used to create overlapping
amplicons that enable complete coverage of large targets. Panels are designed to be used with nucleic
acid from various sources, including nucleic acid from formalin-fixed paraffin-embedded (FFPE) tissue
and cell-free DNA (cfDNA).

lon AmpliSeq™ panels are ordered using lon AmpliSeq™ Designer. Users who are interested in inherited
disease or germline research applications can design and order panels using a content selection engine
or by uploading their own gene list. The gene designs in the On-Demand catalog have been optimized
for high performance. For additional information, see “lon AmpliSeq™ On-Demand Panel designs” on
page 8 or visit AmpliSeq.com.
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https://www.ampliseq.com
https://www.ampliseq.com

Chapter 1 Product information
lon AmpliSeq™ panels

The following types of panels are compatible with the Genexus™ Integrated Sequencer.

In stock Made-to-order Fixed panels
Product and - . .
lon AmpliSeq™ . . lon AmpliSeq™ lon AmpliSeq™
description On-Depmang lon AmpliSeq™ | lon AmpliSeq™ HD Comnr:unit;;I Ready-‘:o-U:e
Custom panels Custom panels
Panels Panels Panels
Genome Human Any Human Human Human
Nucleic Acid DNA only DNA/RNA DNA/RNA DNA/RNA DNA/RNA
Sample type Genomic DNA Any cfDNA/FFPE Any Any
Target type Genes Genes, regions, Genes, regions, Genes, regions, | Genes, regions,
hotspots, fusions | hotspots, fusions | hotspots, fusions | hotspots, fusions

lon AmpliSeq™ Custom panel designs

lon AmpliSeq™ Custom panel designs are customizable for any genome at the amplicon level. Panels
can be designed against a number of pre-loaded reference genomes, or for any other organism by
uploading a FASTA file reference sequence.

Custom panels are delivered within a few weeks in tubes of pre-pooled, multiplexed primers in ready-

to-use concentrations.

Custom panel type

# of oligos / pool

# of tubes / pool

Concentration

Storagel']

DNA <192 5x1.5mL 2X
=193 20 x 1.5 mL 2X
RNA - 3 x1.5mL 5X

-30°C to -10°C

[ Shipped at ambient temperatur

e. Store as indicated.

To determine the number of samples that can be sequenced per lane on either the GX5™ Chip or
GX7™ Chip for a custom panel design, see Chapter 4, “Guidelines for setting up custom assays and
sequencing runs on the Genexus™ Integrated Sequencer”.

lon AmpliSeq™ On-Demand Panel designs

lon AmpliSeg™ On-Demand designs are suitable for common disease research areas and are
customizable at the gene level. The designs include optimized amplicons with verified performance
for germline analysis. You can create designs by selecting from a catalogue of >5,000 pre-tested genes

or browsing the lon AmpliSeg™ Designer gene repository by research area of interest.

Each lon AmpliSeg™ On-Demand Panel consists of 2 DNA primer pools, where the number of primer
pairs per pool depends on the genes that are selected. The maximum number of genes that can be
selected for design creation is 800. Each lon AmpliSegq™ On-Demand panel order is limited to either
500 genes or a maximum of 15,000 amplicons. The minimum number of amplicons per design is 12 per

pool.
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lon AmpliSeq™ panels

You can add genes that are not in the On-Demand catalog to your panel as a Spike-in panel. Spike-in
panels are high concentration Made-To-Order panels that are used to supplement On-Demand designs
with genes that are not available On-Demand. Spike-in panels are created as 2-pool designs and are
limited to 123 amplicons per pool.

lon AmpliSeq™ On-Demand panels are available in 24 reaction packs for library preparation (in
combination with 48 barcode plates on the GX5™ Chip and with any barcode plate on the GX7™ Chip)
on the Genexus™ Integrated Sequencer. The panels support sequencing genomic targets from as little
as 10 ng of DNA input.

lon AmpliSeq™ Community Panels

lon AmpliSegq™ Community Panels are DNA and RNA panels that are predesigned for germline or
somatic analysis. Designed with input from leading disease researchers and verified for performance,
these panels are appropriate for a wide range of research areas, including inherited diseases, cancer
research, human identification, infectious diseases, pharmacogenomics, developmental disorders,
inflammation and immune response research, and more.

lon AmpliSeq™ Community Panels are customizable, giving you the flexibility to add or remove genes
and amplicons to fit your unique project requirements, and are available to ship within a few weeks.

lon AmpliSeq™ HD Made-to-Order panels

lon AmpliSeg™ HD Made-to-Order panels provide pools of primers for amplification of custom target
regions to generate tagged targeted amplicon libraries for use as part of the lon AmpliSeq™ HD
sequencing workflow. lon AmpliSeq™ HD technology enables scalable polymerase chain reactions
(PCR) from 12- to 5000-plex (1 x 5000-plex in a 1-pool panel or 2 x 2500-plex in a 2-pool panel) for
Unique Molecular Tag (UMT) targeted sequencing. The primers contain proprietary modifications that
are required during library preparation for efficient target assessment during sequencing. Nucleic acid
from various sources—including cell-free DNA (cfDNA), and formalin-fixed paraffin-embedded (FFPE)
tissue—can be used as the starting material.

Visit AmpliSeq.com to design and order lon AmpliSeq™ HD Made-to-Order panels using lon AmpliSeg™
Designer. Panels are provided as 1 or 2 pools, each consisting of two subpools (forward (FWD) and
reverse (REV) primers) at 10X concentration and enable sequencing: gene, region, hotspot, or fusion
targets on the Genexus™ Integrated Sequencer.

Primer pool panels Volume Storagel'!

1-pool primer panel (DNA or RNA)

10X Pool 1 FWD (red cap) 6 x 1.5 mL each -30°C to -10°C
10X Pool 1 REV (yellow cap)

2-pool primer panel (DNA only)

10X Pool 1 FWD (red cap) 6 x 1.5 mL each -30°C to -10°C
10X Pool 1 REV (yellow cap)
10X Pool 2 FWD (blue cap)

10X Pool 2 REV (green cap)

[ Shipped at ambient temperature. Store as indicated.
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Workflow

e o

Workflow

Custom assays run on the Genexus™ Integrated Sequencer

Design your custom assay panel 3 m -

Design and order your custom assay panel(s) at AmpliSeq.com

Import directly or download your custom panel files from AmpliSeq.com.
Contact your field application scientist if you need help accessing the files.

Import your custom panel design files (page 41) ‘
[ =]

Create a custom assay (page 54)

To create a custom assay for your custom panel, copy an existing custom or
system-installed assay, then edit the settings as needed. Alternatively, create
your custom assay from scratch with the Create assay wizard .

Enter samples (page 78)

Enter samples in Genexus™ Software to assign sample names and provide
information such as collection date, gender, type, and disease category.

L

Plan a sequencing run (page 86)

Runs planned in Genexus™ Software contain all of the settings that are used
in library preparation, templating, sequencing, and analysis, including sample
information and plate location, assays, and barcodes.

Dilute the samples and load the sample plate
(page 95)

Dilute your nucleic acid samples, if needed, then load the sample plate.

Load the sequencer and start a run (page 98)

Follow the step-by-step instructions on the sequencer touchscreen to load the
sample plate and consumables.

H :,D o,
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Workflow

Custom assays run on the Genexus™ Integrated Sequencer

Review data and results (page 114) /
Review data and results in the Genexus™ Software, or analyze data in lon
Reporter™ Software using an lon Reporter™ analysis workflow. 4
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Genexus™ Integrated SEQUENCEN . ... ...ttt ittt et et et e e 12
Reagents and supplies—lon AmpliSeq™ library chemistry ...............ccoiiiiiiiiinn ... 12
Reagents and supplies—lon AmpliSeq™ HD library chemistry ...............c.cccoiiieina.... 15
Shared reagents and SUPPIIES . . .. ..ottt e 17
Required materials—general laboratory equipment and supplies ............ ... ... ... 22
Recommended materials for nucleic acid isolation and quantification ....................... 23

This chapter lists the reagents, supplies, and materials needed to operate the Genexus™ Integrated
Sequencer, and provides consumables ordering and storage information. Recommended products for
nucleic acid isolation and purification are also provided.

Genexus™ Integrated Sequencer

Components Cat. No.

Genexus™ Integrated Sequencer A45727

Reagents and supplies—Ilon AmpliSeq™ library chemistry

Genexus™ Integrated Sequencer reagents and supplies can be ordered in convenient combination kits
and starter packs, but most consumables can also be ordered individually as your needs require. The
following tables provide information on the various ordering options that are available for lon AmpliSegq™
library chemistry.

Note:
. Consumables that have catalog numbers are orderable. Components that have part numbers cannot

be ordered individually.

. Reagents that are specific to lon AmpliSeg™ library chemistry have an AS suffix.

12
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Reagents and supplies—lon AmpliSeq™ library chemistry | <
Genexus™ Library Strips 1 and 2-AS

lon Torrent™ Genexus™ Library Strips 1 and 2-AS (Cat. No. A40252) for standard lon AmpliSeqg™ library-
based chemistry are ordered as kits with eight pairs of strips/kit.

Component Carrier color | Part No. | Quantity per kit Storage

Genexus™ Strip 1 Lightred | A46812 8 strips 2°C to 8°C

Light blue | A46813 8 strips -30°C to -10°C

Genexus™ Barcodes AS

lon Torrent™ Genexus™ Barcodes AS are supplied in plates containing 32 or 48 dual barcodes per
plate. The barcodes can be ordered as a set of three 32-barcode plates (Cat. No. A40257), or ordered

individually.

Item Label color Cat. No. Quantity Storage
Genexus™ Barcodes 1-96 AS Blue A40257 3 plates
Genexus™ Barcodes 1-32 AS Blue A40258 1 plate

Genex Barcodes 1-32AS
g

Genexus™ Barcodes 33-64 AS Blue A40259 1 plate

15°C to 30°C
Genexus™ Barcodes 65-96 AS Blue A40260 1 plate
Genexus™ Barcodes 1-48 AS Kit Blue A54129 1 plate

0000®
e00e
e00e
“weHO
® iee

@@ﬁ

Genexus™ Barcodes 49-96 AS Kit Blue A54130 1 plate
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)

Genexus™ GX5™ Starter Pack-AS

Genexus™ GX7™ Starter Pack-AS

14

Chapter 2 Reagents, supplies, and required materials
Reagents and supplies—Ilon AmpliSeg™ library chemistry

lon Torrent™ Genexus™ GX5™ Starter Pack-AS (Cat. No. A40279) supplies the following components for
lon AmpliSeqg™ library preparation and sequencing using a Genexus™-compatible assay.

Note: For custom assays, Genexus™ Primer Pool Tubes (Cat. No. A40262) must be ordered separately.

See For more information, see page 18..

Component Part or Cat. No. Quantity Storage
Genexus™ Strip 1 A46812 8 strips 2°C to 8°C
Genexus™ Strip 2-AS A46813 8 strips -30°C to -10°C
Genexus™ Strip 3-GX5™ A46815 8 strips 2°C to 8°C
Genexus™ Strip 4 A46816 8 strips -30°C to -10°C
Genexus™ Barcodes 1-32 AS A40258 1 plate 15°C to 30°C
Genexus™ Pipette Tips A40266 12 racks
Genexus™ Cartridge A40272 2 cartridges -30°C to -10°C
Genexus™ Bottle 2 A40273 4 bottles 15°C to 30°C
Genexus™ Bottles 1 and 3 A40274 2 bottles each

lon Torrent™ Genexus™ GX7™ Starter Pack-AS (Cat. No. A50222) supplies the following components for
lon AmpliSeqg™ library preparation and sequencing using a Genexus™-compatible assay.

Note: For custom assays, Genexus™ Primer Pool Tubes (Cat. No. A40262) must be ordered separately.

See For more information, see page 18..

Component Part or Cat. No. Quantity Storage
Genexus™ Strip 1 A46812 8 strips 2°C to 8°C
Genexus™ Strip 2-AS A46813 8 strips -30°C to -10°C
Genexus™ Strip 3-GX7™ A46818 8 strips 2°C to 8°C
Genexus™ Strip 4 A46816 8 strips -30°C to -10°C
Genexus™ Barcodes 1-32 AS A40258 1 plate 15°C to 30°C
Genexus™ Pipette Tips A40266 12 racks
Genexus™ Cartridge A40272 2 cartridges -30°C to -10°C
Genexus™ Bottle 2 A40273 4 bottles 15°C to 30°C
Genexus™ Bottles 1 and 3 A40274 2 bottles each
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Reagents and supplies—Ilon AmpliSeq™ HD library chemistry

Reagents and supplies—Ilon AmpliSeq™ HD library
chemistry

Genexus™ Integrated Sequencer reagents and supplies can be ordered in convenient combination kits
and starter packs, but most consumables can also be ordered individually as your needs require. The
following tables provide information on the various ordering options that are available for lon AmpliSegq™
HD library chemistry.

Note:

. Consumables that have catalog numbers are orderable. Components that have part numbers cannot
be ordered individually.

. Reagents that are specific to lon AmpliSeq™ HD library chemistry have an HD suffix.

Genexus™ Library Strips 1 and 2-HD

lon Torrent™ Genexus™ Library Strips 1 and 2-HD (Cat. No. A40255) for lon AmpliSeq™ HD library-based
chemistry are ordered as kits with eight pairs of strips/kit.

Component Carrier color | Part No. | Quantity per kit Storage

Genexus™ Strip 1 Lightred | A46812 8 strips 2°Cto 8°C

Violet A46814 8 strips -30°C to -10°C
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Reagents and supplies—Ilon AmpliSeqg™ HD library chemistry

Genexus™ Barcodes 1-32 HD

lon Torrent™ Genexus™ Barcodes 1-32 HD are supplied in a plate containing 32 dual barcodes.

Item Label color Cat. No. Quantity Storage

Genexus™ Barcodes 1-32 HD Purple A40261 1 plate 15°C to 30°C

Genexus™ GX5™ Starter Pack-HD

lon Torrent™ Genexus™ GX5™ Starter Pack-HD (Cat. No. A40280) supplies the following components for
lon AmpliSeq™ HD library preparation and sequencing using a Genexus™-compatible assay.

Note: For custom assays, Genexus™ Primer Pool Tubes (Cat. No. A40262) must be ordered separately.
See For more information, see page 18..

Component Part or Cat. No. Quantity Storage
Genexus™ Strip 1 A46812 8 strips 2°C to 8°C
Genexus™ Strip 2-HD A46814 8 strips -30°C to -10°C
Genexus™ Strip 3-GX5™ A46815 8 strips 2°C to 8°C
Genexus™ Strip 4 A46816 8 strips -30°C to -10°C
Genexus™ Barcodes 1-32 HD A40261 1 plate 15°C to 30°C
Genexus™ Pipette Tips A40266 12 racks
Genexus™ Cartridge A40272 2 cartridges -30°C to -10°C
Genexus™ Bottle 2 A40273 4 bottles 15°C to 30°C
Genexus™ Bottles 1 and 3 A40274 2 bottles each

Genexus™ GX7™ Starter Pack-HD

lon Torrent™ Genexus™ GX7™ Starter Pack-HD (Cat. No. A50223) supplies the following components for
lon AmpliSeq™ HD library preparation and sequencing using a Genexus™-compatible assay.

Note: For custom assays, Genexus™ Primer Pool Tubes (Cat. No. A40262) must be ordered separately.
See For more information, see page 18..

Component Part or Cat. No. Quantity Storage
Genexus™ Strip 1 A46812 8 strips 2°C to 8°C
Genexus™ Strip 2-HD A46814 8 strips -30°C to -10°C
Genexus™ Strip 3-GX7™ A46818 8 strips 2°C to 8°C
Genexus™ Strip 4 A46816 8 strips -30°C to -10°C
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(continued)

Component Part or Cat. No. Quantity Storage
Genexus™ Barcodes 1-32 HD A40261 1 plate 15°C to 30°C
Genexus™ Pipette Tips A40266 12 racks
Genexus™ Cartridge A40272 2 cartridges -30°C to -10°C
Genexus™ Bottle 2 A40273 4 bottles 15°C to 30°C
Genexus™ Bottles 1 and 3 A40274 2 bottles each

Shared reagents and supplies

The following reagents and supplies are used in both lon AmpliSeg™ library chemistry and lon

AmpliSeq™ HD library chemistry runs.

Note: Consumables that have catalog numbers are orderable. Components that have part numbers

cannot be ordered individually.

Genexus™ Templating Strips 3-GX5™ and 4

lon Torrent™ Genexus™ Templating Strips 3-GX5™ and 4 (Cat. No. A40263) are ordered as kits with

8 pairs of strips per kit.

Component Carrier color | Part No. | Quantity per kit Storage
Genexus™ Strip 3-GX5™ Brown A46815 8 strips 2°C to 8°C
Genexus™ Strip 4 Yellow A46816 8 strips -30°C to -10°C

lon AmpliSeq™ & lon AmpliSeg™ HD Custom Assay User Guide
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Shared reagents and supplies

Genexus™ Templating Strips 3-GX7™ and 4

lon Torrent™ Genexus™ Templating Strips 3-GX7™ and 4 (Cat. No. A46817) are ordered as kits with

8 pairs of strips per kit.

Component Carrier color | Part No. | Quantity per kit Storage
Genexus™ Strip 3-GX7™ Green A46818 8 strips 2°C to 8°C
Yellow A46816 8 strips -30°C to -10°C

Genexus™ Primer Pool Tubes and Pipette Tips

Genexus™ Primer Pool Tubes and Genexus™ Pipette Tips can be ordered individually. Genexus™ Primer
Pool Tubes are required for custom assays only.

IMPORTANT! The catalog number listed for Genexus™ Pipette Tips is the only supported option for
pipette tips. Use of pipette tips from third-party suppliers is not supported and can result in failed

sequencing runs.

ltem Cat. No. Quantity Storage
Genexus™ Primer Pool Tubes A40262 50 assemblies 15°C to 30°C
(2 tubes/assembly)
Bag of 100 caps
Genexus™ Pipette Tips A40266 12 racks

18
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GX5™ Chip and Genexus™ Coupler

Chapter 2 Reagents, supplies, and required materials m

Shared reagents and supplies

W7 a

The GX5™ Chip and Genexus™ Coupler (Cat. No. A40269) are ordered as a set that contains 2 chips
and 2 couplers, sufficient for up to 8 sequencing runs.

Component Part No. Quantity Storage
GX5™ Chip 100081364 2 chips 15°C to 30°C
ion torrent 6xAOXO+%
100081252 2 couplers

lon AmpliSeg™ & lon AmpliSeq™ HD Custom Assay User Guide
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GX7™ Chip and Genexus™ Coupler

The GX7™ Chip and Genexus™ Coupler (Cat. No. A46731) are ordered as a set that contains 2 chips

and 2 couplers, sufficient for up to 8 sequencing runs.

Component Part No. Quantity Storage
GX7™ Chip 100093568 2 chips 15°C to 30°C
ion torrent 6xAOXO+%
100081252 2 couplers

Genexus™ Sequencing Kit

The lon Torrent™ Genexus™ Sequencing Kit (Cat. No. A40271) provides reagents and solutions sufficient

to sequence up to 2 full chips.

Component Part No. Quantity Storage
Genexus™ Cartridge A40272 2 cartridges -30°C to -10°C
Genexus™ Bottle 2 A40273 4 bottles 15°C to 30°C
Genexus™ Bottles 1 and 3 A40274 2 bottles each
(4 bottles total)
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Genexus™ Conical Bottles

Genexus™ Conical Bottles (Cat. No. A40275) are installed in the sequencing reagents bay and serve as
reservoirs for nucleotide reagent dilutions. For information on when and how to replace the bottles, see
the Genexus™ Integrated Sequencer User Guide (Cat. No. MAN0O17910).

Component Quantity Storage

Genexus™ Conical Bottles

5 bottles 15°C to 30°C

Genexus™ Filter

The Genexus™ Filter (Cat. No. A40302) is installed in the liquid waste disposal port on the instrument

deck to prevent liquid waste line blockage. For information on installation, see the Genexus™ Integrated
Sequencer User Guide (Cat. No. MAN0017910).

Component Quantity Storage

Genexus™ Filter

2 filters 15°C to 30°C

Genexus™ Controls

The lon Torrent™ Genexus™ Controls kit (Cat. No. A40267) provides sufficient Genexus™ Control
Library-AS to perform four Library to Result runs. The kit also provides sufficient Genexus™ Control
Panel-AS and Genexus™ DNA Control to perform eight Nucleic Acid to Result runs.

IMPORTANT! Genexus™ Strip 2-AS is required for sequencing Genexus™ Controls. For ordering
information, see “Genexus™ Library Strips 1 and 2-AS” on page 13.

Note: The Genexus™ Control Library-AS is barcoded with lonCode™ 0101.

Component Quantity Storage
Genexus™ Control Library-AS 1 tube
Genexus™ Control Panel-AS 8 carriers (white) -30°C to -10°C
Genexus™ DNA Control 2 tubes
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Required materials —general laboratory equipment and
supplies
Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates

that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

ltem Source
MicroAmp™ EnduraPlate™ Optical 96-Well Clear Reaction Plates with Barcode 4483352, 4483354
Adhesive PCR Plate Foils AB0626
20-, 200-, and 1,000-pL pipettors and appropriate filtered tips MLS
Microcentrifuge tubes, 1.5-mL or 1.7-mL (low retention for nucleic acids) MLS
Vortex mixer with a rubber platform MLS
Gloves, powder-free nitrile MLS
Ice buckets and ice -
Nuclease-free water, molecular biology grade AM9932
Isopropyl alcohol, 70% solution MLS
Wipes, disposable lint-free MLS
(Optional) Uninterruptible Power Supply (UPS)1] MLS
(Optional) Sorvall™ ST 8 Small Benchtop Centrifugel?, with 75007200
Thermo Scientific™ M10 Microplate Swinging Bucket Rotor (or equivalent),¥l and 75005706
Sealed Bucket; Capacity: 4 Standard or 2 Midi-Deepwell plates (Set of 2) (or equivalent) 75005721

' For laboratories that experience frequent power outages or line voltage fluctuations, we recommend that you use an uninterruptible
power supply that is compatible with 2500 W output or higher.

[ For centrifuging library and templating reagent strips using the Genexus™ Strip Centrifuge Adapter. Centrifuge must achieve an RCF
of 2000 x g, have a swinging bucket rotor and accommodate deepwell plates.

Bl Swinging bucket rotor must carry deepwell plate in the landscape orientation.
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Recommended materials for nucleic acid isolation and
quantification

Unless otherwise indicated, all materials are available through thermofisher.com. Catalog numbers
that appear as links open the web pages for those products.

Item Source

Genexus™ Purification System reagent kits for automated nucleic acid isolation and quantification!'!

lon Torrent™ Genexus™ FFPE DNA and RNA Purification Kit A45539
lon Torrent™ Genexus™ Cell-Free Total Nucleic Acid Purification Kit A45542
lon Torrent™ Genexus™ Multisample DNA Purification Kit A45540
lon Torrent™ Genexus™ Total RNA Purification Kit A45541

Nucleic acid isolation—manual (Nucleic Acid to Result runs)

lon AmpliSeq™ Direct FFPE DNA Kit A31133, A31136
RecoverAll™ Total Nucleic Acid Isolation Kit for FFPE AM1975
RecoverAll™ Multi-Sample RNA/DNA Workflow A26069
MagMAX™ FFPE DNA/RNA Ultra Kit A31881
PureLink™ Genomic DNA Mini Kit K1820-00
MagMAX™ Cell-Free DNA Isolation Kit A29319
MagMAX™ Cell-Free Total Nucleic Acid Isolation Kit A36716
RNaseZap™ RNase Decontamination Solution AM9780
DNAZap™ PCR DNA Degradation Solutions AM9890

Nucleic acid quantification—manual

TagMan™ RNase P Detection Reagents Kit (Recommended for DNA only) 4316831

Qubit™ 4 Fluorometer! Q33238

One or more of the following kits for use with the Qubit™ 4 Fluorometer:

- Qubit™ dsDNA HS Assay Kit (High-sensitivity DNA) Q32851, Q32854
- Qubit™ dsDNA BR Assay Kit (Broad range DNA) Q32850, Q32853
- Qubit™ RNA HS Assay Kit (High-sensitivity RNA) Q32852, Q32855
- Qubit™ RNA BR Assay Kit (Broad range RNA) Q10210, Q10211

lon AmpliSeq™ & lon AmpliSeq™ HD Custom Assay User Guide 23


http://www.thermofisher.com
https://www.thermofisher.com/order/catalog/product/A45539
https://www.thermofisher.com/order/catalog/product/A45542
https://www.thermofisher.com/order/catalog/product/A45540
https://www.thermofisher.com/order/catalog/product/A45541
https://www.thermofisher.com/order/catalog/product/A31133
https://www.thermofisher.com/order/catalog/product/A31136
https://www.thermofisher.com/order/catalog/product/AM1975
https://www.thermofisher.com/order/catalog/product/A26069
https://www.thermofisher.com/order/catalog/product/A31881
https://www.thermofisher.com/order/catalog/product/K1820-00
https://www.thermofisher.com/order/catalog/product/A29319
https://www.thermofisher.com/order/catalog/product/A36716
https://www.thermofisher.com/order/catalog/product/AM9780
https://www.thermofisher.com/order/catalog/product/AM9890
https://www.thermofisher.com/order/catalog/product/4316831
https://www.thermofisher.com/order/catalog/product/Q33238
https://www.thermofisher.com/order/catalog/product/Q32851
https://www.thermofisher.com/order/catalog/product/Q32854
https://www.thermofisher.com/order/catalog/product/Q32850
https://www.thermofisher.com/order/catalog/product/Q32853
https://www.thermofisher.com/order/catalog/product/Q32852
https://www.thermofisher.com/order/catalog/product/Q32855
https://www.thermofisher.com/order/catalog/product/Q10210
https://www.thermofisher.com/order/catalog/product/Q10211

5§ Chapter 2 Reagents, supplies, and required materials
Recommended materials for nucleic acid isolation and quantification

(continued)

Item Source

Library quantification (Library to Result runs only)

lon Library TagMan™ Quantitation Kit 4468802

1 Used with the Genexus™ Purification System. See the Genexus™ Purification System User Guide (Pub. No. MAN0018475) for detailed
information on the Genexus™ Purification System and its consumables.

21 Qubit™ 2.0 Fluorometer and later are supported.
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Precautions

Avoid nucleic acid contamination

IMPORTANT! A primary source of contamination is spurious nucleic acid fragments from previous
sample processing steps. Do not introduce amplified DNA into the work area where the instrument is
located.

Avoid strong electromagnetic radiation

WARNING! Do not use the instrument in close proximity to sources of strong electromagnetic
radiation (for example, unshielded intentional RF sources), as these sources can interfere with proper
operation.

Protection by equipment

WARNING! The protection that is provided by the equipment can be impaired if the instrument is
operated outside the environment and use specifications, the user provides inadequate maintenance,
or the equipment is used in a manner that is not specified by the manufacturer (Thermo Fisher
Scientific).
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Guidelines for panel and reagent use and handling
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Use only the reagents and supplies that have been recommended in “Required materials —general
laboratory equipment and supplies” on page 22 and “Recommended materials for nucleic acid
isolation and quantification” on page 23.

Keep panel tubes capped until immediately before loading in the Genexus™ Integrated Sequencer.

If using, thaw positive controls on ice for 30 minutes. After the positive controls are completely
thawed, vortex the tubes, then centrifuge to collect tube contents. Return to ice before loading into
sample plate.

IMPORTANT! Ensure that contents of the control tubes are completely thawed before adding to
the sample plate.

Equilibrate or thaw the following reagent strips at room temperature for 30 minutes before loading
in the sequencer.

— Genexus™ Strip 1
— Genexus™ Strip 2-AS (or Genexus™ Strip 2-HD)
— Genexus™ Strip 3-GX5™ (or Genexus™ Strip 3-GX7™)

Thaw Genexus™ Strip 4 on ice for 30 minutes before loading in the sequencer.

IMPORTANT! Ensure that the contents of strips that are stored frozen are completely thawed
before loading in the sequencer.

Thawed library and templating strips can be vortexed on a platform vortexer to dissolve precipitate
or dislodge air bubbles. If you vortex, you must centrifuge the strips to collect tube contents using
the Genexus™ Strip Centrifuge Adapter to hold strips during centrifugation.

For information about obtaining and using the Genexus™ Strip Centrifuge Adapter, see “Centrifuge
library and templating reagent strips using the Genexus™ Strip Centrifuge Adapter” on page 180.
Keep the sample plate, thawed panel, Genexus™ Strip 2-AS (or Genexus™ Strip 2-HD), and
Genexus™ Strip 4 on ice or at 4°C until ready to load in the sequencer.

Do not freeze-thaw the panel. Thaw only the number of panel tubes that are required for an
instrument run. Discard unused panel tubes after they are thawed. Store panel tubes at -30°C to
-10°C.

If you are using an assay that uses lon AmpliSegq™ HD chemistry, do not combine the contents

of panel tubes. Forward and reverse primers must remain separate until they are combined by the
sequencer as part of the on-instrument library preparation workflow.

Do not store primer pool tubes or reagent strips on the sequencer for more than 24 hours before
starting an instrument run.
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Guidelines for preventing contamination

We recommend following these guidelines to prevent cross-contamination of samples and controls
between and within sequencing runs.

Personal protective equipment

Wear a laboratory coat that is reserved for sequencing work and is laundered frequently. If
possible, change to a fresh laboratory coat before setting up a run, or use new sleeve covers.

Wear fresh gloves to load the instruments, including during the loading of the sequencing chip and
coupler. Do not remove gloves to install the sequencing chip.

Change gloves between dispensing positive controls and no-template control (NTC) in sample plate
wells.

Equipment and instrument cleaning

If you are preparing samples and sample plates in a hood (recommended), illuminate the hood with
UV light for 15 minutes before use.

Before preparing for a sequencing run, decontaminate surfaces of the hood or bench where
samples or sample plates are handled, and other equipment such as vortexers, microcentrifuges,
and pipettors. Use DNAZap™ and either the RNaseZap™ RNase Decontamination Solution or the
RNase AWAY™ Surface Decontaminant reagent. Follow manufacturer instructions for the proper
storage and use of each decontamination reagent. Alternatively, a 10% solution of commercial
bleach can be used. Follow with wiping of bench and equipment surfaces with wipes moistened
with 70% isopropanol or 70% ethanol.

Before and after a run, sequentially wipe instrument deck surfaces with lint-free wipes moistened
with the two DNAZap™ decontamination solutions, followed by wipes moistened with either 1) the
RNaseZap™ RNase Decontamination Solution or 2) the RNase AWAY™ Surface Decontaminant
reagent. Follow with wiping of deck surfaces with wipes moistened with 70% isopropanol or 70%
ethanol. The robotic pipettor arm can also be cleaned in this manner.

IMPORTANT! Do not spray decontamination solution or alcohol solution directly onto deck
surfaces or into deck openings. Instead, use a lint-free wipe moistened with solution to clean
surfaces. Do not use bleach to clean instrument surfaces.

We recommend that you centrifuge the sample plate after sealing. Ensure that the centrifuge has
been wiped down and cleaned before centrifuging the plate.

Workflow tips

After dispensing a positive control or sample (if applicable) in a sample plate well, do not pass
the end of the used tip over wells intended for other samples or NTC. This practice minimizes the
chance of depositing microdroplets in adjacent wells.

If you dilute samples on the sample plate, apply the foil seal carefully between wells with an
applicator before vortexing to ensure that the seal is complete and contamination between wells
does not occur.

If possible, reserve a pipettor and tips for dispensing only NTC.
Before disposal, close or cap used sample and positive control tubes to avoid creation of aerosols.
Avoid touching the foil seals of the reagent strips, barcode plate, and sample plate.
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When loading the sequencer deck for a run, install the sample plate last.

After a run, seal the PCR amplification plate with a foil seal before removing the plate from the PCR
amplification station. Sealing the plate before removal helps prevent contamination of libraries if
libraries are recovered for reuse.

Guidelines for Genexus™ Integrated Sequencer operation

28

Follow guidance that is provided by Genexus™ Software when you plan a run to determine which
consumables must be loaded and which consumables can be reused from a previous run.

Follow guidance that is provided by the software when you plan a run to determine how many
samples can be run with a given assay or assays in an instrument run. The number of samples that
can be included in a sequencing run depends on multiple factors

— The number of available barcodes

— The sequencing chip, GX5™ Chip or GX7™ Chip

— The number of available lanes on the sequencing chip

— The sequencing chemistry being used, lon AmpliSeq™ or lon AmpliSeq™ HD
— The targeted mean read depth needed to achieve the desired result

Table 1 lon AmpliSeq™ sequencing chemistry

Limiting factor Description

The sequencing chip being | GX5™ Chip or GX7™ Chip

run

The number of available The maximum number of available lon AmpliSeq™ barcodes per run
barcodes in the barcode is 48. lon AmpliSeq™ consumables are configured to support sample
plate batch sizes in multiples of four to six samples depending on the barcode

plate configuration (32 or 48) being used. The most efficient use of lon
AmpliSeq™ consumables occurs when samples are run in multiples of
four or six.

IMPORTANT! When libraries are prepared on the Genexus™ Integrated
Sequencer, each target amplification reaction for a sample requires a
unique barcode.

Maximum number of target | One library strip pair has the reagents necessary for 6 target
amplification reactions per | amplification reactions, or 6 barcodes. With a maximum of 8 library strip
run pairs loaded, a maximum of 48 samples can be run using an assay with
one primer pool.

The number of primer pools | Given the limits of 48 target ampilification reactions, and 48 available
per assay barcodes, the number of samples in a run multiplied by the total number
of primer pools in the assays that are used in a run cannot exceed 48.

The number of unused lanes | A maximum of 4 lanes are available on a single chip.
on an installed chip

The minimum read count The minimum read count per sample parameter is set during assay
per sample for an assay creation.
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Table 2 lon AmpliSeq™ HD sequencing chemistry

Limiting factor Description

The sequencing chip being | GX5™ Chip or GX7™ Chip

run

The number of available The maximum number of available lon AmpliSegq™ HD barcodes per run
barcodes in the barcode is 32.

plate lon AmpliSeq™ HD consumables are configured to support sample

batch sizes in multiples of four samples. The most efficient use of lon
AmpliSeq™ HD consumables occurs when samples are run in multiples
of four.

IMPORTANT! When lon AmpliSeq™ HD libraries are prepared on the
Genexus™ Integrated Sequencer, each target amplification reaction for a
sample requires two unique barcodes.

Maximum number of target | One library strip pair has the reagents necessary for 4 target
amplification reactions per | amplification reactions, or 4 barcodes. Given the limit of 32 lon

run AmpliSeq™ HD barcodes, a maximum of 8 library strip pairs are needed
for 32 target amplification reactions.

The number of primer pools | Given the limits of 16 target amplification reactions, and 32 available
per assay barcodes, the number of samples in a run multiplied by the total number
of primer pools in the assays that are used in a run cannot exceed 32.

The number of unused lanes | A maximum of 4 lanes are available on a single chip.
on an installed chip

The minimum read count per | The minimum read count per sample parameter is set during assay
sample for an assay creation.

* Two assays cannot share a chip lane, so a maximum of 4 assays can be run per chip, one assay
per lane.

* The assays that are used in a single run must use the same chemistry (lon AmpliSeq™ or lon
AmpliSeg™ HD), and have compatible cycling parameters to allow amplification in the instrument
thermal cycler. The thermal cycler has two independently controlled heating zones. After you select
an assay, Genexus™ Software restricts the list of available assays to use in the run to those that are
compatible with the selected assay or assays. For more information, see the Genexus™ Integrated
Sequencer User Guide (Pub. No. MANO017910), or see the “Guidelines for using custom assays
with the Genexus™ Integrated Sequencer” on page 32.

® One library strip pair is needed for each primer tube position 1-8 that is filled in a run.
* One template strip pair is needed for each chip lane that is used in a run.

¢ If a chip installed in a sequencer has unused lanes, do not remove it unless you are sure that
you want to replace it with a new chip. After a partially used chip has been removed from the
sequencer, it cannot be reinserted and reused. The sequencer cannot track lane usage after chip
removal.

lon AmpliSeq™ & lon AmpliSeq™ HD Custom Assay User Guide 29


https://www.thermofisher.com/search/results?query=MAN0017910

e

IR G

Chapter 3 Before you begin
Guidelines for expired reagents and chips

You can remove a chip in one of the following situations.

— After all the lanes of a chip are used in a run, the chip shuttles to the install position and you
are asked to remove the used chip.

— When you select a run plan that requires more lanes than are available on the installed chip,
you are asked to remove the partially used chip, and the sequencer performs a post-chip
clean. In addition, you must clear consumables from the lower sequencing reagents bay, even
if only a single lane of the chip was used.

The Genexus™ Integrated Sequencer can track used and unused barcodes in barcode plates in
Genexus™ Software 6.2.0 and later, enabling you to swap plates between runs if needed, and
reload a partially used barcode plate for a run if a sufficient number of barcodes is available on the
plate.

After loading in the sequencer, reusable consumables, such as barcode plate, chips, and
sequencing reagents bay components, must be used within 14 days for optimal results.

An assay that is selected in a Library to Result run cannot include library batches that share a
library with the same barcode. However, two different assays in a run can include a barcode in
common, because assays are run in separate lanes of a chip.

If desired, manually dilute samples to the needed concentration to avoid loss of sample due to the
required volume overages during automated dilution.

Guidelines for expired reagents and chips

30

Follow these guidelines for using reagents and sequencing chips that are at or near expiration. It is
not recommended to use components past the expiration date, but under specific circumstances, a
sequencer warning for expired reagents can be overridden to allow a sequencing run to proceed.

For all reagents, including the barcode plate, the instrument bypasses an expired reagent warning
after you tap the Help button in the sequencer screen. However, the sequencer must be able to
detect and read the 2D barcode on the expired reagent for the bypass to proceed.

In Genexus™ Software 6.6 and later, if a chip is expiring in a given month, and you start a run in
the next calendar month with the same chip installed, the sequencer allows the run to proceed.
In addition, in Genexus™ Software 6.6 and later you can use expired chips for post-chip cleans or
forced instrument cleans.

lon AmpliSeq™ & lon AmpliSeqg™ HD Custom Assay User Guide



Chapter 3 Before you begin -~ 51
Guidelines for nucleic acid isolation and quantification— Nucleic Acid to Result runs

Guidelines for nucleic acid isolation and quantification—
Nucleic Acid to Result runs

These are general guidelines for manual isolation and quantification of DNA and RNA for Nucleic Acid
to Result runs. For assay-specific guidelines, see the assay user guide. If you do not manually dilute
samples to the target concentration of the assay, quantify sample nucleic acid concentrations ahead of
time so concentrations are available to enter during run planning.

See “Recommended materials for nucleic acid isolation and quantification” on page 23 for
recommended kits for isolating DNA and RNA.

We recommend the TagMan™ RNase P Detection Reagents Kit (Cat. No. 4316831) for quantifying
amplifiable human genomic DNA (see Demonstrated Protocol: Sample Quantification for lon
AmpliSeq™ Library Preparation Using the TagMan™ RNAse P Detection Reagents Kit (Pub. No.
MANO0007732) available at thermofisher.com).

The Qubit™ dsDNA HS Assay Kit (Cat. No. Q32851 or Q32854) can also be used for quantification,
particularly for formalin-fixed, paraffin-embedded (FFPE) DNA, and highly degraded DNA samples.
See “Quantify FFPE DNA with the Qubit™ Fluorometer” on page 179 for a detailed procedure for
quantifying FFPE DNA.

We recommend the Qubit™ RNA HS Assay Kit (Cat. No. Q32852 or Q32855) for quantifying RNA.
Quantification methods such as densitometry (for example, using a NanoDrop™ spectrophotometer)
are not recommended, because they are not specific for DNA or RNA. Use of these methods can
lead to gross overestimation of the concentration of sample nucleic acid, under-seeding of the
target ampilification reaction, and low library yields.

The lon AmpliSeq™ Direct FFPE DNA Kit bypasses nucleic acid isolation when preparing libraries
from FFPE sections on slides. See the lon AmpliSeq™ Direct FFPE DNA Kit User Guide (Pub. No.
MANO0014881) for a protocol for using this kit to prepare gDNA from FFPE tissue.

The Direct FFPE DNA preparation can be stored for up to 6 months at -30°C to —10°C before
library preparation.
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Guidelines for using custom assays with the Genexus™
Integrated Sequencer

Follow these guidelines for setting up assays on the Genexus™ Integrated Sequencer if you are using a
custom lon AmpliSeg™ or lon AmpliSegq™ HD assay.

lon AmpliSeq™ library chemistry:

32

For germline lon AmpliSeq™ assays, start with a coverage depth (Z) of 150 reads per amplicon for
calculating the Minimum Read Count Per Sample that you enter in the Panel step of assay setup.

Example: The panel has 500 amplicons (X) in each of two primer pools (Y).

Minimum Read Counts Per Sample = (X x Y) x Z

(500 amplicons x 2 pools) x 150 reads/amplicon/sample = 150,000

For somatic lon AmpliSeq™ assays, start with a coverage depth (Z) of about 2,500 reads per
amplicon for calculating the Minimum Read Count Per Sample when you set up your assay.
Example: The panel has 500 amplicons (X) in each of two primer pools (Y).

Minimum Read Counts Per Sample = (X x Y) x Z

(500 amplicons x 2 pools) x 2,500 reads/amplicon/sample = 2,500,000

See the information in Table 3 for entering the number of target amplification cycles and
anneal/extend time parameters for a custom lon AmpliSeq™ panel.

Table 3 Target amplification parameters

B e P e Recommended _number_of amplification cycles Anneal/Extend time
(10 ng high-quality DNA/RNA)I']
RNA fusion panels 28 4 minutes
DNA panels

12-24 22 4 minutes
25-48 21 4 minutes
49-96 20 4 minutes
97-192 19 4 minutes
193-384 18 4 minutes
385-768 17 4 minutes
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Table 3 Target amplification parameters (continued)

I oA

Primer pairs per pool

Recommended number of amplification cycles
(10 ng high-quality DNA/RNA)[']

Anneal/Extend time

769-1,536 16 8 minutes
1,537-3,072 15 8 minutes
3,073-6,144 14 16 minutes
6,145-24,576 13 16 minutes

1 Add 3 cycles for low quality (FFPE) samples.

lon AmpliSeq™ HD library chemistry:

* To calculate the Minimum Read Count Per Sample parameter that you enter during assay setup,
estimate the coverage depth that you require to achieve the limit of detection (LOD) needed for
your samples. The limit of detection depends on coverage depth and amount of input material.

Table 4 Minimum Read Count Per Sample at given target LOD

LOD Minimum amplicon coverage
5% 1,400

1% 7,000

0.2% 35,000

For more information, see “Molecular tag sequencing technology —Important factors” on page 37
or the lon AmpliSeq™ HD Library Kit User Guide (Pub. No. MAN0017392).

Examples:

— The panel has 200 amplicons (X) in each of two primer pools (Y), and you require 5% LOD and
coverage depth (2) of 1,400 reads/amplicon for a solid tumor sample.

Minimum Read Counts Per Sample = (X x Y) x Z
(200 amplicons x 2 pools) x 1,400 reads/amplicon/sample = 560,000

— The panel has 100 amplicons in each of two primer pools, and you require 1% LOD and 7,000
reads/amplicon for a cell-free sample.

Minimum Read Counts Per Sample = (X x Y) x Z

(100 amplicons x 2 pools) x 7,000 reads/amplicon/sample = 1,400,000

Note:

. These calculations are based on 100% uniformity and 100% on target reads. Depending on
the actual uniformity of the panel, the quality of input sample, and panel on-target percentage,
minimum read counts per sample may need adjustment.

. To achieve low LOD it can help to increase sample input to =20 ng and optimize parameters for

low frequency detection.

¢ HD library amplification consists of 2 PCR cycling stages.

— First stage consists of 5 cycles that are preset and cannot be modified.

— Second stage varies depending on the number of primer pairs per pool in the panel. See
Table 5 to determine the number of library target amplification cycles for a custom lon

AmpliSeq™ HD panel.
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Accept the recommended default number of Library Amplification Cycles or adjust that number
within the allowed range (12-25) of amplification cycles.

Genexus ’ lon Torrent Dashboard Samples Runs Results Assays
Assays | CopyAssay

Purification Library Prep & Templating Primary Analysis Annotation CNV Finding Fusions Read Mapping Variant Finding

Q e
Library Prep & Templating
© et
© roameter -
® Q DNA
les
o dans I - 5 ® =
M %Range allowed: 12 - 25, Default Value: 15 L s 2. o . = - = 5.
e @ Sample Cancentration Minimum DNA {ng/u Sample Target Concentration DNA {ng

10 0.67 0.67 50

@ Number of Library Amplification Cycles

Table 5
Primer pairs per pool Recommended number of target amplification cycles
12-500 15
501-1,000 14
1,001-2,000 13
2,001-5,000 12
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Planning sequencing runs for efficient use of consumables

Planning sequencing runs for efficient use of consumables

Genexus™ Integrated Sequencer consumables are used most efficiently when samples are grouped in
multiples of 4 or 6, depending on the chip and barcode combination used. When using a GX5™ Chip
with a 32 barcode plate, 4 reactions per sequencing strip are automatically used for custom assays.
With a 48 barcode plate, 6 reactions are used. For GX7™ Chips, 6 reactions per sequencing strip are
used for all runs regardless of the barcode plate loaded.

For example, running one sample uses the same number of primer pool tubes, library and template
strips, and chip lanes as up to 6 samples when using a GX5™ Chip in combination with a 48 barcode
plate or when using a GX7™ Chip with either a 32- or 48 barcode plate. In this setup, running 7 or

8 samples requires the same consumables as 12 samples. For the most economical use of reagents,
therefore, you should try to group samples in multiples of 4 or 6, if possible.

The following tables show the relationship between sample number, the number of pools in an
assay, the required number of reads per sample, and the amount of deck consumables needed for
a sequencing run.

Table 6 lon AmpliSeq™ library chemistry consumable use

Number of Reads per ofsélngjsgeii:;w Barcode plate it fo consumale use fable
primer pools sample Strips 1 and 2-AS GX5™ Chip GX7™ Chip

1 500K 4 32 Table 39 —
6 48 Table 40 -

M 6 48 - Table 45
2 M 4 32 Table 41 -

6 48 Table 42 Table 46
2x2 8M 4 32 Table 43 —
48 - —
6 32 - —

48 Table 44 Table 47

Table 7 lon AmpliSeq™ HD library chemistry consumable use

Number of s pe Samples per set of_ Barcode Link to consumable use table
rimer pools sample ERTDUS e @iz late
UL P 1 and 2-HD P GX5™ Chip | GX7™ Chip
1 M 4 32 Table 48 Table 50
2 M 4 32 Table 49 Table 51
2+1 M 4 32 - Table 52
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Guidelines for chip selection

Use these guidelines to select the appropriate chip for sequencing custom panels. The nucleic acid
type and amplicon size range is determined at the time of custom panel creation in lon AmpliSeq™
Designer. For more information about designing and ordering custom panels, see the lon AmpliSeq™
Designer Help (available at AmpliSeq.com).

Chip Reads per lane Library type Nucleic acid sample typel'l Amplicon size range
GX5™ Chip upto15M lon AmpliSeq DNA
up to 275 bp
RNA
lon AmpliSeq HD | cfDNA/FFPE ("short" designs) only 75-125 bp
GX7™ Chip upto25M lon AmpliSeq DNA
up to 275 bp
RNA
lon AmpliSeq HD | cfDNA/FFPE ("short" designs) only 75-125 bp

[ Selected at the time of design creation in lon AmpliSeq™ Designer (AmpliSeq.com).

lon AmpliSeq™ HD sequencing experiment design

Experiment design workflow

Decide on the
desired target LOD

36

Determine the
required DNA
input amount
based on the
corresponding
LOD target

Determine the
number of samples
per chip based on
the required number
of reads per sample

Determine the
required number
of reads per
sample based

on DNA input
amount and panel
multiplexy (primer
pairs per panel)
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Molecular tag sequencing technology —Important factors

When designing a sequencing experiment, using either lon AmpliSeq™ (non-molecular tag) or lon
AmpliSegq™ HD (molecular tag-based) sequencing, three factors must be taken into consideration: the
targeted % variant allele frequency limit of detection (%VAF LOD), the quantity of input DNA, and the
minimum read depth needed.

To detect a variant in a DNA sample, the physical presence of multiple copies of that variant containing
molecule (nominally 6-9 copies) is needed to reliably capture target variant molecules for variant calling.
Assuming about 300 molecules per ng of human DNA, theoretically to detect variants at 1% frequency,
2-3 ng human DNA sample input is needed to get the 6-9 variant containing molecules in the assay.

For 0.1% VAF LOD detection, 20-30 ng human DNA sample input is required to get the 6-9 variant
containing molecules. The direct tie between DNA sample input amount requirement and the %VAF
LOD target in an assay applies for both lon AmpliSeg™ (non-molecular tag) and lon AmpliSeq™ HD
(molecular tag-based) sequencing.

For assays that use lon AmpliSeq™ chemistry, the required minimum DNA input amount and the
minimum read depth are independently tied to the %VAF LOD target and the minimum reads depth
requirement is not directly dependent on the DNA input amount but on the level of %VAF LOD target.
Therefore, the lower the %VAF LOD target, the higher the required minimum read depth needed. To
detect 1% variant allele frequency, 4,000X read depth is needed to get the 40 variant containing reads
for variant calling.

In contrast, lon AmpliSeq™ HD assays use molecular tag sequencing technology to achieve lower
%VAF LOD targets. This relies on generating families of reads based on molecular tagging information
before calling variants. So, the minimum reads depth requirement is directly dependent on the DNA
input amount. That is, with increased DNA input, you must increase the minimum reads depth
accordingly. This direct tie between DNA input amount and minimum reads depth needed is because of
the requirement to build molecular tag families for variant calling. Therefore, increasing the DNA input
amount and the concomitant increase in read depth results in low % VAF LOD detection (Figure 1).

In general, to build valid tag families at a given DNA input amount, the goal is to generate an average

of 8 reads per amplicon for each input molecule (by default the minimum is 3 reads, with at least

1 read from each strand). For example, a human DNA sample with 20 ng input (~6,000 molecules)
typically generates ~6,000 tag families per amplicon and can therefore theoretically achieve 0.1% LOD
(6 / 6,000), when coverage depth is =50,000X (corresponding to an average of 8 reads per molecule per
amplicon (8 x 6,000)). If the minimum coverage depth for a given input is not achieved, valid molecular
tag families can be underrepresented, impairing the variant calling process. This also applies to DNA
input amounts <20 ng. The reduction in the number of molecules in a sample results in the reduction

of the number of tag families for higher %AF LOD targets, and consequently, a reduction of the reads
depth requirement.

For 0.1%VAF LOD target with lon AmpliSeg™ HD chemistry, we recommend at least 20-30 ng DNA
input (50 ng for optimal performance). An optimal read coverage of 70,000X read depth per amplicon,
which means 70,000 x (number of amplicons in the DNA panel) reads per library is recommended.
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Limit of detection (LOD)

Figure 1 Representative limit of detection for a custom lon AmpliSeq™ HD panel, using human cfDNA
input and the required per amplicon read depth. The graph illustrates the theoretical relationship between the
minimum human DNA input amount, and the minimum reads depth per amplicon requirement to achieve a given %VAF
LOD target. For example, to achieve 1%VAF LOD target, you need 2-3 ng DNA input and 7,000 reads depth per amplicon
assuming the sample contains 6-9 copies of variant containing molecules and the read depth generates sufficient tag
families for variant calling. If you increase the DNA input amount, you must increase the minimum read depth accordingly
even you are still targeting the same %VAF LOD. The read depth increase is to resolve the molecular tag families due to
the increased number of DNA input molecules.

The number of samples that can be sequenced on a single chip is determined by the total reads
needed for a given assay and the number of reads that are generated per chip. Because the total reads
requirement increases with decreasing target %VAF, fewer samples can be sequenced per chip. By
raising the target %VAF you can start with a lower DNA input amount, concomitantly reduce the needed
total read depth, and therefore sequence a greater number of samples per chip.
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Assays in Genexus™ Software contain the settings and parameters for library preparation, templating,
sequencing, analyzing, and reporting the results. Assays also define the panels, kits, and chips that

are used in a run, and specify the reference files and threshold values for quality control and variant
detection. You can optionally add a filter chain to an assay, to narrow the list of variants that appear in a
sample result.

An assay is a reusable experimental design that contains predefined settings appropriate for use with
common types of research applications. An assay can be used to plan many runs and plays an
important role in enabling rapid throughput. Assays help reduce variability and the chance of errors,
because information is stored and then applied to runs instead of entered manually for each run. You
can create a new assay for use with a custom lon AmpliSeg™ or lon AmpliSeg™ HD panel, copy and
edit an existing assay, or import an assay.

Before you can create, copy or import an assay for use with a custom panel, you must first import a
genome reference file for non-human DNA panels, design files and, optionally, the hotspots file that the
panel includes, and a sequence variant baseline (SVB) file that you can create. Each file is available for
selection in the software after files are imported to Genexus™ Software.

Import or add a custom panel

Before you sequence samples on the Genexus™ Integrated Sequencer with a custom panel, you must
import or add a ZIP file that contains files for the custom panel, or add individual custom panel files to
Genexus™ Software. Manager- and administrator-level users can complete these procedures. If you will
use a custom non-human genome reference file, ensure that you add the reference FASTA file to the
software before you add the custom panel files (designed.bed or ZIP file) to Genexus™ Software.

Note: RNA gene expression is not currently supported in Genexus™ Software for custom lon
AmpliSeq™ panels.
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The first time that you use a custom panel, we recommend that you complete one of the following
procedures.

Import the custom panel ZIP file directly from AmpliSeq.com. For more information, see “Import a
custom panel file from Ampliseq.com to Genexus™ Software” on page 41. These custom panels
must have a status of "ordered" or "quote requested" on AmpliSeqg.com to be available for import.

Add the custom panel ZIP file from your computer. For more information, see “Add a custom
DNA panel file to Genexus™ Software” on page 43 and “Add a custom Fusions panel file to
Genexus™ Software” on page 44. These custom panels can be designed with either a human or a
non-human genomic reference.

The custom panel ZIP file that you import directly from AmpliSeq.com, or add from a directory on your
computer, contains the panel target regions (designed.bed file) and other files that are related to the
custom panel.

For DNA panels, you can add the ZIP file that contains the panel file and optionally includes a
hotspots file. To use versions of panel files that are not included in the lon AmpliSeg™ custom
panel, such as a custom hotspots (hotspot.bed) file, you must add the files after the genome
reference FASTA file and the custom panel files (designed.bed or ZIP file) are added to Genexus
Software.

For fusion panels, the ZIP file from AmpliSeq.com contains the target region file (BED) and the
fusion reference file (FASTA). The lon AmpliSeg™ and lon AmpliSeg™ HD custom fusion panel files
are encrypted, so you cannot visualize or edit the file content or download file content after the
fusion reference is uploaded in Genexus™ Software, but the files are used by the software only for
analysis. Reverse transcription is included as part of the Genexus™ Software fusion panel workflow
during library preparation.

Note: For a DNA and Fusions combined assay workflow, contact your Field Application Scientist
(FAS) or Field Bioinformatics Specialist (FBS).

For custom panels that are not human DNA panels, you can create either a Generic Sequencing
Application assay, which only performs sequencing and mapping but not variant calling, or a
Non-Human Reference assay that includes both mapping and variant calling. You must first
upload the genome reference FASTA file, and then upload the target regions (designed.bed file).
For non-human custom panels, you can obtain the genome reference FASTA file from one of the
following sources:

— Use areference that is included in the ZIP file for some non-human custom panels from

AmpliSeq.com, along with a target regions BED file.

— Use a reference from ionupdates.com.

— Use your own genome reference file (for example, if you have uploaded a genome reference
file to AmpliSeq.com for a custom design).

Note:

. If the reference FASTA file is in ZIP file format, the file must be extracted before it is uploaded to
Genexus™ Software.

. If a custom reference file was previously uploaded to Genexus™ Software, the custom reference
is ready to use and can be selected from the reference dropdown menu when a panel is
imported or added.

For more information, see “Add individual target regions files to Genexus™ Software” on page 46.

40
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To improve specificity and sensitivity and to improve the limit of detection, you may want to create

a Sequence Variant Baseline. You can also adjust parameters such as the Variant Finding parameters
to lower limits of detection (LOD). For more information, see “Create a sequence variant baseline
(manager/administrator)” on page 51.

Import a custom panel file from Ampliseq.com to Genexus™ Software

Before you import panel files directly into Genexus™ Software, you must have the following:
* An account in Genexus™ Software.

* An access code that allows you to access AmpliSeq.com from Genexus™ Software. You can
generate a randomized access code on the website, or create an access code of your choice. You
can also use an access code that you generated or created previously.

* Custom panels with a status of "ordered" or "quote requested" on AmpliSeq.com.

1. To generate an access code for AmpliSeq.com do one of the following actions.
Proceed to step 2 to use a previously saved access code for AmpliSeq.com.

Option Action

Generate a random
access code on
AmpliSeq.com for use in
step 4. c. Inthe Manage Access Code dialog box, click Generate to receive
an access code, then click Save.

a. Go to AmpliSeq.com, and sign into your account.
b. Click My Account » Manage Access Code.

d. Clip Copy to Clipboard to use the access code in step 4.

Create an access code
of your choice for
AmpliSeq.com for use in
step 4. c. Enter the code that you want to use as your access code into

the Access Code field. Select an Access Code Expiration in the
dropdown menu, then click Save.

d. Click Copy to Clipboard to copy the access code for use in step 4.

a. Go to AmpliSeq.com, and sign into your account.
b. Click My Account » Manage Access Code.

If desired, you can remember the access code for future use. Alternatively,
you can generate an access code each time that you sign into
AmpliSeq.com.

2. In Genexus™ Software, in the menu bar, click Assays » Manage Panels.
The Panels tab in the Manage Panels screen opens.

3. Click &) Import from AmpliSeq.
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4. In the Import from AmpliSeq dialog box, enter the required information.

Panel Type Options
DN/_\ and IMPORTANT! This option is not supported for custom panel imports from
Fusion Panel AmpliSeg.com.
DNA Panel ¢ Reference—Select a reference genome.

Library Chemistry—Select AmpliSeq or AmpliSeqHD
AmpliSeq Panels —Select Custom Panel
AmpliSeq Username —Enter your username for AmpliSeq.com.

AmpliSeq Access code—Enter the access code that you created previously, or
that you copied to your clipboard in step 1.

Fusion Panel .

Library Chemistry—Select AmpliSeq or AmpliSeqHD
AmpliSeq Panels —Select Custom Panel
AmpliSeq Username —Enter your username for AmpliSeq.com.

AmpliSeq Access code —Enter the access code that you copied to your
clipboard, or that you created previously.

RNA Panel

IMPORTANT! This option is not currently supported in Genexus™ Software.

5. Click List My Ampliseq panels, then select the custom panel to import.

6. Click Import.

Note: Large files take time to import. You can see the file listed in the Panels tab only when the

import is complete.

After the import is complete, the new panel is available to be associated with a new software assay
that you create or copy in Genexus™ Software. Hotspots files for the panel are listed in the Hotspots
tab and are also available to add to a custom assay. For ZIP file imports, the name of the hotspots is
the name of the panel followed by _Hotspot. Fusion references are listed in the Panels tab with more
details available in the Fusion References tab.

For more information, see “Create an assay in Genexus™ Software for use with a custom panel” on
page 56 and “Copy an assay (manager/administrator)” on page 73
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Add a custom DNA panel file to Genexus™ Software

You must add the files for a custom panel to Genexus™ Software before you sequence samples on the
Genexus™ Integrated Sequencer. Manager- and administrator-level users can add new panel files to the
software.

Use this procedure if the custom panel ZIP file is available on your computer.

Custom DNA panel files can be added to Genexus™ Software in the following ways.

* You can upload the entire ZIP file for the lon AmpliSeg™ custom panel to the software. This option
can be completed successfully only for panels that are designed on ampliseq.com using the hg19
or hg38 genomic references. The panel file and related files for the lon AmpliSeq™ custom panel
are contained in the ZIP file that is downloaded from ampliseq.com. This file contains a target
regions BED file, and can also optionally contain a hotspots file. We recommend that you use this
procedure the first time that you add a custom DNA panel file.

* You can also upload panel files individually, including a DNA reference file and, optionally a
hotspots file. Use the steps to upload individual BED files only for non-human custom panels,
or edit panel files before the files are uploaded, if you want to use a version of a file that is
not included in the lon AmpliSeg™ custom panel file that you download. Individual design files in
BED format can be uploaded only if a corresponding genomic reference is already present in the
system. For more information, see “Add individual target regions files to Genexus™ Software” on
page 46.

Use this procedure to upload the entire ZIP file for the lon AmpliSeq custom panel.

IMPORTANT! If the reference genome is not available in the software, the reference genome must
be imported into Genexus™ Software before you import the panel. For more information, see “Add
reference genome files (manager/administrator)” on page 46.

1. In Genexus™ Software, in the menu bar, click Assays » Manage Panels.
The Panels tab in the Manage Panels screen opens.

2. Click + Add New.

3. In the Add Panel dialog box, enter the following required information.
a. Enter the following information.
* Name—Enter a name for the new panel.
¢ Panel Type—Select DNA Panel.
* Reference—Select a reference genome.

b. Under File Type select Zip, then click Select Panel Zip.

c. Navigate to and select the lon AmpliSeg™ custom panel ZIP file on your computer, then click
Open.

This is the ZIP file that you downloaded from Ampliseqg.com.

lon AmpliSeq™ & lon AmpliSeq™ HD Custom Assay User Guide 43



s

Chapter 5 Assays for use with custom panel files
Import or add a custom panel

d. Click Upload. The custom panel ZIP file contains all required files.

Note: Large files take time to upload. You can see the file listed in the Panels tab only when
the upload is complete.

The new panel is listed in the Panels tab and is available to add to a custom assay. For more
information, see “Create an assay in Genexus™ Software for use with a custom panel” on page 56
and “Copy an assay (manager/administrator)” on page 73.

Add a custom Fusions panel file to Genexus™ Software

44

You must add the files for an lon AmpliSeq™ custom panel to Genexus™ Software before you sequence
samples on the Genexus™ Integrated Sequencer. Manager- and administrator-level users can add new
panel files to the software.

Use this procedure if a custom panel is available on your computer.

Fusion lon AmpliSeq™ custom panel ZIP files from AmpliSeq.com contain the target region file (BED)
and the fusion reference file (FASTA). lon AmpliSeqg™ fusion files are encrypted, so you cannot view

the content of the files in Genexus™ Software, but the files can be used by the software. You must
upload the entire ZIP file to the software. By including a fusion panel in an assay, reverse transcription
is performed on the Genexus™ Integrated Sequencer as part of the fusion assay workflow during library
preparation.

1. In Genexus™ Software, in the menu bar, click Assays » Manage Panels.
The Panels tab in the Manage Panels screen opens.

2. Click + Add New.

3. In the Add Panel dialog box, enter the following required information.
a. Enter the following information.

* Name—Enter a name for the new panel.
* Panel Type—Select Fusion Panel.

b. In the File Type section, select Zip, then in the Fusion Panel section, click Select Panel Zip.

c. Find the lon AmpliSeq™ custom panel ZIP file on your computer and click Open to upload the
custom panel file that contains all required files in ZIP file format.

This is the file that you downloaded from Ampliseq.com.

d. Click Upload to upload the custom panel file that contains all required files in ZIP file format.

Note: Large files take time to upload. You can see the file listed only when the upload is
complete. The fusion reference file is added to the list of references shown in the Fusion
References tab.

Any new reference files you upload are available for use with the custom panel file when you create or
copy an assay in the software. The files are listed Fusion References tab.

For more information, see “Create an assay in Genexus™ Software for use with a custom panel” on
page 56 and “Copy an assay (manager/administrator)” on page 73.
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Obsolete panels (manager/administrator)

Manager- and administrator-level users can make panels unavailable that have been added or imported
in Genexus™ Software. You cannot designate as obsolete system-installed panels.

1. In the menu bar, click Assays » Manage Panels.
The Panels tab in the Manage Panels screen opens.

2. Place the pointer over the row of the panel that you want to remove from the software, then click
Obsolete.

The panel is listed in the Panels table with a Status of Obsolete. Panels that have been made obsolete
cannot be added to a new assay. Manager- and administrator-level users can reactivate panels that
have been made obsolete. For more information, see “Reactivate panels (manager/administrator)” on
page 45.

Reactivate panels (manager/administrator)

Manager- and administrator-level users can reactivate panels that have been made obsolete in
Genexus™ Software.

1. In the menu bar, click Assays » Manage Panels.
The Panels tab in the Manage Panels screen opens.

2. Place the pointer over the row of the panel that you want to reactivate, then click Reactivate.

The panel is listed in the Panels table with a Status of Locked and is available to add to a new assay.

Add individual custom panel files to Genexus™ Software

You can upload individual files for use with custom lon AmpliSeq™ and lon AmpliSeg™ HD panels,
including hotspots and target regions files in BED format, and genomic reference files. You can also
create a sequence variant baseline to improve the specificity of variant calling, which is especially useful
when you want to use the software to detect somatic variants so that variants can be sensitively and
specifically detected at lower LOD. You must add these files for custom panels to Genexus™ Software
before you sequence samples on the Genexus™ Integrated Sequencer. When you add the files to
Genexus™ Software, the files are available to select when you create or copy the assays that you will
use for the sequencing runs, and in some cases, to ensure that the files are used correctly by the
software.

Manager- and administrator-level users can add new panel files to the software.
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Add reference genome files (manager/administrator)

Manager- and administrator-level users can add new reference genome files in Genexus™ Software. The
file must use FASTA format.

1. In the menu bar, click Assays » Manage Panels.
2. In the Manage Panels screen, click the References tab, then click + Add New.

3. In the Add Reference Genome dialog box, enter the required and optional information, then select
the FASTA file to upload the reference sequence information.

Large files take time to upload and may not appear immediately.
4. Click Upload when you have finished.

The reference genome file is listed in the References table and is available to select when you add or
import a custom panel.

Add individual target regions files to Genexus™ Software

You can upload individual target regions files in BED format for use with custom DNA panels. You must
add the files for an lon AmpliSeq™ custom panel to Genexus™ Software before you sequence samples
on the Genexus™ Integrated Sequencer.

To use a custom target regions file with your custom panel, ensure that you upload and add
the reference FASTA file to Genexus™ Software before you import or add the custom panel files
(designed.bed) to Genexus™ Software.

Manager- and administrator-level users can add new panel files to the software.

Use this procedure only if you want to upload reference and target region files separately, for example,
to edit a target regions file, or use a version of a file that is not included in the lon AmpliSeq™ custom
panel that you download from AmpliSeq.com.

IMPORTANT! Before you begin this procedure, the genome reference (FASTA file) that you will
associate with the panel must be uploaded before a target regions file can be uploaded. For more
information, see “Add reference genome files (manager/administrator)” on page 46.

1. In Genexus™ Software, in the menu bar, click Assays » Manage Panels.
The Panels tab in the Manage Panels screen opens.

2. Click + Add New.
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3. In the Add Panel dialog box, enter the following required information.
a. Enter the following information.
* Name—Enter a name for the new panel.
* Panel Type—Select DNA Panel or RNA Panel.

Note: When you select RNA Panel, reverse transcription is performed on the Genexus™
Integrated Sequencer as part of the custom assay workflow during library preparation.
This option can be used, for example, for viral RNA custom panels.

Reference —Select the reference genome for the panel.
b. Under File Type select BED File, then click Select Target Regions file.

c. Find the target regions file to use with the lon AmpliSeq™ custom panel file on your computer
and click Open.

4. Click Upload.

Note: Large files take time to upload. You can see the file listed only when the upload is complete.

The new target regions file is listed in the Panels tab and is available to add to a custom assay in
Genexus™ Software.

Hotspots files for use with lon AmpliSeq™ and lon AmpliSeq™ HD custom
panels

All lon AmpliSeg™ HD, and some lon AmpliSeq™, custom panels include hotspots files. You can create
a hotspots file or edit an existing hotspots file for any custom panel, if desired. You can create hotspots
files to include variants for which you want to increase the likelihood of detection. For example, variants
that have a lower LOD for complex alleles, or in the presence of noise.

To use a custom hotspots file or an edited hotspots file with your custom panel, you must first upload
the hotspots (hotspot.bed) file to Genexus™ Software.

By default, the analysis pipeline in Genexus™ Software includes both hotspots calling and de novo
calling for lon AmpliSeg™ and lon AmpliSegq™ HD custom panels. You can optionally change the
settings to set up sequencing runs that call only hotspots. If no hotspots file is provided, only de

novo variant calling is done. Default variant calling settings are slightly different for hotspots positions.
For example, the settings can allow hotspots variants to be called at a lower LOD. You can modify the
threshold for variant calling parameters to allow de novo variants and/or hotspots variants to be called
at lower Variant Allele Frequency (VAF) thresholds in order to reduce the LOD after a sequence variant
baseline is created. For more information, see “Guidelines to lower the limit of detection (LOD) with
Variant Finding parameters” on page 66.

Manager- and administrator-level users add, view, and manage the hotspots BED files that are available
in Genexus™ Software. Operators can view the hotspots files that are available in the software.
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View hotspot file details

Details about system-installed hotspots BED files and custom hotspots BED files are available to view
in Genexus™ Software.

If you have operator-level permissions, you can view the hotspots files and details. Manager- and
administrator-level users can view, add, and manage the hotspots files.

1.

In the menu bar, click Assays » Manage Panels.
The Panels tab in the Manage Panels screen opens.

Click the Hotspots tab.

In the Hotspots table, view the details for the hotspot files, including the panel with which the file
is associated, whether the file is Locked, if the file is Active, who created the file, and the date
on which the file was created. You can also view the genomic coordinates and alleles that are
included in the hotspot file.

Add new hotspots files (manager/administrator)

Manager- and administrator-level users can add new hotspots files in Genexus™ Software.

To use a custom hotspots file or an edited a hotspots file with your custom panel, ensure that you
upload and add the new hotspots (hotspot.bed) file to Genexus™ Software after you import or add the
custom panel files (designed.bed or ZIP file) to Genexus™ Software.

1.

In the menu bar, click Assays » Manage Panels.
The Panels tab in the Manage Panels screen opens.

Click the Hotspots tab.
Click + Add New.

In the Add Hotspot File dialog box, enter a name, select a panel, then select the hotspots file in
BED format that you want to upload.

Click Upload.
Large files take time to upload and may not appear immediately.

The hotspots file is listed in the Hotspots table and is available to select when you create or copy and
edit some custom assays.
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Export hotspot files (manager/administrator)

Manager- and administrator-level users can export hotspot files from Genexus™ Software.

1. In the menu bar, click Assays » Manage Panels.
The Panels tab in the Manage Panels screen opens.

2. Click the Hotspots tab.

3. Place the pointer over the row of the hotspot file that you want to export, then click Export to
download the hotspot BED file.

Sequence variant baselines

A sequence variant baseline is used to improve the specificity of variant calling. This is especially
useful for workflows that are used to detect somatic variants so that variants can be sensitively and
specifically detected at lower LOD.

Variant calling filters in Genexus™ Software suppress and remove most false positives caused by
sequencing errors.

A sequence variant baseline is a BED file that contains a list of variant alleles that are identified by the
application of an error model to reduce false positives. The baseline file includes detailed properties for
each entry. The errors and properties are based on known germline normal samples. When added to
an assay in Genexus™ Software, the baseline detects and filters out the errors in sequencing that could
lead to false positive variant calls.

Custom lon AmpliSeg™ panels and lon AmpliSeq™ HD panels do not include sequence variant
baselines. You can however create sequence variant baselines for custom panels to improve specificity
and reduce the LOD.

Use of a sequence variant baseline will typically further improve specificity and reduce false positives.
In addition, you might be able to set a lower LOD with high specificity when you create and upload a
sequence variant baseline.

To create a sequence variant baseline, you must first sequence multiple samples that are amplified
with your custom panel. You can then use the samples to create custom sequence variant baselines in
Genexus™ Software .

You must create, copy, or import an assay then, to apply the sequence variant baseline to a custom
panel, ensure that it is selected in the parameters step in the software when you create or copy the
assay.

In addition, you can edit a sequence variant baseline and import it back into the software. You can then
replace the existing sequence variant baseline in a newly copied assay, or an assay that is unlocked.
Alternatively, you can add the edited sequence variant baseline to a newly created assay. The assay
that references the new sequence variant baseline can then be used to reanalyze a sequencing run.

You can add the newly created or edited SVB file to an assay in Genexus™ Software, then reanalyze the
run using the newly created assay. For more information, see “Reanalyze a run” on page 164.

You can also augment an existing sequence variant baseline by adding additional samples. For more
information, see the software help system.
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For more information about creating, copying and importing sequence variant baselines, see “Create
a sequence variant baseline (manager/administrator)” on page 51, “Copy a sequence variant
baseline (manager/administrator)” on page 52, and “Import a sequence variant baseline (manager/
administrator)” on page 52. For more information about selecting the sequence variant baseline in the
assay, see “Create an assay in Genexus™ Software for use with a custom panel” on page 56, and
“Copy an assay (manager/administrator)” on page 73.

Add the custom sequence variant baseline to the assay that you create in Genexus™ Software. Using
this custom sequence variant baseline will reduce false positives at low variant allele frequency,

and therefore facilitate the optimization of this custom assay workflow with a lower variant allele
frequency threshold. You can also customize parameters, for example, you can reduce the variant allele
frequency threshold for SNVs, hotposts, indels, and so on, to lower the LOD. For more information, see
“Guidelines to lower the limit of detection (LOD) with Variant Finding parameters” on page 66.

View sequence variant baseline details (manager/administrator)

Manager- and administrator-lever users can view details for custom sequence variant baselines. You
can view the name of a system installed sequence variant baseline file for an assay in the Variant
Finding section of the Parameters step when you copy an assay.

1. In the menu bar, click Assays » Manage Presets.

2. In the Assays / Manage Presets screen, click the Sequence Variant Baselines tab.
The Sequence Variant Baselines table lists custom sequence variant baselines.

3. Click the name of a sequence variant baseline.

Review the details in the Sequence Variant Baselines pane. The details that are shown depend on the
setup of the sequence variant baseline. Parameters used to create sequence variant baselines are also
shown, but are not listed in this table.

Table 8 Sequence variant baseline details

Item Description
Created By Sign-in name of the person who created the baseline.
Created On The date the baseline was created.

Number of Samples | The number of samples that are included in the baseline.

Amplification Type | Library amplification technology that is used in the baseline (lon AmpliSeg™ or lon
AmpliSeq™ HD).

Panel Name The name of the panel that is included in the baseline.
Chip Type The semiconductor sequencing chip for the panel and baseline.
Reference The reference genome for the panel and baseline.

You can click -+ (More Options) to perform more actions, such as obsolete, export, copy, edit, or audit
the sequence variant baseline.
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The actions for each baseline are also available in the list of Sequence Variant Baselines when you
place the pointer over the row of a sequence variant baseline.

Create a sequence variant baseline (manager/administrator)

Manager- and administrator-level users can create a sequence variant baseline (SVB) if system-installed
sequence variant baselines do not meet research needs. You can add the custom baseline to an assay
to use as a baseline for a run.

IMPORTANT! Use the default parameter settings unless you are an advanced user. Contact a Field
Bioinformatics Specialist (FBS) for help.

—

In the menu bar, click Assays » Manage Presets.

2. In the Assays / Manage Presets screen, click the Sequence Variant Baselines tab.

w

Click 4+ Add New.

i

. Complete the Panel step.
a. Enter a name in the Sequence Variant Baseline Name field.
The name is limited to 50 characters and no spaces are allowed.

b. Select or leave Augment an Existing Sequence Variant Baseline as Base unselected.

* Select Augment an Existing Sequence Variant Baseline as Base, then select an SVB
from the dropdown list to use the existing sequence variant baseline as a starting point
for the new baseline.

* |eave Augment an Existing Sequence Variant Baseline as Base unselected to create a
new baseline.

c. Select the panel.
d. (Optional) Enter information about the baseline into the Description field.
e. Click Next.

5. In the Parameters step, accept the default settings or adjust the appropriate parameters, then
click Next.

6. Inthe Samples step, select at least 40 DNA, DNA & RNA, or TNA samples for the baseline.
The samples that you select must have the same library chemistry, chip type, and flow order.

7. In the Review step, review the selections, then click Launch.
The new sequence variant baseline is added to the Sequence Variant Baselines list.

Sequence variant baselines with a State of Completed are available for selection when an assay is
created or copied and edited. For assays that are compatible with the sequence variant baseline, you
can select the sequence variant baseline file in the Variant Finding section of the Parameters step, in
the Analysis SVB File dropdown list.
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If the State of a sequence variant baseline is Failed, place the pointer over the row of the sequence
variant baseline and click View Log to open the log in a separate browser tab. The log file can help with
troubleshooting if the baseline creation job fails.

Copy a sequence variant baseline (manager/administrator)

Manager- and administrator-level users can copy then edit a sequence variant baseline. You cannot
copy sequence variant baselines that have been imported.

1. In the menu bar, click Assays » Manage Assays.

2. In the Manage Assays screen, place the pointer over the row of the sequence variant baseline that
you want to copy, then click Copy.

The Copy Sequence Variant Baseline screen opens to the Panel step with the panel and samples
predefined. The settings and samples that are included can be modified for the new baseline.

3. Change the software-generated name of the baseline if needed, proceed through the workflow
steps, and modify settings. For more information, see “Create a sequence variant baseline
(manager/administrator)” on page 51.

4. In the Review step, review the selections, then click Launch.

The new sequence variant baseline is added to the Sequence Variant Baseline list. When the State
of the SVB is Completed and the Status is Locked, the sequence variant baseline is available for
selection when an assay is created or copied and edited.

For assays that are compatible with the sequence variant baseline, you can select the sequence variant
baseline file in the Variant Finding section of the Parameters step, in the Analysis SVB File dropdown
list. For more information, see “Create an assay in Genexus™ Software for use with a custom panel” on
page 56.

Import a sequence variant baseline (manager/administrator)

Manager- and administrator-level users can import a sequence variant baseline. Two types of files are
supported:
e ZIP

e BED
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1. In the menu bar, click Assays » Manage Presets.
2. In the Assays / Manage Presets screen, click the Sequence Variant Baselines tab.

3. Click Import Sequence Variant Baseline in the top right of the screen.

Option Description
Import a ZIP file a. In File Type, select ZIP.
b. Click Select Sequence Variant Baseline file.
c. Browse for and select the file.
d. Click Upload.

Import a BED file In File Type, select BED.

Enter a name for the baseline.

In the Panel list, select the panel.

Click Select Sequence Variant Baseline file.
Browse for and select the file.

Click Upload.

-~ ® 2 0 T o

A message confirms that the file import was successful when the file import is complete.

The imported sequence variant baseline is added to the Sequence Variant Baseline list. When the
State of the SVB is Completed and the Status is Locked, the sequence variant baseline is available for
selection when an assay is created or copied and edited.

For assays that are compatible with the sequence variant baseline, you can select the imported
sequence variant baseline file in the Variant Finding section of the Parameters step, in the Analysis
SVB File dropdown list. For more information, see “Create an assay in Genexus™ Software for use with
a custom panel” on page 56.

Filter chains for use with lon AmpliSeq™ custom panels

A filter chain is a set of filters that Genexus™ Software uses to narrow the list of variants that appear in a
sample result.

When you view run results and the samples in the results, you can select a filter chain. The filter chains
can be applied to dynamically change the view of the variants as you view results, or you can save the
filter chain to be included as part of the assay.

System-installed filter chains are locked and cannot be changed. You cannot edit system-installed filter
chains, but you can create custom filter chains to refine the results in the software. For example you
can create a filter chain to remove common population variants from gnomAD or ExAC, using MAF
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as a filter. You can remove variants below a specific variant allele frequency. You can remove intronic
variants, and so on. For more information, see the software system help.

For lon AmpliSeq™ or lon AmpliSeq™ HD somatic oncology panels, you can use a filter chain for use
with Oncomine™ assays, such as the Oncomine™ Extended or Oncomine™ Variants filter chain, to show
the most clinically relevant variants.

If you are interested in filtering variants in a different way, you can create a custom filter chain that
filters for variants in public databases such as gnomAD, Clinvar, and ClinGen, variants applicable only
to Exons, and so on. In addition, you can create a custom gene list that shows only variants in selected
genes. For more information, see the software system help.

Filter chains and gene lists allow you to first view the variants that are likely to be most interesting
and important in the sample, then you can remove the filter chain or gene list to see all variants in the
sample, if desired.

Table 9 System-installed filter chains available for use with lon AmpliSeq™ custom panels

System-installed

. . Description

filter chain [1] P

Oncomine™ This filter chain includes all Oncomine™-annotated variants and variants that can be
Extended relevant to cancer due to their inclusion in one or more of the following classes:

* Non-targeted fusions.
* CNV variants with FILTER value of GAIN or LOSS.

* Likely somatic mutations based on dbSNP, 5000Exomes, EXAC, and UCSC
Common SNPs annotation source databases. The minor allele frequencies range
lies between 0.0 and 1.0E-6. Mutations must also be nhonsynonymous and occur
in exonic or splice-site regions.

* Variants with ClinVar annotations of pathogenic or likely pathogenic.

Oncomine™ Variants | This filter chain includes all Oncomine™-annotated variants.

Variant Matrix Returns variant types in a visualization. Variant types returned are SNV/INDEL, CNV,

Summary fusions, and RNAExonVariants.

No Filter Select this option to remove a previously applied filter chain and view all called
variants.

' The version depends on the assay parameter set that is installed in the software.

Custom assay creation

54

Note: You must import a custom panel, into Genexus™ Software before you use the procedures in this
section. For more information, see “Import or add a custom panel” on page 39.

Before you can use an lon AmpliSeq™ custom panel in a sequencing run, you must create an assay

in Genexus™ Software. Assays contain the settings and parameters for library preparation, templating,
sequencing, analyzing, and reporting the results. Assays also define the panels, kits, and chips that
are used in a run, and specify the reference files and threshold values for quality control and variant
detection.
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Manager- and administrator-level users can create a new assay from a system-installed template in
Genexus™ Software. Each assay template allows you to select kits, chips, primer panels, and adjustable
Quality Control (QC) thresholds and other parameters that are appropriate for the custom panel. The
assay is then available to select when you plan a run.

To create a custom assay:

* Use an assay template to create a custom assay that contains preconfigured settings. The template
includes settings for various genetic research analysis applications. For more information, see
“Create an assay in Genexus™ Software for use with a custom panel” on page 56.

* Copy an existing system-installed assay or a locked custom assay, then edit the settings of
the assay to create a new custom assay. For more information, see “Copy an assay (manager/
administrator)” on page 73.

After you create an assay, you can optimize the assay configuration if needed. You can plan a run with a
draft assay, view the results, then edit the assay and plan new runs before you lock the draft assay. This
is useful if you want to further optimize analysis parameters for the custom lon AmpliSeq™ panel.

IMPORTANT! Use the default settings for system-installed assays unless you are an advanced user.
Contact your Field Bioinformatics Specialist (FBS) for assistance.
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Create an assay in Genexus™ Software for use with a custom panel

1. In the menu bar, click Assays » Create Assay.
The Create Assay screen opens.

2. Click the assay type for the template that provides the appropriate kits, chips, primer panels, and
adjustable QC thresholds and analysis parameters.

Assay type

Description

Generic
Sequencing
Application

Use this template to sequence samples with or without mapping to reference
files. Creates an unmapped (unaligned) BAM file, and optionally an (mapped)
aligned BAM file if a panel is selected in the software. The BAM file can be
exported for use in other applications, such as the analysis of gene expression
data, analysis of viral and microbial sequencing and assembly, and so on.

With this assay type, if a panel is selected in Genexus™ Software, the software
uses the target regions BED file for the following information.
® the number of pools

* the chemistry type (lon AmpliSeg™ or lon AmpliSeq™ HD)

This assay type is typically used to sequence samples that are not human or
for non-DNA or non-Fusion panels, for example, RNA gene expression panels,
viral or microbial panels. Assays that are based on RNA panels will include the
reverse-transcription step before target amplification.

Non-Human
Reference

Use this template to sequence samples that are mapped to a non-human
reference, and perform variant calling. Typically, run results from the Non-Human
Reference assay type are not filtered by default with filter chains, and do not
include any annotations, or automatic report generation.

Assays that are based on RNA panels will include the reverse-transcription step
before target amplification during library preparation.

For example, sequencing an RNA virus with the goal of mapping and variant
calling will use the Non-Human Reference assay type.

With this assay type, Genexus™ Software creates a mapped BAM file after
mapping, and a VCF file after variant calling.

IMPORTANT! Ensure that you add the reference (FASTA file) to the software
before the custom panel file (designed.bed) is added to the software. Then,
create an assay after the panel is added.

DNA and
Fusions (1]

Use this template to create a single assay that detects and annotates somatic
DNA variants and RNA fusion targets in paired DNA and RNA samples from the
same source.

DNA Somatic [l

Use this template to create an assay that detects and annotates somatic variants
in DNA samples, and to use Genexus™ Software to analyze liquid biopsy samples.
For more information, see “Create a liquid biopsy assay in Genexus™ Software”
on page 72.

DNA Germline [l

Use this template to create an assay that detects and annotates germline variants
in DNA samples.

56
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Assay type Description

Fusions [! Use this template to create an assay that detects and analyzes fusions in RNA
samples.

' Automatically detects chemistry (for standard lon AmpliSeq™ or lon AmpliSeq™ HD) based on the panel file format.

3. In the Panel step, select the Panel that applies to your custom assay.

If you select None for use with the Generic Sequencing Application, an unmapped (unaligned)
BAM file is created.

If you selected Non-Human Reference as the assay type, you can create both DNA- and RNA
sequencing runs, depending on which Panel you select in this step. Assays that are based on RNA
panels include the reverse transcription step before target amplification during library preparation.

4. Select other options for the assay. For descriptions of the panel information that are appropriate for
the assay, see “Panel step assay options” on page 60.

5. Click Next.

6. In the Reagent step, select the kits and chips that you are using. Ensure that the reagents are
appropriate for the panel that you are using.

Note: The Genexus™ Templating Strip 3B GX5™ is not supported for use with lon AmpliSeq™
Custom panels.

For descriptions of the reagent information that is available for the assay, see “Reagent step assay
options” on page 61.

7. Click Next.

8. In the Parameters step, accept the recommended default values, or adjust the values within the
allowed ranges. Refer to the following guidelines to maximize the use of your custom panels.

Table 10 Recommended parameter settings for lon AmpliSeq™ custom panels

Assay type | Setting description

DNA Resequencing—This option is set by default based on chemistry type. AmpliSeqHD =
True, AmpliSeq = False.

DNA and By default, the Library Pooling Percent DNA parameter is set to 80 percent and the
Fusions Library Pooling Percent RNA parameter is set to 20 percent. Both parameters are set

to 50 percent by default for lon AmpliSeq™ HD custom panels. If you have a panel

with a small number of fusion amplicons, and a large number of DNA amplicons, you
can change Library Pooling Percent DNA parameter to help ensure sufficient amplicon
coverage. When you change this parameter, the Library Pooling Percent RNA parameter
changes automatically to add to a total of 100 percent.

Fusions To help ensure that results for Fusions custom panels are robust, adjust the Fusion
QC parameters. For more information, see “Guidelines to adjust Fusion parameters” on
page 64.
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To improve specificity and sensitivity and to reduce the limit of detection, you might want to create
a Sequence Variant Baseline (SVB). You can also adjust parameters such as the Variant Finding
parameters to lower limits of detection (LOD). For more information, see “Guidelines to lower the
limit of detection (LOD) with Variant Finding parameters” on page 66 and “Sequence variant
baselines” on page 49.

9. (Optional) You can set the parameters with an advanced parameters configuration file in JSON
format to override the default values. First, download the template that is used with the assay, then
edit the JSON file if needed, and upload the edited file.

a. At the bottom of the Parameters step, click Download to download a ZIP file of the JSON
template that is appropriate for the assay.

b. Edit the file with custom settings, then save the file to the computer.
c. At the bottom of the Parameters step, click Upload.

d. Click Select files, navigate to the file on the computer, then click Open. Click Upload to
upload the file and override the default values in the template.

10. (Optional) To use parameters from another assay or panel, you can download and export assay
parameters that are locked. For more information, see “Download assay parameters” on page 77.

a. In the menu bar, click Assays » Manage Assays.

b. In the Manage Assays screen, place the pointer over the row of a locked assay, then click
Download Parameters.

The assay parameter files are downloaded to the computer as a ZIP file that contains JSON
files. The assay parameter files are available to use in a custom assay.

c. Edit the parameter values in the file and save the file.

d. Click Select File.

e. Navigate to the edited file.

f. Click Open.

gd. In the Upload Parameters dialog box, click Upload to upload the file.

11. (Optional) To apply a sequence variant baseline (SVB) file to the assay, do the following.
a. In the Variant Finding section, in the Analysis SVB File dropdown list, select an SVB.

Sequence variant baselines that are compatible with the assay and have a State of
Completed are available for selection when an assay is created or copied and edited.

12. Click Next

13. In the QC step, enter QC metric values, then click Next.
For descriptions of the QC information for the assay, see “QC step assay options” on page 68.
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14. In the Plugins step, plugins to run with this assay are selected by default.

¢ Jon AmpliSeq™ panels — Ensure that CoverageAnalysis and Customer Support Archive are
selected. Select Sample ID, if you have added the SamplelD amplicons. You can deselect
MolecularCoverageAnalysis, because this plugin applies only to lon AmpliSeg™ HD panels.

¢ Jon AmpliSeq™ HD panels — Ensure that CoverageAnalysis, Customer Support Archive and
MolecularCoverageAnalysis are selected.

For more information about plugin results, see “Review coverageAnalysis plugin results” on
page 166, “Review molecular Coverage Analysis plugin results” on page 170, and “Customer
Support Archive” on page 172.

¢ For more information about spike-in panels and use of the Sample ID panel, see “lon
AmpliSeg™ Sample ID Panel” on page 176.

15. Click Next.

16. In the Save step, enter an assay name, an assay full name, and an optional description, then click
Save.

The types of runs that the assay is compatible with are listed in the Save step. The types of assays
listed depends on the selections in the Reagent step. For example, if the lon Torrent™ Genexus™
Library Strips 1 and 2-AS library kits are selected, then Nucleic Acid to Report and Library to
Results run types are shown. If other AmpliSeq library kits are selected, then only Library to
Results run type is shown.

anel Save

Assay Name *

TAL v

Assay Full Name *

& TestAssayl v

Description

Run Workflows: Library to Result, Nucleic Acid to Result

Exit Previous Save
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The new assay is listed in the Manage Assays screen. The Assay Full Name is followed by Draft

to indicate that the assay is in draft status. You can plan a run with the draft assay and the assay is
available to lock, edit, or delete, and audit. You can also download parameters from assays in Draft or
Locked statuses.

Panel step assay options

Manager- and administrator-level users can use the Panel step to select the appropriate reference files
and other settings for use with an assay in Genexus™ Software.

In the Panel step, you can select the appropriate reference files to use in an assay.

The following table lists options that are available in the Panel step. The available options depend on
the type of assay.

IMPORTANT! Use the assay default settings unless you are an advanced user. Contact your Field
Bioinformatics Specialist (FBS) for assistance.

Option Description
Panel The panel to use in the assay. The remaining options are appropriately populated based on the
selected panel.
The panel based on a tab-delimited BED file that defines the coordinates of the regions of
interest to be amplified with the selected primer set.
Hotspots (Optional) The hotspots file to use in the assay. The hotspots file tab-delimited BED file that

indicates the positions where a DNA variant is expected to occur. It also annotates these
positions with the reference allele, variant allele, and anchor base.

Target Regions The target regions BED file that is appropriate for the sample. Depending on the application,

you may need to select a separate DNA and Fusions Target Regions file.

Genome The genome reference file for the panel that is selected is displayed. When you create or upload
Reference a panel, you select the genome reference.

The hg19 and GRCh38 genome references are installed with the system.

Library Chemistry | The type of library chemistry to use in the assay.

Extraction The method used to extract the DNA, RNA, or DNA and RNA from the sample, or as a single
Method Type library TNA from the sample.

Available options depend on the panel that is selected.

Minimum Read The minimum number of reads per sample that are needed to achieve the coverage depth
Count Per required in an assay.
Sample

This value, usually associated with the panel, determines the number of samples that can be
run per lane on a chip. The system uses this value to calculate how many lanes a run uses and
assigns samples according to the calculation. For example, a minimum read count per sample
of 1,000,000 allows twice as many samples on the same lane as that of 2,000,000.

Fusion Reference | The FASTA file to use in the assay that indicates the reference sequence of the targeted RNA

fusion isoform and other RNA variants. These files are encrypted.
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Option

Description

Fusion Panel

The tab-delimited Fusion BED file to use in the assay that defines the coordinates of the regions
of interest to be amplified with the selected primer set. It also annotates these positions. These
files are encrypted.

Primer Pools

The number of primer pools used in the assay.

Annotation Sets

The annotation set to use in the assay. For example, dbSNP, IGSR, ClinVar, COSMIC, and so
on.

Some annotation sets are system-installed. Custom annotation sets can be created as required.
For more information, see the Genexus™ Software help system.

Apply Oncomine
Variant
Annotations

If you select the Apply Oncomine™ Variant Annotations option in the Panel step to create or
edit an assay, analysis results data from more than 24,000 exomes across solid tumor and
hematological cancer types is used as a reference to annotate variants that are relevant to
cancer. The annotations are shown in results in the Oncomine™ Gene class and Oncomine™
Variant class columns. For more information, see the Genexus™ Software help system. or
contact a support representative, Field Bioinformatics Specialist (FBS), or Clinical Account
Consultant (CAC).

Use Latest
Annotations

When enabled, this setting instructs the assay to use the most recent version of the annotation
source in the software. The version of the annotation source that is used with the run depends
on installation of newer versions of the annotation source. After this setting is enabled, any new
run plan uses the latest version of the annotation source that is available in the software. This
means that run plans with the same assay can use a different version of the annotation source.

Reagent step assay options

Manager- and administrator-level users can use the Reagent step to select options that are related to
the reagents for use with an assay in Genexus™ Software.

In the Reagent step, you select the kits and chips to use in an assay. Ensure that the kits and chips that
you select are appropriate for the primer panel that you are using.

The following tables list options that can be available in the Reagent step. The available options
depend on the type of assay.

IMPORTANT! Use the assay default settings unless you are an advanced user. Contact your Field
Bioinformatics Specialist (FBS) for assistance.

Table 11 Purification

Option

Description

Purification Kit

The purification kit that is used for nucleic acid purification.
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Table 12 Library Preparation

Option Description

Library Kit The library kit that is used to prepare the library.

Barcode Kit The barcode kit to use in the assay.

Include Inline You can select DNA or RNA, or both DNA and RNA, depending on the assay template that is

controls used. For example, you might want to ensure that both DNA and RNA are selected if you use
the DNA/RNA template.
By default, only DNA is enabled and RNA is disabled. RNA is available for selection only if the
assay template includes it.

Table 13 Templating

Option Description

Sequencing Chip | The sequencing chip to use in the assay.

When you change the Sequencing Chip option, other assay parameters are changed to the
default settings that are associated with the chip. Review the settings in the Parameters step
after you make this change.

Templating Kit The templating kit to use in the assay.

When you change the Templating Kit option, other assay parameters are changed to the default
settings that are associated with the templating kit. Review the runparameter. json after
you make this change.

Note: The Genexus™ Templating Strip 3B GX5™ is not supported for use with lon AmpliSeq™
Custom panels.

Template Size The template size, measured in base pairs, to use in the assay.
(bp) e 200

Note: 400 bp template size is not supported for use with lon AmpliSeq™ Custom panels.

Table 14 Sequencing

Option Description

Sequencing Kit The sequencing kit to use in the assay.

Sequencing Flows | The number of flows performed by the sequencer during the sequencing stage of the run.
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Parameters step assay options

Manager- and administrator-level users can use the Parameters step to select options related to
parameters for use with an assay in Genexus™ Software. In the Parameters step, you can accept
the default settings for the assay parameters, or adjust the settings if needed to further optimize
performance.

IMPORTANT! Use the default parameter settings for assays unless you are an advanced user. Contact
your Field Bioinformatics Specialist (FBS) for assistance.

When you click the field of a parameter, the software shows the default value and the range that is
allowed for the parameter. You can see a description of most parameters when you place the pointer
over (») (Learn More) next to a parameter.

The options that are available depend on the type of assay and the selections that are made in the
Reagent step.
¢ Library Prep & Templating
¢ Primary Analysis
Advanced Command Line Arguments in the Primary Analysis section can only be adjusted
when you click Enable customization.
¢ Annotation

* Fusions
To help ensure that results for Fusions custom panels are robust, adjust the Fusion QC parameters.
For more information, see “Guidelines to adjust Fusion parameters” on page 64.

* Read Mapping

* Variant Finding
To improve specificity and sensitivity and to reduce the limit of detection, you may want to create
an Sequence Variant Baseline. Adjust parameters such as the Variant Finding parameters to lower
limits of detection (LOD). For more information, see “Guidelines to lower the limit of detection (LOD)
with Variant Finding parameters” on page 66.
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Guidelines to adjust Fusion parameters

The sensitivity and specificity of fusion sample quality control (QC) results can be optimized with slight
adjustments to the settings for the fusion quality control parameters. The recommended settings in this
table can be used to optimize QC parameters for fusion custom panels.

Parameter name in
Parameters screen

Parameter name in
JSON file

Description

Recommended
setting

Fusions sensitivity

fusions.sensitivity

The fusions sensitivity parameter requires
60%, 70%, or 80% overlap of alignment
with insert and 50%, 66.66%, or 75% exact
matches depending on low/medium/high
sensitivity.

Use default setting of
MEDIUM.

Estimate max
crosstalk

fusions.estimate.ma
X.crosstalk

Maximum percentage of spill-over reads that
can be seen in any sample due to reasons
such as barcode crosstalk.

0.5

(This is also used for
Oncomine™ panels.)

Minimum family
coverage per strand

fusions.min.fam.per.
strand.cov

Minimum required coverage of reads on
each strand in a bi-directional molecular tag
family. If the number of reads on each strand
is greater than or equal to (>=) this value, the
family is counted as a functional family.

0

Minimum mean read
length for valid
sampleQC

fusions.min.mean.re
ad.length.sampleQC

Minimum mean read length in order to qualify
a sample as PASS and proceed with the
analysis.

Samples with
average library

read length well
below 50bp typically
indicate poor sample
quality or poor library
quality.

Minimum molecular
family consensus
size

fusions.min.tag.fam.
size

Minimum number of reads with same tag
required to form a functional family. If the
number of reads in a family is greater than or
equal to (>=) this value, the family is counted
as a functional family.

Use a value of 2 to 7.

Note: Higher values
make variant calls
less sensitive but
more specific.

Minimum molecular
family count

fusions.min.tag.fam.
count

Minimum number of variant supporting
functional families that are required to make
a call. If the number of functional families

of a target is greater than (>) this value, the
target is called as present.

Use a value of 2 to
10.

Note: Higher values
make variant calls
less sensitive but
more specific.
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Parameter name in
Parameters screen

Parameter name in
JSON file

Description

Recommended
setting

Minimum Normalized
Read Counts for
Fusions

fusions.min.normaliz
ed.read.count

Minimum normalized read counts threshold
to call fusion isoform as present.

By default, this parameter is set at 0, so is
not used.

Some fusions, such
as FGFR3-TACCS,
can have improved
specificity with a
setting for a
normalized cutoff
value to 0.001, that
is, 0.1% of mapped
reads.

Minimum Number
Of PC Amplicons
Required To Not Fail
QC

fusions.var.max.cont
rol.detected.for.fail

Minimum number of process (or expression)
control amplicons that contain greater than
or equal (>=) the number of families than
Minimum Molecular Family Count required
to not fail quality control (QC).

Use a low value

of 1-3, which can
prevent samples from
failing.

Minimum Number
Of PC Amplicons
Required To Pass QC

fusions.var.min.contr
ol.detected.for.pass

Minimum number of process (or expression)
control amplicons containing equal or more
families than Minimum Molecular Family
Count required to pass quality control.

Set a value >2
the number of PC
amplicons in the
panel.

Minimum number
of valid pools for
SampleQC

fusions.min.valid.po
ols.for.sampleQC.pa
ss

Minimum number of valid pools in order to
qualify a sample QC as PASS and proceed
with software analysis.

Set this value to the
number of pools in
the assay.

Minimum percentage
of read counts

for a non-targeted
fusion in case

where another fusion
involving same gene
pair is reported with
high read counts

fusions.nontargeted.
min.read.count.perc
ent

If a non-targeted fusion is detected in a
sample where another fusion involving same
gene pair is also detected, the non-targeted
fusion will be flagged as secondary fusion
isoform if the percentage of read counts
relative to the other targeted fusion with high
read counts is lower than this threshold.

5

Minimum Read
Counts for Controls

fusions.min.read.cou
nt.controls

Minimum number of valid reads aligned to
specific fusion isoform sequence in order to
call the isoform as Present. If the number

of valid reads assigned to a target is greater
than this threshold (>), the target is called as
Present.

In most cases, use
the same value as the
cutoff the fusion
calling parameter
(fusions.min.read.cou
nt). For example, >20

Minimum Read
Counts for Non-
Targeted Fusions

fusions.min.read.cou
nt.non.targeted

The criteria used to set this parameter should
be more stringent than targeted fusion
calling.

20to 100
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(continued)
Parameter name in Parameter name in Descriotion Recommended
Parameters screen JSON file P setting
Minimum Total Valid | fusions.min.total.vali | Minimum number of total valid mapped 5000

mapped reads

d.mapped.reads

reads in order to qualify a Sample as Valid
and proceed with the analysis. If the total
valid mapped reads in a sample is greater

than or equal to this threshold (>=), the
sample is qualified as PASS.

calls

Use either family
counts only or read
counts only to make

fusions.use.family.or.
read.counts

If the flag is true, the software uses either 0
family counts only or read counts only to
make calls. This parameter is used only for
sequencing runs that use Molecular Tags, or
Unique Molecular Indices (UMIs).

Guidelines to lower the limit of detection (LOD) with Variant Finding parameters

The following guidelines explain how to change the values for Variant Finding parameters to lower the
limit of detection (LOD) in sequencing run results.

Table 15 Variant Finding parameters guidelines for reduced LOD

Parameter Description Recommended setting
Hotspot Min Used to define the allele frequency (AF) threshold for | To detect hotspots present in the sample
Allele Freq statistically testing the presence of a hotspot above at 5% allele frequency, set this threshold
the AF. Hotspots are known relevant variant alleles at 3%.
present in the hotspot bed file. Range: 0.0-1.0.
SNP Min Allele | Used to define the allele frequency (AF) threshold for | To detect SNPs present in the sample at
Freq statistically testing the presence of a de novo SNP 5% allele frequency, set this threshold to
above the AF. De novo SNPs are single nucleotide 3%.
variants not present in the hotspot file. Range: 0.0-1.0.
Indel Min Used to define the allele frequency (AF) threshold To detect InDels present in the sample at
Allele Freq for statistically testing the presence of a de novo 5% allele frequency, set this threshold to
InDel above the AF. De novo InDels include insertions | 3%.
and deletions not present in the hotspot file. Range:
0.0-1.0.
MNP Min Used to define the allele frequency (AF) threshold for | To detect MNPs present in the sample at
Allele Freq statistically testing the presence of a de novo MNP 5% allele frequency, user may want to set
above the AF. De novo MNPs are multiple nucleotide | this threshold at 3%.
variants not present in the hotspot file. Range: 0.0-1.0.
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Table 15 Variant Finding parameters guidelines for reduced LOD (continued)
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Parameter

Description

Recommended setting

Generate Min
Alt Allele Freq

Used to search for possible SNPs and non-
homopolymer insertions and deletions, which are

then statistically evaluated using the Min Allele Freq
parameter. The Generate Min Alt Allele Freq parameter
is the cutoff of candidate SNPs and non-homopolymer
insertions and deletions to be generated in de novo
variant calling. It is not used in hotspot variant calling.
Range: 0.0-1.0.

The Generate Min Alt Allele Freq threshold
should usually be lower than the desired

LOD, for example, 40% lower than the

LOD in the sample. However, setting this

threshold too low may result in false

positives. False positives can be reduced
by creating and using a sequence variant

baseline (SVB).

Generate Min
Indel Alt Allele
Freq

Used to search for possible homopolymer insertions
and deletions, which are then statistically evaluated
using the Min Allele Freq parameter.The Generate

Min Indel Alt Allele Freq parameter is the cutoff of
candidate homopolymer insertions and deletions to be
generated in de novo variant calling. It is not used in
hotspot variant calling. Range: 0.0-1.0.

The Generate Min Indel Alt Allele Freq
threshold should usually be greater than
the Generate Min Alt Allele Freq, for
example, twice as high. Setting this
threshold too low can result in false

positives. False positives can be reduced
by creating and using a sequence variant

baseline (SVB).

For more information about the Variant Finding parameters, see the Genexus™ Software help system.

Edit assay parameters in a file

Manager- and administrator-level users can create assays in Genexus™ Software.

You can edit assay parameters in the Parameters step. Not all parameters appear in the software.
You can download a JSON file that contains the parameters that appear in the software and more
parameters that do not appear in the software. If you are an advanced user and understand how the
changes can affect results, you can edit the parameters file and then upload the edited file to create an
assay that captures the values of the JSON file.

1. In the menu bar, click Assays » Create Assays.

2. Select the type of assay you want to create.

3. In the Panel step, select a panel and other options, then click Next.

4. In the Reagent step, select the kits and chips, and then click Next.

5. In the Parameters step:

a. In the Filter Parameters by dropdown list at the bottom of the screen, select the section
for the parameters you want to change or select All to download a file that contains all

parameters.

b. Click Download to download a JSON file for the parameters.

6. Edit the parameter values in the file and save the file.

7. Click Upload.
a. Click Select File.
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b. Navigate to the edited file.
c. Click Open.
d. In the Upload Parameters dialog box, click Upload to upload the file.

The parameter values in the uploaded file are added to the assay.

QC step assay options
Manager- and administrator-level users can create assays in Genexus™ Software.
You can specify Quality Control (QC) metric values to use in an assay in the QC step.

The following tables list options that are available in the QC step. The available options depend on

the type of assay. For any custom assay, QC failure does impact variant reporting. If detected value
thresholds are not met, the QC metric value is Failed. If the QC threshold is not set, the QC metric value
is Pass.

Table 16 CF-1 Control

Option Description

Min Average Reads Per | The number of average reads per chip lane.

Lane You can specify the minimum threshold value required for the CF-1 (templating Control

Fragment-1) to pass the QC metric.

Min Base Call Accuracy | The total number of errors for all positions in CF-1/ total number of CF-1 base reads.

You can specify the minimum threshold value required for CF-1 to pass the QC metric.

Min Mean AQ20 Read | The average length, in base pairs, at which the accuracy rate is 299% for reads of a
Length (bp) library.

You can specify the minimum threshold value required for CF-1 to pass the QC metric.

Table 17 NTC QC - DNA

Option Description

Max Average Base The average number of reads of all targeted reference bases.

Coverage Depth You can specify the maximum threshold value required for the DNA no template control

to pass the QC metric.

Max Mean Read Length | The average length, in base pairs, of called reads.

(bp) You can specify the maximum threshold value required for the DNA no template control

to pass the QC metric.
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Table 18 NTC QC - RNA

Option

Description

Max Mapped Reads | The total number of reads that are mapped to the reference genome in Genexus™ Software.

You can specify the maximum threshold value required for the RNA no template control to
pass the QC metric.

Length (bp)

Max Mean Read

The average length, in base pairs, of called reads.

You can specify the maximum threshold value required for the RNA no template control to
pass the QC metric.

Table 19 Run QC

Option Description

Min Key Signal | The average signal after software processing for all library ISPs that identically match the library
key (TCAG). This value is a measure of the efficiency of template amplification.
You can specify the minimum threshold value required for a run to pass QC for the key signal
metric.

Min Percent The percentage of addressable wells on a chip lane that are loaded with an ISP. The percentage

Loading is derived from the number of wells with ISPs divided by the number of the total addressable
wells in a run.
You can specify the minimum threshold value required for a run to pass QC for the percent
loading metric.

Min Raw Read | The average raw accuracy across each individual base position in a read, where raw read

Accuracy accuracy is calculated as 100 * (1 - (sum(per base error) / sum(per base depth))).

You can specify the minimum threshold value required for a run to pass QC for the raw read
accuracy metric.

Table 20 Sample QC - DNA

Options

Description

score

Min Deamination

Deamination is reported as the estimated SNP proportion consistent with deamination (low
allele frequency C:G>T:A SNVs). The deamination score can be used to determine the
quality of the FFPE sample.

You can specify the minimum threshold value required for a DNA sample to pass the QC
metric.

Min Mapped Reads | The number of reads aligned to the reference genome.

You can specify the minimum threshold value required for a DNA sample to pass the QC
metric.

Min Mean AQ20
Read Length (bp)

The average length, in base pairs, at which the accuracy rate is =299% for reads of a library.

You can specify the minimum threshold value required for a DNA sample to pass the QC
metric.
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Table 20 Sample QC - DNA (continued)

Options

Description

Min Mean Read
Length (bp)

The average length, in base pairs, of called reads.

You can specify the minimum threshold value required for a DNA sample to pass the QC
metric.

Min Number Of
Bases Used In
Calculating TMB

The number of exonic bases or all of the genomic bases that are covered by the panel. Only
bases with sufficient base coverage are used in the calculation, as defined in the workflow
parameters. By default, the TMB calculation uses total exonic bases with =60 bp coverage.
In the TMB parameter settings, you can select between exonic bases or all of the genomic
bases. You can also modify the sufficient coverage value.

You can specify the minimum threshold value required for a DNA sample to pass the QC
metric.

Min Mean Red Cov

The mean molecular coverage of targeted CNV gene.

You can specify the minimum threshold value required for a DNA sample to pass the QC
metric.

Min Median Mol Cov

The median molecular coverage of non-CNV reference loci.

You can specify the minimum threshold value required for a DNA sample to pass the QC
metric.

Min Number of
variant calls

The number of somatic variants that are identified in the sample. This value is reported in the
statistic.txt file as Total Somatic Filtered Variants Count (numerator for TMB calculation) and
Variant Count.

You can specify the minimum threshold value required for a DNA sample to pass the QC
metric.

Min Uniformity of
Base Coverage

The percentage of reads showing a depth of coverage =20% of the mean base coverage.

You can specify the minimum threshold value required for a DNA sample to pass the QC
metric.

Max MAPD

MAPD is a quality metric that estimates coverage variability between adjacent amplicons in
CNV analyses. A MAPD value of <0.5 indicates an acceptable level of coverage variability.
High MAPD value typically translates to a lower coverage uniformity. Lower coverage
uniformity can result in missed or erroneous CNV calls. The MAPD metric does not affect
SNVs/INDEL/CNV calls.

You can specify the minimum threshold value required for an DNA sample to pass the QC
metric.

This option is available only when a Copy Number Baseline for CNV Calling is selected in
the panel step.
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Table 21 Sample QC - RNA

Option

Description

Min Mapped Fusion
Reads

The number of reads aligned to the reference genome.

You can specify the minimum threshold value required for an RNA sample to pass the
QC metric.

Min Mean AQ20 Read
Length (bp)

The average length, in base pairs, at which the accuracy rate is =299% for reads of a
library.

You can specify the minimum threshold value required for an RNA sample to pass the
QC metric.

Min Mean Read Length
(bp)

The average length, in base pairs, of called reads.

You can specify the minimum threshold value required for an RNA sample to pass the
QC metric.

Min RNA Expression
Ctrls Detected

(For AmpliSeq HD assays
only.)

The number of expression control genes detected for the sample. This metric measures
the RNA input integrity, input amount, and the fidelity of the reverse transcriptase that
was used in library preparation. Fusion panels include primer pairs that cover seven
control housekeeping genes.

You can specify the minimum threshold value required for an RNA sample to pass the
QC metric.

Edit the QC parameters of a locked assay (manager/administrator)

Manager- and administrator-level users can edit the QC parameters of a locked assay. The QC
parameters can be adjusted according to research needs that can change over time. You can edit

the QC parameters of any locked assay, including system-installed assays, if needed. When the QC
parameters are changed, the edited QC parameters are applied to any new run that uses the assay.
Edits to QC parameters do not affect runs that use the assay and are completed before edits are made.

1. In the menu bar, click Assays » Manage Assays.

2. In the Manage Assays screen, place the pointer over the row of a locked assay, then click Edit

QcC.

The Edit QC dialog window opens.

3. Edit the QC parameters as desired.

To reset the QC parameters to the original values in a subsection, such as Run QC or Sample QC
- DNA, click Reset in the upper right corner of the subsection.

4. Click Save.

The new QC parameter values are saved and applied in any run that uses the assay after the changes

are saved.
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Create a liquid biopsy assay in Genexus™ Software

Liquid biopsy samples are typically used to look for variants that occur at very low frequencies. To
support such low Levels of Detection (LOD), modifications need to be made to the variant calling
method in the software. In addition to the creation of an assay, you must also edit the thresholds for
variant calling parameters related to LOD. For more information, see “Guidelines to lower the limit of
detection (LOD) with Variant Finding parameters” on page 66. For best results, we highly recommend
that you also create a sequence variant baseline to reduce false positives when the software analyzes
liquid biopsy samples. For more information, see “Sequence variant baselines” on page 49.

The analysis of lon AmpliSeg™ HD custom panels use sequencing data from cfDNA samples that

use Unique Molecular Tags (UMTs), or Unique Molecular Indices (UMlIs), to remove systematic and
homopolymer errors when calling SNV and Indel variants. Alternative allele variant calls are supported
by families/molecules, resulting in a very low limit of detection. For more information, see “Molecular tag
sequencing technology —Important factors” on page 37.

1. In the menu bar, click Assays » Create Assay.
2. Select DNA Somatic for the assay type.

3. In the Panel step, select the lon AmpliSeq HD Panel that applies to your custom assay. Then,
select other options for the assay. For descriptions of the panel information appropriate for the
assay, see “Panel step assay options” on page 60.

4. Click Next.

5. In the Reagent step, select the kits and chips that you are using. Ensure that the reagents are
appropriate for the panel that you are using.

For descriptions of the reagent information that is available for the assay, see “Reagent step assay
options” on page 61.

6. Click Next.

7. In the Parameters step, click Variant Finding and adjust the parameter settings as follows.

Parameter name Setting for molecular-based variant calling

Additional advanced variant caller arguments | Add "tvc --suppress-mol-tags off --do-indel-
assembly off"

Min Family Size 3
Minimum Family Coverage per Strand 1
Down sample to coverage 50,000

8. Click Primary Analysis and change the setting of the Analyze as single Barcode parameter to
False.

9. Click Next.
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10. In the Save step, enter a new assay name, an assay full name, and an optional description, then
click Save.
The newly created assay is added to the list of assays in the Assays / Manage Assays screen.
The Assay Full Name is followed by Draft to indicate that the assay is in draft status. You can
plan a run with the draft assay. The assay remains in draft status until it is locked. You can lock the
draft assay to ensure that the assay cannot be edited. You can plan a run with the draft assay and
the assay is available to lock, edit, or delete, and audit. You can also download parameters from
assays in Draft or Locked statuses.

11. Reduce variant allele thresholds. For more information, see “Parameters step assay options” on
page 63.

12. Create a Sequence Variant Baseline (SVB) to improve specificity and sensitivity and to reduce the
limit of detection. For more information, see “Sequence variant baselines” on page 49.

Analyze a sequencing run with the new assay.

Copy an assay (manager/administrator)

You can copy and edit the assay that you create for the custom panel. For example, you might want to
start with the current assay as a template, then adjust parameter settings to optimize the settings to use
the assay in a different sequencing run plan.

Manager- and administrator-level users can create a new assay by copying an existing system-installed
assay or other custom assay and modifying it if needed. Only locked assays can be copied.

1. In the menu bar, click Assays » Manage Assays.

2. In the Manage Assays screen, place the pointer over the row of the assay that you want to copy,
then click Copy.
The Copy Assay screen opens to the Panel step. The assay settings can be modified for the new
assay.

3. Proceed through the workflow steps, and modify assay settings if needed.

4. Inthe Save step, enter a new assay name, an assay full name, and an optional description, then
click Save.
The newly created assay is added to the list of assays in the Assays / Manage Assays screen.
The Assay Full Name is followed by Draft to indicate that the assay is in draft status. You can plan
a run with the draft assay. The assay remains in draft status until it is locked. You can lock the draft
assay to ensure that the assay cannot be edited.

Manage assays

You can view assay details, view the audit trail of an assay, and download assay parameters in
Genexus™ Software.

In addition, manager- and administrator-level users can create or import an assay, export a locked
assay, edit, lock, or delete a draft assay, edit the QC parameters of a locked assay, and obsolete a
locked assay in the software.
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In the menu bar, click Assays » Manage Assays to open the Assays / Manage Assays screen.

The following tools are available in this screen.

To

Do the following

Review and
download the
assay audit trail

1. In the Assays / Manage Assays screen, place the pointer over the row of an assay of
interest, then click Audit.

2. In the Audit Trail screen, click Download to download an audit details PDF file to your
local drive.

Edit a draft assay

When a manager- or administrator-level user creates an assay, the status of the assay is draft.
While the assay is in draft status, it can be edited.
1. Place the pointer In the row of a draft assay, then click Edit.
The Edit Assay workflow opens.
2. Edit the options on each assay step as needed, then click Save.

Lock a draft assay

When a manager- or administrator-level user creates an assay, the status of the assay is draft.
Place the pointer In the row of a draft assay, then click Lock.
Locked assays cannot be edited or deleted.

Copy an assay
to create a new
assay

Only locked assays can be copied.

1. Place the pointer In the row of a locked assay, then click Copy.
The Copy Assay workflow opens.

2. Edit the options at each assay step as needed, enter a new name for the assay, then click
Save.

Delete an assay

Only draft assays can be deleted. When an assay is locked, it can be removed from use in the
software by designating it obsolete.

Place the pointer In the row of a draft assay, click Delete, then confirm the deletion.

Remove a locked
assay

A manager-or administrator-level user can remove a locked assay from use in the software by
designating it obsolete. The assay is not deleted and a record of it is maintained in the audit
trail. The results for any runs already performed with the assay remain on the sequencer.

1. Place the pointer In the row of a locked assay, then click Obsolete.

2. Click Yes to confirm the operation.

Export an assay

An assay can be exported, for example if you want to use that assay in another Genexus™
Integrated Sequencer in your lab. Only locked assays can be exported.

Place the pointer in the row of a locked assay, then click Export. The assay parameter files
are downloaded to your local drive as a ZIP folder and are available for import to another
sequencer.

Panel reference files are not included in the exported folder.

Download Place the pointer In the row of the assay, then click Download Parameters. Assay parameter
parameters files are downloaded to your local drive as a ZIP folder containing assay parameter JSON files.
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View assay details

You can view assay details in Genexus™ Software.

1. In the menu bar, click Assays » Manage Assays.
2. In the Manage Assays screen, click the assay name of interest.

The assay details are shown.

If needed, you can click --- (More Options) to perform more actions, such as export, copy, edit, lock,
delete, obsolete, edit QC, download parameters, or audit the assay. The options that are available
depend on whether the assay is system-installed or is a custom assay. For custom assays, the options
that are available also depend on whether or not the assay is locked.

The actions for each assay are also available in the Manage Assays screen when you place the pointer
over the row of an assay. For more information, see “Manage assays” on page 73, “Export a custom,
locked assay (manager/administrator)” on page 77, “Copy an assay (manager/administrator)” on

page 73, “Edit the QC parameters of a locked assay (manager/administrator)” on page 71, “Download
assay parameters” on page 77 and the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or
the Genexus™ Software help system.

Assay details

When you view assay details in Genexus™ Software, you can view information about the components of
the assay. The information that is available depends on the type of assay.

You can view the following assay creation details.
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Research Application—The research
application for the assay, such as DNA or
DNA and Fusions.

Created By —The sign-in name of the person
who created the assay.

Assays that are included with the software are
labeled as System Installed.

Analysis Pipeline Version—The version of the

the version number of the assay. The assay
version number is not the same as the Version
that is shown in the assay creation details.

Version—Tracks revisions made to unlocked
assays. For example, when you edit an assay
for the first time, the version changes from 1 to
2.

analysis pipeline used for the assay.

* Created On—The date on which the assay
was created.

* Assay Name—The name and version of the

assay.

Note: For system-installed assays or assays
that you install in the software, the end
of the assay name, for example w5.0.0, is

Assay detaill'l

Description

Panel

In addition to other components, the panel section lists the reference files that are used in an
assay.

One item that is listed is the Minimum Read Count Per Sample, which is the minimum
number of reads per sample that are needed to achieve the coverage depth required for the
assay. The minimum read counts per sample is used to calculate the number of samples that
are allowed in a chip lane when you plan a run.

For more information and a complete list of components in the panel section, see “Panel step
assay options” on page 60.

Reagents

In addition to other components, the reagents section lists the kits and chips for the assay.

For more information and a complete list of components in the reagents section, see
“Reagent step assay options” on page 61.

e NTC QC - RNA
e CF-1 Control
* NTC QC - DNA

The QC sections list the Quality Control (QC) metric values for the assay.

For more information and a complete list of components in the QC section, see “QC step
assay options” on page 68.

* RunQC
e Sample QC
Plugins The plugins sections lists the plugins that are associated with the assay.
For more information about plugins, see “Plugins for data analysis” on page 166.
Description A short description of the assay, similar to the assay full name.

' The details that are shown depend on the assay.
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Import an assay (manager/administrator)

A manager- or administrator-level user can import an assay from another Genexus™ Integrated
Sequencer if the assay has been first exported to a local drive.

1. In the menu bar, click Assays » Manage Assays.
2. In the Manage Assays screen, click [ Import Assay.

3. In the Import Assay dialog box, click Select Assay file, then go to the folder on the computer that
contains the exported assay and select the ZIP file for the assay.

4. Click Upload.

The assay appears in the list of assays in the Assays » Manage Assays screen.

Export a custom, locked assay (manager/administrator)

An assay can be exported, for example to use that assay in another Genexus™ Integrated Sequencer.
You cannot export system-installed assays. Only custom assays that are locked can be exported.

If you want to view or edit assay parameters, download only parameter files. For more information, see
instead “Download assay parameters” on page 77.

If you want to edit the hotspots file, or the target regions BED file, first export the assay, then edit the
files.

1. In the menu bar, click Assays » Manage Assays.

2. In the Assays » Manage Assays screen, place the pointer over the row of a locked, custom assay,
then click Export.

The assay parameter files are downloaded to the computer as a ZIP file and are available for import to
another sequencer.

Panel reference files are not included in the exported file.

Download assay parameters

Assay parameters can be downloaded and exported, for example to use that assay in another
Genexus™ Integrated Sequencer.

Panel reference files are not included in the export.

1. In the menu bar, click Assays » Manage Assays.

2. In the Manage Assays screen, place the pointer over the row of a locked assay, then click
Download Parameters.

The assay parameter JSON files are downloaded to the computer in a ZIP file and are available to
import to another sequencer.
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Before you can sequence samples on the Genexus™ Integrated Sequencer, you must create a run plan
to specify the assay (or assays), the samples, and any additional parameters needed for the run. In
Genexus™ Software 6.4 and later, there are three types of runs that you can plan for use custom assays
on the Genexus™ Integrated Sequencer:

* Nucleic Acid to Result—start from purified nucleic acid samples.

* Library to Result—start from prepared libraries, either prepared manually or prepared previously on
the Genexus™ Integrated Sequencer.

* BAM to Result—start from a BAM sequence file and analyze using the assay you specify.

Before you plan a run

The following conditions must be met before you plan a run in Genexus™ Software.

* Sample information is accurate in the software and the name assigned to each sample is unique.
For more information, see “Enter samples in the Genexus™ Software” on page 78.

* Ensure that the following conditions are met for a Library to Result run.
— Library batches are prepared and each batch uses a unique library batch ID.

— Each sampile library in a library batch is prepared with and assigned a unique barcode or
barcode pair.

For more information, see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the
Genexus™ Software help system.

The software returns an error message when any of the conditions are not met.

Enter samples in the Genexus™ Software

Genexus | lon Torrent Dashboard  Samples  Runs

Filtie Saenplas by... = Selocted Samples: 0

Sample Name T Tags T CreatedOn  + T Appi R T Sample Type T
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In Genexus™ Software, the data and attributes that characterize a purified nucleic acid—or a specimen
that requires nucleic acid purification and quantitation—to be sequenced are called samples.

Before you plan a run in the Genexus™ Software, you must first enter sample information in the software
to assign sample names and provide other information.

From the Samples menu, you can add samples in multiple ways. For more information on creating and
managing samples, see the software help system, or the Genexus™ Software 6.8 User Guide (Pub. No.
MANO0026409).

Find samples

You can sort, search, and filter information to refine and narrow the samples that are listed in the
Samples / Manage Samples screen in Genexus™ Software. The sort, search, and filter tools help you
organize samples and find a samples of interest.

For information to search for a sample by a unique identifier, such as the sample name, see “Search for
samples” on page 79.

For information to filter samples by a common trait, such as the date the sample was created, see
“Filter the list of samples by the date of sample creation” on page 81.

Search for samples
Samples are listed in the Samples / Manage Samples screen in Genexus™ Software.

You can search for samples with keywords or text that are included in the sample attributes, such as
sample name, tags, or application category. You can also search for a specific date or date range for
the Created On attribute.

IMPORTANT! Search terms must adhere to the following rules.

. An asterisk (*) is not allowed in the search field for use as a wildcard.

. Searches are case-insensitive, that is, both upper-case and lower-cases letters are found regardless
the case of search term letters.

. Searches find every occurrence of a continuous string. For example, a search for demo in analysis
names returns a list of all analyses with a name that includes demo. For example, demo1, demo2,
and so on.

. Spaces are removed during searches, and therefore are not recommended. For example, a search for
demo 1 would return results only for data that includes the string demo1.
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1. In the menu bar, click Samples » Manage Samples.

2. In the Manage Samples screen, use the options to filter the list of sample attributes.

Option

Steps

Limit the list of
sample attributes
that is shown.

Click Y (Filter) in in the column heading for a sample attribute of interest, then
do one or move of the following.

* In the search field, enter 3 or more characters for the sample attribute.
® Select a checkbox next to one or more sample attributes.
* C(lick Select All to select all sample attributes.

* C(lick Clear to close the filter dialog box.

Limit the list of
samples based on a
creation date, or a
range of dates.

Click Y (Filter) in the Created On column heading, and select Is equal to, Is
before or equal to, or is after or equal to to set the criteria for the date or date
range.

Select a date in the calendar.

(Optional) Select And, or Or to include a second set of criteria and further
narrow the search.

For more details, see “Filter the list of samples by the date of sample creation”
on page 81.

3. Click Filter.

In the column heading, jf changes color to indicate that a filter is applied.

The filtered list of samples is shown in the Manage Samples screen.

Click {x] Clear Filters at the top of the Samples / Manage Samples screen to remove all filters and
view the full list of samples.

Sort the list of samples

You can sort the list of samples to make it easier to find a sample in Genexus™ Software.

By default, samples are listed in the Samples / Manage Samples screen by the date that the sample
was created. The most recently created sample is at the top of the list.

You can change the order that the samples are listed in the table.

1. In the menu bar, click Samples » Manage Samples.

2. In the Manage Samples screen, click a column heading of interest.

The list of samples is sorted by the sample attribute, in alphabetical or chronological order of the
attribute, depending on the heading.

3. Click the column heading again to reverse the order.

80

lon AmpliSeq™ & lon AmpliSeqg™ HD Custom Assay User Guide



Chapter 6 Planarun [

||
Enter samples in the Genexus™ Software

Filter the list of samples by the date of sample creation

You can apply filters to narrow search results, or shorten the list of samples when you view the list of
samples in Genexus™ Software.

In addition to the filter tools in the column headings, you can also filter the list of samples with a
dropdown list and search by the sample name or other column headings. For more information, see
“Refine the list of samples” on page 82 and “Search for samples” on page 79.

1. In the menu bar, click Samples » Manage Samples.

2. In the Manage Samples screen, select one or more filters.

Option

Description

List only samples
created on an exact
date.

a o oo

In the Created On column heading, click Y (Filter).

In the first dropdown list, select Is equal to.

In the calendar that appears, select the date of interest.
Click Filter.

List samples created
within a date range.

e

g.

In the Created On column heading, click Y (Filter).
In the first dropdown list, select Is after or equal to.

In the calendar that appears, select the earliest date that the samples of
interest were created.

In the Boolean operator dropdown list, select And.
In the second dropdown list, select Is before or equal to.

In the calendar that appears, select the latest date that the samples of
interest were created.

Click Filter.

Records are listed for samples created on dates that meet both conditions.

List samples according
to a date that meets
either one condition or
a second condition.

g.

In the Created On column heading, click Y (Filter).
In the first dropdown list, select Is after or equal to.

In the calendar that appears, select the earliest date that the samples of
interest were created.

In the Boolean operator dropdown list, select Or.
In the second dropdown list, select Is before or equal to.

In the calendar that appears, select the latest date that the samples of
interest were created.

Click Filter.

Records are listed for samples created on dates that meet at least one of the
conditions.
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Option Description

List only samples that a. Inthe Created On column heading, click Y (Filter).

were created before a b. In the first drond list. select Is bef It

date that you indicate. . In the first dropdown list, select Is before or equal to.
c. Inthe calendar that appears, select the date of interest.
d. Click Filter.

List only samples that | 5 | the Created On column heading, click Y (Filter).

were created after a b. In the first drond list. select Is aft It

date that you indicate. . In the first dropdown list, select Is after or equal to.
c. Inthe calendar that appears, select the date of interest.
d. Click Filter.

Remove all selections In the filter dialog box, click Clear.
and close the filter
dialog box.

3. In the filter dialog box, click Filter to apply the filtered selections.
In the column heading, j§ changes color to indicate that a filter is applied.

The list of samples is filtered according to the selections.

Click {x] Clear Filters to remove all filters and view the full list of samples.
Refine the list of samples

You can shorten the list of samples that are shown in Genexus™ Software.

1. In the menu bar, click Samples » Manage Samples.

2. In the Manage Samples screen, in the Filter Samples by dropdown list, select the type of sample
you want to view.

Option Description
List only the samples that have not been prepared as a library batch. Select To Be Prepared.
List samples created from BAM files. Select BAM Samples.
List all samples. Select All.

Only the selected type of samples are listed.

Create a new sample
You can enter information individually for each sample that you add in the software. Complete this

procedure to make a sample available for use in a run, or to add the sample to a library batch. If you
have many samples to add, see instead “Download a template file for sample creation” on page 85
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and the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the Genexus™ Software help
system.

1. In the menu bar, click Samples » Create Sample.

2. In the Samples/Create Sample screen, enter a name for the sample, select an Application
Category, then complete the required fields, and optional fields if needed.

¢ In the Tags field, enter a full or partial tag name of at least 3 characters, then select one or
more tags of interest to assign a tag to the sample.

¢ |f the tag that you want to assign to the sample does not exist in the software, a manager-or
administrator-level user can enter a new tag name in the Tags field to create a new tag and
assign it to the sample.

The fields for sample attributes change based on the Application Category. Attributes identified
with a red asterisk (*) are required.

If you select Other as the Sample Type, you must enter a name for the custom sample type in the
text box that is shown. For example, enter Nasopharyngeal Swab.

Sample Type *

Other v/ % | Nasopharyngeal Swab +/

3. Click Save.
The new sample is listed in the Manage Samples screen and is available to use in a run plan.

Import samples

You can enter sample information for multiple samples directly in Genexus™ Software. When you want
to create more than a few samples, an easy and fast way to add multiple samples in the software is to
create a file of information for a group of samples and import that file.

Sample data files can be used to capture, manage, and edit sample data. You can import sample data
files in TSV, XLS, XLSX, or CSV file formats. For a list of the sample attributes that are included in

the import file, see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the Genexus™
Software help system. For ease of use, you can download a Microsoft™ Excel™ template file to create an
import file.

You must create custom attributes before importing sample and run information for the attributes to

be propagated through to output files. All attributes that are included in the file that you use to import
samples must be either system-installed attributes or custom attributes that exist in the software. Other
file content is not transferred with the sample.

You can use a file to import sample information into the software. You can create the file, or use
a file that is exported from external LIMS software. Before you import a file from LIMS software,
you must first map the sample attribute names that are named differently in the LIMS file to the
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attribute used in Genexus™ Software. For more information, see the Genexus™ Software 6.8 User Guide
(Pub. No. MAN0026409) or the Genexus™ Software help system.

1. In the menu bar, click Samples » Create Sample.

2. In the Create Sample screen, click the Multiple (.xls, .csv, .tsv) tab.

3. In the Application Category dropdown list, select the application category for the samples.

Tip: Use the search field to search for the application category of interest.

4. Set up a sample file using one of two options.

Option Description
Download a template file, | For more information, see “Download a template file for sample creation”
then edit it to create a on page 85. Upload the edited file using the Browse button.
new file.

Note: When you select Other as the Application Category, you must
enter text in the Application Category text box, then click anywhere in the
screen in order for the template file to be available.

Upload the sample data
from an existing file.

a. Click Browse.
b. Navigate to the file, then click Open.

The data contained in the file populates the table in the screen.

5. In the sample file, edit the sample table and data, if needed.

Option

Description

Remove an attribute column.

Click Columns, then deselect the column name.

Add an attribute column to the
table.

Click Columns, then select the column name. The column names
that are listed are Application Category-specific.

Edit sample data.

Click the sample row of interest, then edit the text field or
dropdown list for the sample.

Add more samples to the table.

Click Add Row, then enter the sample data.

Remove a sample from the table.

Select the checkbox for the row, then click Remove Row.

6. Select the checkbox in the row for each sample to create. To select all samples, select the
checkbox in the column heading row.

IMPORTANT! The information for samples that are not selected is not retained by the software.
Ensure that you select the checkbox for every sample you intend to create.

7. Click Save.

You can place the pointer over (¥) (alert) to view more information if needed.

The new samples are listed in the Manage Samples screen and are available to assign to a run plan.
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Download a template file for sample creation

You can download a template file, add sample information to it, then use the file to import the sample
data for multiple samples.

Template files contain two tabs. The Instruction tab in the spreadsheet lists and indicates required and
optional attributes, which are the column headings in the Sample Details tab. Use the Sample Details
tab to enter sample information.

Template files contain both the system-installed and the custom sample attributes as column headings.

—

. In the menu bar, click Samples » Create Sample.
2. In the Create Sample screen, click the Multiple (.xls, .csv, .tsv) tab.

3. In Application Category, select the application category for the samples.
Template files are specific for each application category.

4. Click Download Template to download the Microsoft™ Excel™ template file.

The template file contains default sample attributes as columns. If custom sample attributes have
been configured in the software, the custom attributes are added to the template file.

5. Save the file to the computer, then open the file, enter sample data in the Sample Details tab.
6. When you are finished adding sample information to the file, save the file.

You can now import the file to Genexus™ Software. For more information, see the Genexus™ Software
6.8 User Guide (Pub. No. MAN0026409) or the Genexus™ Software help system.

Upload a BAM file to create a sample or samples

You can upload BAM files to create samples in Genexus™ Software. You can also redefine existing BAM
files as new samples. That is, you can upload a BAM file and create a new sample name for the BAM
file and enter the same or different values for the sample attributes that are associated with the BAM
file.

If the BAM file is not on the Genexus™ Integrated Sequencer, you can upload a BAM file from the
computer that is used to access Genexus™ Software. You can upload the BAM file directly from the
computer or from a USB drive connected to the computer.

BAM files can be analyzed in the software. For more information, see “Plan a BAM to Result run” on
page 94.

You can upload BAM files from a USB drive, from the hard drive, or from a connected Genexus server,
or from a connected lon Reporter™ Software server. For more information, see the Genexus™ Software
6.8 User Guide (Pub. No. MAN0026409) or the Genexus™ Software help system.

1. In the menu bar, click Samples » Create Sample.
2. In the Create Sample screen, click the From Sequence Files (.bam) tab.

3. In Application Category, select the application category for the samples.
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4. Click Browse, then navigate to the file.

Option Description
Find the file on the instrument. Click Server, then navigate to the file.
Find the file on the computer used to Click & My Computer, then in the Browse dialog box
access the software. that appears, navigate to the file.

5. Navigate to the file, then click Select.
The file is now available to select and assign to a sample. The BAM file name is visible in the
dropdown lists in the DNA BAM File, RNA BAM File, and TNA BAM File columns.

6. Enter the information for the sample.
Attributes identified with a red asterisk (*) are required.

7. In one or more of the DNA BAM File, RNA BAM File, and TNA BAM File dropdown lists for the
sample, select the BAM file that you want to assign to the sample.

8. To add more samples, click Add Row.
9. Repeat step 4 to step 8 for each extra BAM sample you want to create.

10. Select the checkbox in the row for each sample that you want to create. To select all samples,
select the checkbox in the column heading row.

11. Click Save.

The new samples are listed in the Manage Samples screen, are denoted with BAM after the sample
name, and are available to assign to a BAM to Result run plan.

Plan a Nucleic Acid to Result run

You can plan a run for sequencing that starts with nucleic acid samples. A run that starts with nucleic
acid samples is called a Nucleic Acid to Result run.

Planning a Nucleic Acid to Result run is organized into steps: Setup, Assays, Samples, Sample
Plate, and Review. You can view progress through the steps in the upper left corner of the
Runs / Nucleic Acid to Result screen.

Ensure that the following prerequisites are complete before you plan a Nucleic Acid to Result run.

* Enter sample information into Genexus™ Software. For more information, see “Create a new
sample” on page 82, or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the
Genexus™ Software help system.

¢ Ensure that the assay that you want to use in the run exists in the software. For more information,
see Chapter 5, “Assays for use with custom panel files” .

* Quantify sample concentration, if you do not intend to dilute sample concentrations manually to the
target concentration of the assay. For more information, see the Genexus™ Integrated Sequencer
User Guide (Pub. No. MANOO17910).
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1. In the menu bar, click Runs » Nucleic Acid to Result.

o

s
R

Note: Alternatively, you can click 4+ Nucleic Acid to Result in the Runs / Manage Runs screen.

2. In the Setup step, enter or make the following selections.

a. In the Plan section, enter a unique name.

The name is limited to 50 characters and no spaces are allowed.

b. (Optional) In the Reporting (Optional) section, ensure that Generate Report is enabled to
generate a variant report using the default report template.

c. (Optional) In the Reporting (Optional) section, enable Upload BAM files to Server to upload
BAM files to another Genexus™ Integrated Sequencer or lon Reporter™ Software.

Option

Description

Upload BAM files
to another Genexus™
Integrated Sequencer.

In the dropdown lists that appear, select the Genexus™ Software account

and the software version.

To configure a Genexus™ Software account that you can use for data
uploads, click Set up Account. For more information, see Genexus™
Software 6.8 User Guide.

Automatically upload
data for further
analysis with lon
Reporter™ Software.

In the dropdown lists that appear, select the lon Reporter™ Software
account and software version.

To configure an lon Reporter™ Software account that you can use for
data uploads, click Set up Account.

Note: To transfer data to lon Reporter™ Software, you must add one
or more lon Reporter™ Software accounts in Genexus™ Software. To
configure an lon Reporter™ Software account that you can use for
data uploads, see Genexus™ Software 6.8 User Guide and Genexus™
Software 6.8 User Guide.

Alternatively, you can upload BAM files to another Genexus™ Integrated Sequencer or lon
Reporter™ Software after a run is successfully completed. For more information, see the
Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the Genexus™ Software help

system.

d. In the Reason for Change field, enter the reason for the new run plan.

e. Click Next.

3. Inthe Assays step, select one or more assays that you want to include in the run.

a. Use the Y (Filter) tools in table column headings to find assays of interest, if desired.

For more information, see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or
the Genexus™ Software help system.
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b.

C.

d.

In the Research Application column for the assay of interest, select one or more research
applications, such as DNA and Fusions or DNA, to include the research application for the
assay in the run plan.

After you select an assay and the research application for the assay, the list is filtered to show
compatible assays that can be selected and run at the same time.

Note: To create a new assay, see “Create an assay in Genexus™ Software for use with a
custom panel” on page 56.

If more assays are included in the run, repeat substep 3b for each extra assay.

Click Next.

4. Inthe Samples step, select the samples that you want to run with each research application of
each assay.

a. Select the checkbox next to each sample that you want to assign to the research application

C.

of an assay, then in the Selected Assays pane, for the assay and research application that
you want to use for the selected samples, click Assign.

The Chip View updates to show the lanes used in the run. Lane usage is calculated based

on the number of samples (including a no template control, if selected) and the minimum read
counts per sample for the assay. Green denotes a chip lane in the run containing assigned
samples within lane capacity.

If the minimum reads per sample x number of samples exceeds the chip or lane well capacity,
a dialog box appears after you click Assign asking you to confirm that you want to continue.
After confirmation, the Chip View updates and shows the lane color as red instead of green.
The run is allowed if the lane capacity is exceeded, but you might not achieve the reads
needed per sample to pass QC metrics.

lon Torrent™ GX5™ Chip lon Torrent™ GX5™ Chip

123 QCAv3 DNA Fus a4 QCAv3 DNA Fus T
@ Lane. y W5.0.2 et w5.0.2 Seanphes
@ Green lane color denotes lane usage and sample @ Red lane color denotes sample assignment that
assignment within lane capacity. exceeds lane capacity.

. If you selected more than one research application or assay, repeat substep 4a for each

research application for each assay in the run plan.

If needed, edit samples in one of the following ways.
* (Click View & Remove, make the selections, then click Update.

¢ Click Remove All, to remove all sample assignments for all assays.
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d. If you selected the Upload BAM files to Server reporting option in the Setup step, make the
following selections from the Genexus Workflow or lon Reporter Workflow dropdown list
for each assay that you selected.

¢ Select Upload Only to upload sample data to the selected server automatically after run
completion.

® Select the desired Genexus™ Software assay or lon Reporter™ Software analysis workflow
to upload sample data and perform an analysis in the target software automatically after
run completion.

Note: In order for the lon Reporter™ Software analysis workflow to appear in the list, you
must tag the analysis workflow for use with the lonReporterUploader plugin. For more
information, see the software help system or the lon Reporter™ Software 5.18 User Guide
(Pub. No. MAN0024776).

e. If desired, for each research application of each assay in the run plan, select NTC to include a
no template control.
The Chip View updates to show the lanes used in the run for the included no template
controls.

f. Click Next.

5. In the Sample Plate step, review position assignments in the sample plate. Drag-and-drop
samples and no template controls to edit the location of samples and controls, if applicable.

a. If desired, enter the extraction kit barcode for one or more samples or controls. For a single
sample, in the row of the sample of interest, in the Kit Barcodes column, enter the extraction
kit barcode or control kit barcode, if applicable. For multiple samples or controls, select the
samples and controls, then click & Assign Kit Barcodes. In the Assign Kit Barcodes dialog
box, enter the extraction kit barcode for the samples, and if applicable, enter the barcode for
the no template control.
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6.

b. Modify the concentration of samples, if needed. For a single sample, in the row of the sample
of interest, in the Conc. (ng/pl) column, edit the concentration.
To modify the concentration of multiple samples, select the samples of interest, then click
@ Edit Concentration. In the Bulk Edit dialog box, enter the concentration for all selected
samples, then click Submit. The concentration for each selected sample is updated to the
new value.

The sequencer automatically dilutes the sample to the target concentration during the run if
either of the following is true:
* The sample concentration is less than or equal to 1,024.00X the target concentration for
an assay that performs 4 reactions per library.
* The sample concentration is less than or equal to 40.00X the target concentration for an
assay that performs 6 reactions per library strip.

If a sample concentration is greater than 1,024.00X or 40.00X the target concentration,
depending on the assay, you must manually dilute the sample to the target concentration,
or to a value within range for automated dilution before loading on the sample plate.

IMPORTANT! A warning symbol ((!)) with a message that states “Sample concentration out
of range” can be shown in error for automated sample dilution in the Run Plan screen when
you plan a run, or view the Run Summary screen, in Genexus™ Software.

. If the sample concentration is below the required minimum concentration and shows a
Dilution Factor of 1.00 (that is, no dilution), the message is valid.

. If a sample that includes the warning message shows a Dilution Factor >1.00 and
<1,024.00 (4 reactions per strip) or >1.00 and <40.00 (6 reactions per strip), the message is
not valid and can be ignored.

. When you see the maximum Dilution Factor of 1,024.00 (4 reactions per strip) or 40.00
(6 reactions per strip), multiply the maximum value of the target concentration range by
the maximum dilution factor (that is, 1,024.00 or 40.00). If the product of the calculation is
greater than the sample concentration, the message is not valid and can be ignored.

Note: The sample volume that is required for library preparation is not adjustable. The volume
depends on the number of primer pools in the assay, sample type, and library chemistry.

c. Ensure that sample plate information is correct, then click Next.

In the Review step, review the run plan summary, then click Save & Print to print the run setup
guide, if desired. Click Save to save the run without printing.

Note: To print the run setup guide, you must allow pop-ups in the browser.

The run plan summary lists the following details.

* the consumables that are required for this * where to load samples and primer pool
run tubes
* how much sample volume to load ® details about the assay.

Note: If you are using an assay with lon AmpliSeq™ HD library chemistry, the primer pool positions
show that HD primer pools occupy both rows:
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Primer Tube Positions

1 2 4 5 5 7 a
®7 1 2 3 4 [ f 8
1. OPA DNA w2.8.0-0.0.2 [ 100085165: OPA Pool 1] 2. OPA DNA w2.8,0-0.0.2 [ 100085165: OPA Poal 1]
3. OPA DNA Fus w2.8.0-0.0.2 [ 100085165: OPA Pool 1] 4, OPA DNA Fus w2.8.0-0.0.2 [ 100085165: OPA Pool 1]
5. OPA Fusions w2.8,0-0,0,2 [ 100085165 OPA Pool 1 ] 6, OPA Fusions w2.8,0-0.0.2 | 100085165: OPA Pool 1 |
7. OPA DNA Fus w2.8.0-0.0.1 [ 100085165: OPA Pool 1] l 8. OPA DNA Fus w2.8.0-0.0.1 [ 100085165: OPA Pool 1]

(D The position of the primer tubes.
@ The legend for the image.

In the example outlined in red, primer tube 7 contains OPA Pool 1 for the OPA DNA Fusion assay, in the seventh
position from the left.

After saving, the run appears in the Manage Runs screen in the run list with the name you
specified.

After you select the run and load the sequencer, the run is started on the sequencer screen.

When the sequencing run is complete, you can recover the leftover volume from each library that was
prepared in the run. For more information to find, recover, and purify the leftover library preparations,
see the Genexus™ Integrated Sequencer User Guide (Pub. No. MANOO17910).

Plan a Library to Result run

You can plan runs for sequencing that start with libraries. This is called a Library to Result run. Before
you can plan a Library to Result run, you must first enter sample information and prepare a library
batch that associates an assay with the library batch. The library batch must be created with the
assay to be used in the run. The assay specifies the barcode set that was used to prepare the sample
libraries.

If the sample libraries were prepared using a barcode set that is not specified in the assay you want run,
you must do the following:

* (Create a new assay, or copy an existing assay, and specify the new barcode set in assay setup.

* Prepare a new library batch that selects the new assay.

For more information, see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the
Genexus™ Software help system.

Genexus™ Software guides you through the four steps of planning a Library to Result run: Setup,
Assays, Library Batches, and Review. You can view progress through the steps in the upper left
corner of the Runs / Library to Result screen.

1. In the menu bar, click Runs » Library to Result.

Note: You can also click -+ Library to Result in the Runs / Manage Runs screen.
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2. In the Setup step, enter a name for the run, then configure the reporting options.
a. In Run Name, enter a unique name.
The name is limited to 50 characters and no spaces are allowed.

b. (Optional) In the Reporting (Optional) section, ensure that Generate Report is enabled to
generate a variant report using the default report template.

c. (Optional) In the Reporting (Optional) section, enable Upload BAM files to Server to upload
BAM files to another Genexus™ Integrated Sequencer or to lon Reporter™ Software.

Option Description

Upload BAM files In the dropdown lists that appear, select the Genexus™ Software account
to another Genexus™ | and the software version.

Integrated Sequencer. | To configure a Genexus™ Software account that you can use for data
uploads, click Set up Account. For more information, see Genexus™
Software 6.8 User Guide or the Genexus™ Software system help.

Automatically upload | In the dropdown lists that appear, select the lon Reporter™ Software
data for further account and software version.

analysis with lon To configure an lon Reporter™ Software account that you can use for
Reporter™ Software. | data uploads, click Set up Account.

Note: To transfer data to lon Reporter™ Software, you must add one or
more lon Reporter™ Software accounts in Genexus™ Software.

For more information, see Genexus™ Software 6.8 User Guide or the
Genexus™ Software system help.

Alternatively, you can upload BAM files to another Genexus™ Integrated Sequencer or to lon
Reporter™ Software after a run is successfully completed.

d. Click Next.

If a chip is installed in the sequencer, the Chip View graphic in the lower left corner indicates
the lanes that are available for sequencing.

3. In the Assays step, select one or more assays that you want to include in the run.

For the assay to be selectable at this step, you must have prepared a library batch that assigns
the assay to the batch. The assay specifies the barcode set that was used to prepare the sample
libraries.

a. Use the Y (Filter) tools in table column headings to find assays of interest, if desired.

b. In the Research Application column for the assay of interest, select one or more research
applications, such as DNA and Fusions, to include each selected research application for the
assay in the run plan.

After you select an assay and the research application for the assay, the list is filtered to show
compatible assays that can be selected and run at the same time.

Note: To create a new assay, see “Create an assay in Genexus™ Software for use with a
custom panel” on page 56.

c. If more assays are included in the run, repeat substep 3b for each extra assay.
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d. Click Next.

4. In the Library Batches step, select the library batch that you want to use in the run, then click
Next.

Note: Only one library batch can be selected per assay. However, you can plan a library run that
uses multiple assays if you select multiple compatible assays in the Assays step.

a. If you selected the Upload BAM files to Server reporting option in the Setup step, make the
following selections from the Genexus Workflow or lon Reporter Workflow dropdown list.

* Select Upload Only to upload sample data to the selected software account
automatically after run completion.

* Select the desired Genexus™ Software assay or lon Reporter™ Software analysis workflow
to upload sample data and perform an analysis in the target software automatically after
run completion.

Note: In order for the lon Reporter™ Software analysis workflow to appear in the list, you
must tag the analysis workflow for use with the lonReporterUploader plugin. For more
information, see the software help system or the lon Reporter™ Software 5.18 User Guide
(Pub. No. MAND024776).

The Chip View updates to show the lanes to be used in the run as green. Lane usage is calculated
based on the number of samples and minimum reads per sample entered at assay setup.

lon Torrent™ GX5™ Chip lon Torrent™ GX5™ Chip

395 OCAGDNAFus 4 OCAEDNAFus 7
@ apel W5.0.2 Smhples @ s Samples

@ Green lane color denotes lane usage and sample @ Red lane color denotes sample assignment that
assignment within lane capacity. exceeds lane capacity.

If the minimum reads per sample x number of samples exceeds the chip or lane well capacity,

a dialog box appears after you click Next asking you to confirm that you want to continue. After
clicking Yes, the Chip View updates and shows the lane color as red instead of green. In the
example shown at right, seven samples were included in a library batch instead of four. The run is
allowed if the lane capacity is exceeded, but you may not achieve the required reads per sample to
pass QC metrics.

5. In the Review step, review the run plan summary.

* C(Click Save and Print to print the run setup guide.
¢ Click Save to save the run without printing.

Note: To print the run setup guide, you must allow pop-ups in the browser.
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The run plan summary lists the consumables that are required for the run, where to load the library
batch on the sample plate, and how much library volume to load.

The run appears in the run list on the Manage Runs screen with the name you specified.

After you select the run and load the sequencer, the run is started on the sequencer screen.

Plan a BAM to Result run

Before you can plan a BAM to Result run, you must enter BAM samples into Genexus™ Software. For
more information, see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the Genexus™
Software help system.

Planning a run to analyze BAM samples is organized into steps: Assays, Samples, and Review. You
can view progress through the steps in the upper left corner of the Runs / BAM to Result screen.

1. In the menu bar, click Runs » BAM to Result.

Note: You can also click + BAM to Result in the Runs / Manage Runs screen.

2. In the Assays step, enter or make the following selections.
a. Enter a unique name.
The name is limited to 50 characters and no spaces are allowed.

b. Use the Y (Filter) tools in table column headings to find assays of interest, if desired.

For more information, see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or
the Genexus™ Software help system.

c. In the Research Application column for the assay of interest, select the research application,
such as DNA and Fusions or DNA, to include the selected research application for the assay
in the run plan.

You can select only one research application of an assay per run.
d. Click Next.

3. In the Samples step, select the BAM samples from the list that you want to analyze, then click
Assign.

Note: Only BAM samples that are compatible with the selected assay are listed. Compatibility is
determined by the sample type, such as DNA or DNA and Fusion.

a. If needed, click ® in an assigned sampile tile to remove the sample from the plan.
b. Click Next.

4. Inthe Review step, review the samples in the run plan summary, then click Save and Launch.
The run is listed in the Results / Run Results screen. The run is launched or the run is queued if
other runs are in progress.
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Load the sample plate

m Dilute or concentrate the samples, if needed, then load the sample plate—Nucleic Acid to

Resultrun ...................

B Dilute and pool libraries, then load the sample plate—Library to Resultrun .................. 97

Before starting a Nucleic Acid to Result or Library to Result run on the instrument, you must quantify
and dilute the samples or sample libraries, if needed, then load the sample plate.

If you are using the Genexus™ Purification Instrument in the standalone configuration, you must
manually transfer quantified samples from the 48-Well Nucleic Acid Archive Plate to the sequencer
sample plate, following the run setup guide in the Nucleic Acid to Result run plan.

Dilute or concentrate the samples, if needed, then load the
sample plate—Nucleic Acid to Result run

Isolate DNA and RNA samples using one of the procedures and kits that are recommended in
“Recommended materials for nucleic acid isolation and quantification” on page 23.

Nucleic acid samples with concentrations up to 1,024X of the target concentration for an assay
(displayed as default values in the Sample Plate step screen in run planning) are in range for automated
dilution and require no manual dilution. Enter the concentrations during run planning at the Sample

Plate step (see step 5 on page 89).

Note: If desired, manually dilute samples to the required concentration to avoid loss of sample due to
the required volume overages during automated dilution.

1. For samples with concentrations that are out of range for automated dilution, manually dilute the
sample with nuclease-free water, or concentrate the sample to a concentration <1,024X of the
target concentration. For samples that are in range, go to step 2.

Sample concentration

Action

<0.04 ng/uL

Concentrate the sample to greater than or equal to the target
concentration.

>0.04 ng/uL, but less than the
target concentration

Run is allowed but sample concentration may not be optimal for
library preparation. Concentrate the sample to greater than or equal
to the target concentration.

<1,024X of the target
concentration

No manual dilution is necessary. The sequencer dilutes the sample to
the target concentration automatically during the run.

>1,024X of the target
concentration

Manually dilute to the target concentration based on assay type, or to
a concentration in range for automated dilution by the sequencer.
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Note:

. For samples with less than the minimum required volume, manually dilute an aliquot to the target
concentration and minimum required volume.

. If you enter a concentration <0.04 ng/pL or >10,000 ng/pL, a warning that the concentration is
out of range appears, and you are not allowed to proceed to the next step.

. If the concentration is <10,000 ng/pL, but >1,024X of the target concentration, you can proceed,
but because the instrument cannot dilute samples more than 1,024-fold, the diluted sample
concentration will be greater than the target concentration.

2. Add samples and controls, if used, to the sample plate at the volume and positions that are
specified in the run setup guide.

The sample volume is not adjustable and depends on sample type, the number of primer pools in
the assay, and library chemistry. The following table also provides loading volume.

Sample type Number of primer pools Volume

lon AmpliSeq™ chemistry

DNA 1 15 uL
DNA 2 25 L
RNA 1 15 uL
RNA 2 25 L

lon AmpliSeq™ HD chemistry

DNA 1 20 pL
DNA 2 40 pL
RNA 1 20 pL

3. Seal the plate with a sheet of Adhesive PCR Plate Foils (Thermo Fisher Scientific Cat. No. AB0626).

Note: The use of other plate seals can affect performance.

Note: We recommend that you use Corning™ Microplate Aluminum Sealing Tape (Fisher Scientific
Cat. No. 07-200-684), or Adhesive PCR Plate Foils (Thermo Fisher Scientific Cat. No. AB0626). The
use of other plate seals has not been tested and could affect performance.

4. Keep the plate on ice until you are ready to load it in the sequencer.
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Dilute and pool libraries, then load the sample plate—
Library to Result run

1. Dilute each manually prepared and quantified sample library to 200 pM with nuclease-free water.

Note: Each library must be barcoded with a unique barcode or barcode pair. Use this
concentration as a starting point, then titrate up or down based on sequencing results, if needed.

2. Add equal volumes of each library to a new 1.5-mL low DNA retention tube so that the total volume
is greater than the volume specified in the run setup guide provided by the software.

Note: For information on combining DNA and RNA libraries recovered from Sample to Result or
Nucleic acid to Result runs using assays that include DNA and fusions, see Genexus™ Software 6.8
User Guide.

3. Mix well by pipetting up and down five times, then transfer the specified volume of each library
batch to the sample plate position specified in the run setup guide.

4. Seal the plate with a sheet of Adhesive PCR Plate Foils (Thermo Fisher Scientific Cat. No. AB0626).

Note: The use of other plate seals may affect performance.

Note: We recommend that you use Corning™ Microplate Aluminum Sealing Tape (Fisher Scientific
Cat. No. 07-200-684), or Adhesive PCR Plate Foils (Thermo Fisher Scientific Cat. No. AB0626). The
use of other plate seals has not been tested and may affect performance.

5. Keep the plate on ice until you are ready to load it in the sequencer.

Guidelines for library quantification—Library to Result runs

* We recommend that you use libraries that are freshly quantified and diluted before pooling in a
library batch.

* Preprepared libraries can be quantified by one of the following three methods:
- Quantification using the Agilent™ 2100 Bioanalyzer™ instrument

— Quantification using the Qubit™ Fluorometer

— Quantification by gPCR using the lon Library TagMan™ Quantitation Kit
See one of the following guides for specific procedures.

— lon AmpliSeq™ Library Kit 2.0 User Guide (Pub. No. MAN0006735)

— lon AmpliSeq™ Library Kit Plus User Guide (Pub. No. MANOO17003)

— lon AmpliSeq™ HD Library Kit User Guide (Pub. No. MAN0017392)
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After you have planned a run in Genexus™ Software, use the run setup guide provided by the software
to load samples in the sample plate, and to determine which consumables to load in the sequencer.
Follow the step-by-step instructions in the sequencer touchscreen during run setup. The vision system
of the sequencer tracks the addition of consumables in real-time and alerts you if a component is
loaded in an incorrect position, or if an incorrect quantity is loaded.

Before you begin

Before setting up a sequencing run, review general procedural guidelines for handling panels, reagents,
and samples to minimize the chance of contamination. For more information, see “Guidelines for panel
and reagent use and handling” on page 26 and “Guidelines for preventing contamination” on page 27.

1. Remove the library and templating strips from their packaging in the refrigerator or freezer, and
prepare them for loading in the sequencer.

* Equilibrate or thaw the following reagent strips at room temperature for 30 minutes.
— Genexus™ Strip 1
— Genexus™ Strip 2-AS. If you are delayed in loading, keep the thawed strips on ice or at

4°C until you load them in the sequencer.

— Genexus™ Strip 3-GX5™ (or Genexus™ Strip 3-GX7™)

* Thaw Genexus™ Strip 4 by laying the strips on ice for 30 minutes, or incubating at 4°C for

30 minutes. If you are delayed in loading, keep the thawed strips on ice or at 4°C until you
load them in the sequencer.

IMPORTANT! Ensure that contents of strips that are stored frozen are completely thawed before
installing in the sequencer.
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2. Visually check tube 3 of the Genexus™ Strip 2-AS for precipitation. If needed, flick the tube the
strip to dissolve the precipitate.

Note: You can also vigorously vortex the strip on a platform vortexer to dissolve precipitate

if you have a Genexus™ Strip Centrifuge Adapter to hold the strip during the centrifugation.
Centrifugation is needed after you vortex a strip. For more information about vortexing the strips,
and obtaining and using the adapter, see .

3. Remove primer pool tubes in tube carriers that are needed for the run from the freezer, then thaw
at room temperature for 30 minutes. After thawing, gently tap the primer pool tube or tubes on a
bench surface to ensure that contents are collected at the bottom of the tubes. Keep the tubes and
carriers on ice or at 4°C until you load them in the sequencer.

4. If you are installing a new Genexus™ Cartridge, thaw the cartridge at room temperature for
30 minutes before installing in the sequencer.

5. Genexus™ Strip 1, Genexus™ Strip 3-GX5™, and Genexus™ Strip 3-GX7™ contain magnetic beads
in one or two positions, yellow or brown in color, that sometimes get trapped in the upper
"keyhole" of the tube. Dislodge these beads from the keyhole before installing the strip in the
sequencer. Use the following procedure for each strip.

Note: If you have a Genexus™ Strip Centrifuge Adapter, vortex the strips on a platform vortexer
to dislodge air bubbles and magnetic beads or to dissolve precipitate, then briefly centrifuge the
strips using the adapter to collect the contents at the bottom of the tubes. For more information,
see.

a. Invert the strip 3—4 times to dislodge beads that are trapped in the keyholes.

b. To remove any remaining beads and liquid from the
keyholes, grasp the strip at one end with the strip
seal facing up, then swing the strip with a rapid,
downward centrifugal arm motion, ending with a
sharp wrist-flick.

c. Grasp the strip at the other end, then repeat the
centrifugal motion.
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1

d. Check tube positions for significant amounts of beads that are still trapped in keyholes (see
the following figure), then repeat the centrifugal motion, if needed. It is acceptable if a few
beads remain in the keyhole or on the tube wall, but most should be either in suspension or in
a pellet at the bottom of the tube.

Example Genexus™ Strip 3-GX5™ before (upper) and after (lower) inversion. The carrier has been removed to
show tube contents more easily.

@ Magnetic beads trapped in keyholes @ Magnetic beads dislodged from keyholes

Note:

. It is not necessary to resuspend the magnetic beads completely —it is only necessary to
dislodge most of the beads that can be trapped in the keyhole. The instrument resuspends
the beads during the run when needed.

. Fine bubbles can form above the liquid in some tubes after inversion. These bubbles do not
affect the run.

6. Inspect all strips for large bubbles lodged under the surface of the liquid or at the bottom of each
tube or well. Gently tap the strips on a benchtop to dislodge any bubbles without splashing the
contents onto the upper tube walls. If tapping fails to dislodge a bubble, use the technique that is
described in substep 5b until large bubbles are dislodged.
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Fill Genexus™ Primer Pool Tubes

Fill Genexus™ Primer Pool Tubes

Genexus™ Primer Pool Tubes must be manually filled with the custom panels at the appropriate volume

and in the correct primer pool tube positions. For lon AmpliSeq™ library panels, use one carrier per DNA
or RNA assay primer pool. The two positions in the primer pool tube carrier are designated as shown in

the following figure:

HD FWD primer pool
@ Position 2 tube: Contains lon AmpliSeq™ HD REV primer pool

/ﬁ @ Position 1 tube: Contains lon AmpliSeg™ DNA, lon AmpliSeg™ RNA, or lon AmpliSeq™

Note: When you order custom panels from lon AmpliSeq™ Designer (AmpliSeq.com), be sure to order
a sufficient amount of panel for your needs, and request the tube format, not the plate format. Library
preparation on the Genexus™ Integrated Sequencer requires greater panel volume per sample than
manual library preparation, or library preparation on the lon Chef™ System.

1. Add primer pool at the indicated volume, appropriate to the assay type, to the Genexus™ Primer
Pool Tubes using the following tables as a guide. Fill the number of tubes specified by the run plan
summary.

Table 22 lon AmpliSeq™ DNA assays

Chip conc:::rzltion“ Barf:ode I.(it Numb.er of Voll.{r.ne in VO|L.IIT1e in

1 configuration reactions position 1 position 2
GX5™ Chip 2X 32 4 140 pL -
2X 48 6 168 pL —
GX7™ Chip 2X 32 6 168 pL -
2X 48 6 168 pL —

[ Custom DNA panels can be delivered at 5X concentration on request for specific purposes (for example, the need for
increased sample volume per reaction in manual library preparation). Panels at 5X concentration must be manually diluted to
2X concentration before loading into Genexus™ Primer Pool Tubes.

Table 23 lon AmpliSeq™ RNA assays

. Panel Barcode kit Number of Volume in | Volume in
Chip . . . . i .
concentration configuration reactions position 1 position 2
GX5™ Chip 5X 32 4 75 pL -
5X 48 6 88.5 pL -
GX7™ Chip 5X 32 6 88.5 uL -
5X 48 6 88.5 pL -
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Table 24 lon AmpliSeq™ HD assays

Primer pool type Panel concentration Volume in !
P P position 1 position 2
lon AmpliSeq™ HD FWD 10X 50 yL -
lon AmpliSeq™ HD REV 10X — 50 L
IMPORTANT!

. If you are using lon AmpliSeg™ library chemistry, leave the tube that is in position 2 empty and
uncapped, but do not remove the tube from the carrier before loading in the sequencer. Do not
add a second lon AmpliSeg™ primer pool to the position 2 tube.

. If you are using lon AmpliSeg™ HD library chemistry, add the FWD and REV primer pools to the
appropriate tubes in the same carrier.

. Ensure that no bubbles are introduced at the bottom of the tube when adding the primer pool.

2. If you do not install the primer pool tube carriers in the sequencer immediately, cap the tubes
that contain primer pools, then store the tube carriers on ice. Remember to uncap all tubes before
installing.

Load the sequencer and start a run

1. Tap Run on the sequencer home screen to start the loading procedure.

Genexus Integrated Sequencer
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2. In the Run Selection screen, select the run that you want to use from the list.

Run Salection

Run List

Cancel

If you select a run that requires more lanes than are available on a currently installed chip, a dialog
box appears giving you the option to install a new chip, or cancel. If you proceed with a new chip,
a post-chip clean is performed, then the sequencer prompts you to perform the following steps.

* Clear Deck * Clear Sequencing Reagents
e UV Clean * Load Sequencing Reagents
¢ Load Deck

3. In the Review Run screen, confirm the run selections, then tap Next.

Review Run

Confirm the
E2E_DNA-RNA-Mix_BD_0

1: Previously used
Previously used

Myeloid DNA Fus v2 w

Lane 4: Empty

The deck door opens automatically.
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Note:

.

If the instrument vision system detects consumables loaded on the deck, the sequencer
prompts you to remove the consumables, then starts a UV Clean.

Select the Do Force Clean checkbox if there is an unused lane or lanes on the installed chip
after the run, but you want to start your next run on a new chip after the current run. A force
clean automatically cleans the instrument after the run, eliminating the need for an operator to
perform the cleaning procedure manually between the completion of the current run and the
next run. Selecting Do Force Clean renders all lanes of the installed chip unusable after the run.

4. Inthe Load Deck screen, the sequencer instructs you step by step to load each required
consumable in a highlighted position on the deck. The sequencer detects the loading of each
consumable in real time and advances to the next component automatically.

Load Deck

IMPORTANT!

Ensure that you remove the primer pool tube cap or caps before installing the tube carrier on the
deck.

Ensure that you load the correct type of barcode plate and library strip 2 for the type of run

you are setting up. The sequencer displays a warning if you have installed consumables that are
incompatible with the run you have selected, for example, a Genexus™ Barcodes AS plate or
Genexus™ Strip 2-AS in an HD run.

Ensure that you remove the lids from all the boxes of Genexus™ Pipette Tips before you load the
boxes in the sequencer.

After removing the tip box lid, visually inspect tip boxes to ensure that all tips are seated level

in the tip rack before and after placing on the instrument deck. If a bent or damaged tip is
suspected, replace the tip box with a new tip box. Reracking of tips from partially used boxes is
not supported and can cause some tips to seat at an angle, which can affect run performance.
Ensure that all tip boxes sit level on the deck by visually inspecting all boxes across the tip
station. Reseat the boxes before starting the run, if needed.

Do not use third-party pipette tips or rerack third-party tips into used Genexus™ Pipette Tips
boxes. Use of third-party tips can result in sequencing run failure.

Load instrument plates, including the PCR plate, barcode plate, enrichment plate, and sample
plate, into position by pressing down firmly and evenly on all sides and corners of each plate.
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Note:
. A primer pool tube carrier can only be installed with

the position 1 tube in the back row of the Primer

Pool Tube Station. Follow the guidance in the run U @

setup guide for loading the primer pool tube carrier or

carriers in the correct position and order in the station.
. If the sequencer cannot read the correct loading of

an unexpired consumable, tap Help in the lower left

corner of the screen to override the block. After using

this override, the name of the consumable will not @ Position 1

appear in the run summary consumables list. ® Position 2

5. If prompted, insert a new GX5™ Chip and Genexus™ Coupler. Insert the chip into the chip install

slot with the chip notch oriented down and toward the front of the instrument.

@ Notched corner of chip

Note: A chip shuttle under the deck moves the installed chip to loading and sequencing positions

during the run.

IMPORTANT! Insert the Genexus™ Coupler so that it is level to properly align with the GX5™ Chip.
A coupler that is installed at an angle or is not level will not align properly to the chip and can result

in a failed run.

6. When the deck consumables have been loaded, lock the library and templating strips in place by

sliding the latches toward the rear of the deck.

Note: We recommend that you load the sample plate last.
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Cancel

If a chip is detected and the strip latches are closed, the Close Deck Door screen appears.

7. Close the deck door, then tap Next.

Close Deck Door

Close the deck door, then press Next

¢ If you installed a new chip in the sequencer, the sequencer prompts you to open the
sequencing reagents bay doors to empty the waste and remove used sequencing reagents
bay consumables. Proceed to step 8.

¢ If you are using a chip that was previously installed and has sufficient lane capacity for the run,
the sequencer prompts you to start the run.

IMPORTANT! The cartridge and bottles in the sequencing reagents bay must be replaced every
time that a new chip is installed, regardless of how many lanes were used in the previous chip.
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8. Follow on-screen instructions to empty the waste in the Waste carboy, remove waste pipette
tips, remove the used Genexus™ Bottle 1, Genexus™ Bottle 2, Genexus™ Bottle 3, and Genexus™
Cartridge, then tap Next.

Clear Sequencing Reagents

Empty

IMPORTANT!

. Ensure that you empty and replace the Waste carboy and the waste pipette tip bin.

. After replacing the emptied Waste carboy, ensure that you reinsert the waste tube into the
carboy.

. Follow all applicable local, state/provincial, and/or national regulations when recycling or
disposing of consumables and liquid waste.

9. Install a new Genexus™ Bottle 1, Genexus™ Bottle 2 (two required), Genexus™ Bottle 3, and
Genexus™ Cartridge.

Load Sequencing Reagents
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IMPORTANT!

. Before installing, gently invert each Genexus™ Bottle 2 five times to mix—avoid vigorous mixing.
Inspect the plastic nozzles for any pinches or deformations. To avoid pinching or folding of the
plastic nozzle, install the bottles straight-on, not at an angle.

. The installed reagents can be used for up to 14 days on the sequencer with full performance.
After 14 days, you may observe reduced performance.

After reagents are installed, the Close Sequencing Reagent Bay Door screen appears.

10. Close the sequencing reagents bay doors.

After the doors are closed, the sequencer starts the run.

At the beginning of the run, the instrument chip coupler check verifies the chip, checks for leaks,
then calculates run time.

A sequencing run encompasses the following stages.

1. Starting 5. Pre-sequencing
2. |Initializing 6. Sequencing

3. Library Prep 7. Cleaning

4. Templating

At each stage, the instrument shows the time remaining on the touchscreen.

Note: The time remaining shown on the screen does not include run analysis time.
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Clear the instrument deck and perform a UV Clean  ©5"

Sequencing

CLEL
o0 iy,
&Y %,

00:31:24
B Library Prep

%apun®®

When the run finishes, the sequencer displays the Run Complete screen.

Note: If all the lanes of a chip are used, the chip shuttles to the install position. You are prompted
to remove the chip and coupler, and clear the sequencing reagents.

Clear the instrument deck and perform a UV Clean

After a run completes, remove used consumables from the deck and perform a UV Clean to ready the
instrument for the next run.

1. In the Run Complete screen, tap Next to start removal of used consumabiles.

Sequencing

Run
Complete

The deck door opens.
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2. In the Clear Deck screen, the sequencer provides step-by-step instructions by highlighting the
components to be removed. Unlock the library and templating strips by sliding the latches toward
the front of the deck, then remove the used strips. Remove the remaining deck components

specified by the sequencer.

Clear Deck

P 1 in position 1

3. Inspect the Genexus™ Filter in the liquid waste disposal port and verify that no standing liquid is
present. If standing liquid is present, manually remove the liquid with a pipette, then pull out the
filter. Test the filter with water to determine if a clog is present.

¢ [f the Genexus™ Filter is clogged, replace it with a new filter. For more information, see the
Genexus™ Integrated Sequencer User Guide (Cat. No. MAN0O17910).

¢ [f the Genexus™ Filter does not appear to be clogged, a line clog downstream of the filter is
implicated. Contact Technical Support and report a possible deck liquid waste line clog.

4. When finished, close the deck door, then tap Next.

Close Deck Door

Close the deck door, then press

A two-minute UV Clean starts.
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Sequencing

’bﬁﬁ“ "#ﬁ&

00:01:58

UV Clean

Yay uﬂ":‘ﬁ

5. After UV cleaning, if all the chip lanes were used, the sequencing reagents bay doors unlock. Open
the doors, remove used components from the bay and empty the Waste carboy, then tap Next.

Clear Sequencing Reagents

IMPORTANT! Do not discard or remove the conical bottles, unless alerted by the sequencer to
replace the bottles after a conical bottle flow rate test. For more information, see the Genexus™
Integrated Sequencer User Guide (Cat. No. MAN0O017910).

IMPORTANT! Follow all applicable local, state/provincial, and/or national regulations when
recycling or disposing of Genexus™ Integrated Sequencer consumables and liquid waste.

CAUTION! The Genexus™ Bottle 1 (small waste bottle) contains small amounts of formamide.
Dispose of this waste appropriately.
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MISE EN GARDE ! Le Genexus™ Bottle 1 (petit flacon de récupération de déchets) contient de
petites quantités de formamide. Eliminez ces déchets de facon appropriée.

6. After removal of used components, close the sequencing reagents bay doors, then tap Next.
The sequencer returns to the home screen.

Options for an expired sequencer initialization

A sequencer initialization is defined by the installation of a new chip, chip coupler, sequencing
bottles, and reagent cartridge on the sequencer before a run. Reagents are stable on the sequencer
for 14 days, after which you can experience reduced performance. After 14 days, the following on-
instrument warning appears:

Run Workflow

A

Attention:

It has been longer thar

Users have the option to ignore the warning and proceed with an expired initialization by tapping
Ignore, or to perform an instrument clean by tapping Cancel. After tapping Cancel, select
Settings » Clean instrument to clean the instrument before starting a run with a new chip. Lane
assignment for a new run starts with lane 1.

After 28 days, you can no longer proceed with an expired initialization. The following message appears:
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Run Workflow

Attention:

It has been lenger than the

Thi Instrume;

Tap Cancel to return to the main menu to perform an instrument clean.
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Use the Results menu to review results and data analysis, and to perform data management tasks. You
can view results sorted by sample or by run.

Selection Description

Click Results » Sample Results | Select this option to review completed sample results and reports.

Click Results » Run Results Select this option to review completed run results and reports by assay.
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Example results

Note: The following examples are from sequencing runs that include a control sample.

P P9 il

A Rundd_803_Mmix Spct_SFMixvd d Variants
[ artant ey
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Figure 2 Example results from a custom DNA and Fusions sequencing run

@ Run Name - The unique name of the run given when it was created in the software. For more information, see
“Review run results” on page 127 and “View the run summary” on page 123.

@ Assay Name - The name of the assay used in the run plan.

@ Sample Name - The unique identifier created when the sample was entered into the software. For more information,
see “Review sample results” on page 118 and “View sequencing results” on page 134.

@ Variants — Click to see a list of all variants in the results. For more information, see “View SNV/INDEL results” on
page 144, “View fusion results” on page 148, and “Review the variant pileup view” on page 152.

@ Plugins —Click to view results for plugins that are included in the sequencing run. For more information, see “Review
molecular Coverage Analysis plugin results” on page 170 and “Review coverageAnalysis plugin results” on page 166.

@ Reports —Click to open the screen from which you can create a report. For more information, see “View assay
metrics and the run report” on page 129 and “Generate a variant report” on page 163.

@ Edit Filters—Click Edit Filters and select another filter chain from the list , or select No Filter Chain, to remove all
filter chains, then click Save to apply the filter chain selection to the list of results that are shown. Or, Click Edit
Filters and select another gene list, or select No Gene List, then click Save to apply the gene list selection to the
list of results. If you do not apply a gene list, variants in all genes will be shown. But if you do apply a gene list, the
list of variants will show only variants for the genes that are included in the gene list. For more information, see the
Genexus™ Software help system.

Export —Click to download the information for the variants in XLS or TSV format.

@ Columns—Click Columns to change the columns in the sample results table. Select a checkbox in the list of
columns to add a column to the table, or deselect a checkbox to remove a column from the table. For more
information, see the Genexus™ Software help system.

@ +++ (More Options) - Use this menu to reanalyze the run, download a Customer Service Archive (CSA) file, download
files, view a history of the variant classifications, view the run report tab, or run plugins after a sequencing run is
complete. For more information, see “Reanalyze a run” on page 164, “Customer Support Archive” on page 172 or
the Genexus™ Software.

@ Columns currently available in the list of results. You can change the columns that are shown in the sample results
table. For more information, see “Customer Support Archive” on page 172 or the Genexus™ Software.

@ Variant class - Select an option to limit the types of variants that are shown and toggle between different variant
results: All variants, SNVs/Indels or Fusions. For more information, see “Create and assign variant classifications”
on page 159.
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@ QC - The QC status of a completed run.

e " (Passed) indicates the sample passed all QC metrics.
e X (Failed) indicates the sample failed a QC metric.
e — (Not Calculated) indicates a sample did not undergo QC analysis.
@ Key Findings —The Key Findings tab shows details about the sample, a summary of key metrics for the run, and
key variants for genes assayed in the run.
Note: The Key Findings tab is by default the first view that is first shown for sample results. For more information,
see “View key findings” on page 139.

The information that is displayed depends on the assay that was used in the run.

Rund]_S07_SeraSeqFusionyd  0f o/ KeyFindings  Variants
b
User Key Read Call
Classification T vasiantil T vadiamthame T vaame T Locus T  Genesibwons) T Couts T Type - Gene oform T Oncomine Driver Gene § 5
aa4T Fusien PRESENT ETVE-NTRELESNLISCOSFSTLE NTRES T

Cunificasinn

Figure 3 Example results from a custom Fusions sequencing run

Results navigation bar overview

After you select a run result or a sample result, a results navigation bar appears and allows you to
easily toggle between different results screens for each run. You can quickly switch between run-level
results, assay-level results, and sample-level results for the run. In addition, you can easily find samples
or assays in the run with the search field that appears in each dropdown list.

Assay-level results include assay metrics, such as final read data.

Samples that are run with the same assay in the same run share the same run report. All other results
are specific to the sample and are shown in the sample results.

Genexus | lon Torrent o

Results CCAplus_F_cust_reanalysis ¥ / OCAplus_custom_fusio (Fusions) ¥ / JG_6.2.1_w130_TCR_thor_5_1661213396 ¥
JG_S.Z.l_wlSO_TCR_thor_5_16612 b Variants Plugins Repo-'[s
Sample Details ; }

O s_custom_fusio (Fusions)
Sample Name crenooes crerrerer Sample Type Application Category
JG_8.2.1_wi130_TCR_thor_5_1661213995 02 OCT 2018 Unknown FFPE Cancer
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Results navigation bar overview

Callout Dropdown Description
menu
1 Run name The run name is listed. Multiple runs are listed only if the run has been reanalyzed. For more

information, see “Reanalyze a run” on page 164.

2 Select Assay

You can click the assay name of interest to view assay metrics for the run.

You can search for or toggle between different assays used in the run. If only one assay is
associated with the run, only one assay name is listed.

Some results from a plugin that are included in the run, such as the customer support
archive plugin, apply to all of the samples for an assay in a run plugin results are comprised
of a consolidation of all of the samples. Results from such assay-level plugins are shown

in the Plugins tab when you select an assay but do not select any samples for the run. For
more information about plugins, see “Plugins for data analysis” on page 166.

You can select Select Assay from the dropdown menu to remove the assay selection.

If you remove the assay and sample selections, the Run Summary tab opens with a
summary of results for the run selected in the Run Results dropdown menu. Assay metrics
are also shown in the Run Report tab. For more information, see “View assay metrics and
the run report” on page 129.

3 Select
Sample

You can click a sample name to view the sequencing results for the sample. You can click
a different sample name to view other sample results for other samples in the run for the
assay that is selected in Select Assay. The search field allows you to find samples in the
run.

For Sample to Result runs that include a positive control, results for the positive control are
shown when you select Control Sample.

You can select Select Sample from the dropdown menu to remove the sample selection.
If you remove the sample selection, the Assay metrics tab for the selected assay opens. If
you select Select Assay with Select Sample shown, the Run Summary tab opens. Assay
metrics are also shown in the Run Report tab. For more information, see “View assay
metrics and the run report” on page 129.

lon AmpliSeq™ & lon AmpliSeq™ HD Custom Assay User Guide 117



P28 Chapter 9 Review data and results
Review sample results

Q)

Review sample results

In the Results / Sample Results screen, samples that have been sequenced are listed by sample

name.

See the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the Genexus™ Software help
system for information about how to find sample results of interest.

The following information appears in the Sample Results screen. You can add columns to the Sample
Results table to view more information. For example, you can add a column for Electronic Signatures
to view signature and lock information for variant reports. For more information, see the Genexus™
Software 6.8 User Guide (Pub. No. MAN0026409) or the Genexus™ Software help system.

Column

Description

Sample Name

The unique identifier created when the sample was entered into the software. Click the
Sample Name to open the Sample Results screen for the sample.

Assay Name

The name of the assay used in the run plan.

Run Name

The unique name of the run given when it was created in the software.

Sample Status

The status of the run or sample (for example: Completed, Running, Failed, Terminated,
Pending, Stalled).

Annotations

QC Status The QC status of a completed run.
o (Passed) indicates the sample passed all QC metrics.
¢ X (Failed) indicates the sample failed a QC metric.
e — (Not Calculated) indicates a sample did not undergo QC analysis.
Started On The date and time when the run was started.
Updated On The date and time when the last action was completed on the run.
Tags Tags that are assigned to the sample are listed.
Updated The information that is shown depends on the type of the assay and whether the option to use

the latest annotation is configured in the assay.

* The name and version of the annotation source that is applied to the sample result is
shown when an assay is configured to use the latest annotations but the annotation that
is applied to the results is not the latest annotation source.

* No information is shown in the column (the value is blank) when the latest annotation
source version is applied to the result, regardless of whether the assay is configured to
use the latest annotation source.

* No information is shown in the column (the value is blank) when an assay is configured
to not use the latest annotation source, and instead uses a fixed version of an annotation
source.

* N/Ais shown when an assay does not use an annotation set.

You can also perform the following actions in the Sample Results screen.

118

lon AmpliSeq™ & lon AmpliSeqg™ HD Custom Assay User Guide


https://www.thermofisher.com/search/results?query=MAN0026409
https://www.thermofisher.com/search/results?query=MAN0026409

Chapter 9 Review data and results 248
Review sample results

Option Description
Actions Available action links for a sample are shown when you place the pointer over the row of a sample.
* Report—Download the report (available only for samples with a sample status of completed).
* Assign Tags—Add or remove the tags assigned to a sample result.
¢ Audit—View the audit trail for the run.
* Notes—View, add, or delete notes for sample result.
* CSA—Download customer support archive (CSA) log files for the run to help with
troubleshooting.
* Reanalyze—Reanalyze a sample from the alignment step when a sample or reanalysis
successfully completes the basecalling step.
* Variant Audit—View the history of variant classifications.
Actions that | More actions are shown when you select one or more samples.
you can * Assign Tags—Assign a tag or tags to selected sample results in one action. The ©» Assign
perform when Tags command appears above the Sample Results table after you select one or more samples.
Bs/ZrLi]rsalegliCt * Compare—Compare variant results between multiple samples, or from a single sample over

time. The Compare command is not shown until you select at least two samples.

Download results files for a sample result

You can download results files for a sample result in Genexus™ Software.

1. In the menu bar, click Results » Sample Results, or Results » Run Results, then do one of the
following procedures.

Option Selection

Download files for a sample

selected sample from the
Results screen.

Download results files for a In the Results / Sample Results screen, place the pointer over the row
sample from the list of sample | of a sample of interest, then click Download Files.

results.

Download resullts files for a 1. In the Results / Sample Results screen, in the Sample Name

column, click the sample name of interest.
2. Click -+ (More Options) » Download Files.

Download files for a run or assay

Download results files for a In the Results / Run Results screen, place the pointer over the row of
run from the list of run results. | a run of interest, then click Download Files.

lon AmpliSeq™ & lon AmpliSeq™ HD Custom Assay User Guide 119



5 Chapter 9 Review data and results
Review sample results

(continued)

Option

Selection

Download results files for a 1
selected run or assay from the
Results screen.

. In the Results / Run Results screen, in the Run Name column,
click the run name of interest.

2. Click the run or assay of interest from the results navigation bar.
3. Click -+ (More Options) » Download Files.

2. In the Download Files dialog box, select the files to download, then click Download.

For information about the files, see the Genexus™ Software 6.8 User Guide
(Pub. No. MAN0026409) or the Genexus™ Software help system.

The selected results files are downloaded in one ZIP folder.

Results files

The following files can be downloaded from the View Results screen for each sample. The files that are
available for download vary depending on the assay used. Results files include the sequencing data,
results from the analyses, such as variant files, and audit and log files.

For a list and descriptions of plugin output files, see “Plugins for data analysis” on page 166.

For instructions to download results files, see “Download results files for a sample result” on page 119.

Option

File name

Description

Variant and QC
Metrics (.txt)

statistic.txt

Contains tumor mutational burden statistics.

Substitution Type
and Context Of
Somatic Mutations

(-png)

somatic mutation plotl.png

A histogram that shows the class of somatic
mutations. Somatic mutations can be divided
into 6 base substitution classes (that is, C>
A, C>G, C>T, T>A, T>C, T>G) based on
their substitution type. After incorporating
information about the bases immediately 5’
and 3’ to each mutated base, 96 possible
mutation types are in this classification.
These 96 mutation types are represented

on the x-axis, and variant frequency for
mutation type on the y-axis. Bars for each
substitution class are grouped and displayed
with different color.

Somatic Mutations
Across Substitution

Type (.png)

somatic mutation plot2.png

A pie chart dividing somatic mutations into
6 base substitution classes (that is, C>A,
C>G, C>T, T>A, T>C, T>G) based on their
substitution type.

Germ-line and
Somatic Variants

(-png)

before AFDist.png

A histogram that shows the frequency
distribution of allele ratio for total called
germline and somatic variants.

120

lon AmpliSeq™ & lon AmpliSeqg™ HD Custom Assay User Guide



https://www.thermofisher.com/search/results?query=MAN0026409

(continued)

Chapter 9 Review data and results 248
Review sample results

Option

File name

Description

Signature Pattern Of
Somatic Mutations

(-png)

somatic mutation plot3.png

A pie chart dividing somatic mutations in
groups consistent with specific mechanisms.

Variants

Filtered Variants
(.vef)!!

<Filter name> filtered.vcf

Summary of filtered variant results in variant
call format (VCF).

All Variants (.vcf)!']

Oncomine <LibPrepID>
<analysisID>.vcf

Summary of variant results in variant call
format (VCF).

Variant Summary
(.tsv)

Summary.tsv

File that lists SNV/INDEL, copy number, and
fusion results in tab-separated value format

(TSV).

Snvindel (.tsv)

Snvindel.tsv

File that lists SNV/INDEL variant results in
tab-separated value format (TSV).

Fusion (.tsv)

Fusion.tsv

File that lists fusion results in tab-separated
value format (TSV).

CNV (.tsv)

Cnv.tsv

File that lists copy number variant results in
tab-separated value format (TSV).

Sequencing Results

DNA Unmapped
Bam File (.bam)

<barcode> rawlib.basecaller.bam

Unmapped DNA barcode BAM file; output
after mapping reads to reference.

DNA mapped bam
file (.bam)

merged.bam

Mapped BAM file of combined barcode
reads.

DNA Mapped Bam
Index File (.bai)

merged.bam.bai

Mapped BAM Index file.

DNA Basecaller
FASTAQ File (.fastq)

<barcode> rawlib.
basecaller.fastqg

FASTQ file of the DNA barcodes used.

Bam File (.bam)

DNA Processed merged.bam.ptrim.bam Mapped BAM file of combined barcode
Bam File reads.

DNA Processed merged.bam.ptrim.bam.bai Mapped BAM index file.

Bam Index

RNA Unmapped <barcode> rawlib.basecaller.bam |Unmapped RNA BAM file; output of base

calling, contains unmapped reads.

RNA Mapped Bam
File (.bam)

<barcode> rawlib.
basecaller alignments.bam

Mapped BAM file of combined barcode
reads.

RNA Mapped Bam
Index File (.bai)

<barcode> rawlib.
basecaller alignments.bam.bai

Mapped BAM index file.
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Option File name Description
RNA Basecaller <barcode> rawlib. FASTQ file generated from the unmapped
FASTAQ File (.fastq) (basecaller.fastqg BAM file of the RNA barcodes used.
Test Fragment rawtf.basecaller.fastqg FASTQ file for the test fragment.
Basecaller FASTAQ
File (.fastq)

Audit and Log

Analysis Log File analysis.log Analysis log file.

Run Summary!? Info.csv Contains information about the run and
analysis, including software version details,
sample details, library details, run details,
assay details, reagent and consumable
information, run and sample QC metrics, and
instrument summary.

Run Audit PlannedRun-AuditTrail.pdf Contains all audit records pertaining to the
run.
Reports
Report <language> <sampleName> <mode> A PDF report that contains sample-specific
_<templateName> <assayName> results. For more information, see “Variant
<date>.pdf report” on page 162.
Sample Summary® |Info.csv Contains information about the run and

analysis, including software version details,
sample details, library details, run details,
assay details, reagent and consumable
information, run and sample QC metrics, and
instrument summary.

Troubleshooting Files

Log Filesl¥ analysis.log Analysis log file.

summary.<timestamp>.log Start and end time for each time an assay
module is executed for the analysis.

various.err Analysis pipeline logs used by field service

. engineers for troubleshooting.
various.out

Info.csv Contains information about the run and
analysis, including software version details,
sample details, library details, run details,
assay details, reagent and consumable
information, run and sample QC metrics, and
instrument summary.
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(continued)
Option File name Description

Log Filesl¥ PlannedRun-AuditTrail .pdf Contains the audit trail of the run plan in PDF
format.

Otherl¥ analysis.ini Analysis configuration files, including

analysisSamples.3son secondary and tertiary INI files.

VCF Files analysis.vcf Summary of variant results in variant call

format (VCF).

' You can view the extracted files individually, or upload a VCF file to a software application that accepts VCF files, such as lon Torrent™

Oncomine™ Reporter software.

[ Files are available only for assays from Genexus™ Software version 6.2 and earlier.

Bl Files are available only for custom and system installed assays in Genexus™ Software version 6.6 and later.
¥ Separate folders are generated for each sample. If included in the run, separate folders are also generated for an NTC and positive control.

View the run summary

The run summary provides an overview of the run. The information that is displayed includes a list of
the assays used in the run, sample locations, information about the reagents used in the run, primer

tube positions, and instrument information.

1. In the menu bar, click Results » Run Results.

2. In the Run Name column, click the run name of interest.

The Run Summary tab opens.

3. Review the run summary.

Action Procedure

View the assay metrics. In the Assays section, click the assay name of interest.

of a 96-well sample plate.

View the sample locations in an image | In the Sample Locations section, click PCR Plate View.

Reanalyze a run with a new assay. In the upper right corner of the screen, click
.-+ (More Options) » Reanalyze.

For more information, see “Reanalyze a run” on page 164.

Run plugins on the sequencing data In the upper right corner of the screen, click
after a sequencing run is complete. +++ (More Options) » Run Plugin.

For more information, see the Genexus™ Software 6.8 User
Guide (Pub. No. MAN0026409) or the Genexus™ Software

help system.

Download customer support archive In the upper right corner of the screen, click

(CSA) log files for the run to help with «++ (More Options) » CSA.

troubleshooting. For more information, see the Genexus™ Software 6.8 User
Guide (Pub. No. MAN0026409) or the Genexus™ Software
help system.
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(continued)

Action Procedure

Upload results to another Genexus™ In the upper right corner of the screen, click
Integrated Sequencer or to lon +++ (More Options) » BAM Uploader.

Reporter™ Software for further analysis. | For more information, see the Genexus™ Software 6.8 User

Guide (Pub. No. MAN0026409) or the Genexus™ Software

help system.
View the history of variant In the upper right corner of the screen, click
classifications. +++ (More Options) » Variant Audit.

The information is available only for results that include
variant classifications.

View the run report. Click the Run Report tab.

The run summary

The run summary displays run information, assays used in the run, sample locations, information about
the reagents used in the run, primer tube positions, and instrument information.

Depending on the type of the run and the selections made in the run plan, the run information can
include the following items.

Table 25 Run information

ltem Description
Run Name The name of the run.
Started On The date and time when the run was started.

Completed On

The date and time when the run was completed.

Run Status The status of the run.

Report Template | If the option to generate a report was enabled in the run plan, the report template used is listed.

Chip Type The semiconductor sequencing chip used in the run, such as the lon Torrent™ GX5™ Chip.

Library Chemistry | The type of library chemistry used in the run, such as lon AmpliSeq™ HD.

Server The lon Reporter™ Software account or the Genexus™ Software account and the respective
software version that was selected for uploading BAM files when the run is complete.

Run Type The type of run. For example, Nucleic Acid to Result.

Table 26 Sequencing instrument information

Item

Description

Instrument Name

The name of the sequencer.

Instrument Serial Number | The serial number of the sequencer.

Status

The status of the sequencing portion of the run.
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Table 26 Sequencing instrument information (continued)

Item Description
Operator The name of the person who was signed in the Genexus™ Integrated Sequencer when
the sequencing run was performed.
Start Date The date and time when the run was started on the sequencer.

Completion Date

The date and time when the run was completed on the sequencer.

Sequencing Flows

The number of flows performed by the sequencer.

Table 27 Assays table

Item

Description

Assay Full Name

The name of the assay used in the run. Click the assay name to display the details of the
assay.

Assay Name

An abbreviated name of the assay or assays used in the run.

Analysis Version

The version of the assay used for analysis.

Research The research application for the assay, such as DNA or DNA and Fusions.
Application
Lane The chip lane or lanes used in the sequencing run for the assay.

Total Samples

The total number of samples sequenced for the assay. A single sample can correlate with
multiple wells on the plate for some assays when multiple nucleic acid types are contained
within the sample.

Updated
Annotations

The information that is shown depends on the settings and the type of the assay.

* The name and version of the annotation source that is applied to the sample result is
shown when an assay is configured to use the latest annotations but the annotation that
is applied to the results is not the latest annotation source.

* No information is shown in the column (the value is blank) when the latest annotation set
version is applied to the result, regardless of whether the assay is configured to use the
latest annotation source.

* No information is shown in the column (the value is blank) when an assay is configured
to not use the latest annotation source, and instead uses a fixed version of an annotation
source.

* N/A is shown when an assay does not use an annotation set.

Table 28 Sample Locations table

ltem Description
PCR Plate View | Click to view the sample locations in an image of a 96-well sample plate.
Well Pos. The well position indicates the location of the sample on the plate.
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Table 28 Sample Locations table (continued)

Item

Description

Library Batch ID

The unique identifier created for the library batch. This information is available only for Library to
Result runs.

Sample Name

The unique identifier created when the sample was entered into the software.

Nucleic Acid Type

The sample nucleic acid type, such as DNA, RNA, or TNA.

Vol. (ul)

The volume of the sample.

Conc. (ng/pl)

The concentration of the sample.

Dilution Factor

The dilution factor of the sample.

Kit Barcodes

The barcode for the kit used for nucleic acid extraction, if applicable.

Barcode

The name of the barcode adapter or adapters that are associated with the sample, for example,
lonHDdual_0101.

Assay Name

The assay that was used to sequence the sample for the indicated well position.

Library Position

The plate location of libraries. For completed runs that were planned using samples, the Library
Position indicates the location of unused libraries that can be sequenced by planning and
initiating a library run.

Table 29 Reagents table

Item

Description

Consumable

Consumables used in the run, such as the PanelKit and LibraryKit, are listed.

Barcode

The consumable barcode, if applicable.

Part #

The consumable part number, if applicable.

Expiration Date

The consumable expiration date, if applicable.

Lot #

The consumable lot number, if applicable.

The Primer Tube Positions table shows an image that indicates the locations of the primer pool tubes.
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Review run results

In the Results / Run Results screen, runs that are pending, in progress, or complete are listed. Runs
with a status of failed, aborted, or stalled are also listed.

See the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the Genexus™ Software help
system for information about how to find run results of interest.

The following run information appears in the Results / Run Results screen.

Column Description

Run Name The unique name of the run given when it was created in the software. Click a run name to
open the Run Summary. For more information, see “The run summary” on page 124.
Runs that are reanalyzed are listed with & (Reanalysis) after the run name. For more
information, see “Reanalyze a run” on page 164.

Assay Name The name of the assay selected for the run. You can view the Assay Name and corresponding
Assay Full Name for all assays in the Assays » Manage Assays screen.

Run Status The status of the run. For example, Analysis In Progress, Executing Plugins, Analysis

Completed, Terminated, Archival: In Progress).

Total Samples

The total number of samples in a run.

PCR Plate A unique identifier for the 96-well plate used for library preparation and templating. For more
Number information, see “Assign PCR Plate” on page 128.

Started On The date and time when the run was started.

Updated On The date and time when the last action was completed on the run.

You can also perform the following actions in the Results / Run Results screen.
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Option Description

Actions | Available action links for a run are shown when you place the pointer over the row of a run. The actions
that are available depend on the type of run.

¢ Delete—Delete the run.
¢ BAM Uploader—Upload run information to another Genexus™ Integrated Sequencer or to lon
Reporter™ Software for further analysis.

BAM Uploader is not available for BAM run results or for archived runs in which BAM files have been
removed.

For more information, see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the
Genexus™ Software help system.

* Audit—View the audit trail for the run.

For more information, see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the
Genexus™ Software help system.

* CSA—Download customer support archive (CSA) log files for the run to help with troubleshooting.
For more information, see “Download a Customer Support Archive” on page 172.

¢ Assign PCR Plate—Enter a unique identifier for the 96-well plate used for library preparation and
templating. For more information, see “Assign PCR Plate” on page 128.

Actions | Available action links for a run are shown when you select the checkbox to the left of the Run Name.
¢ Clear—Deselect the selected run or runs.

¢ Retain Data—Click to keep run data regardless of disk cleanup settings. To undo, select Release
Data.

* Archive Data—Click to archive run data. Select run data options (Sequencing Output, Intermediate
Files) in the Archive Confirmation dialog box. Analysis Results are selected by default and are not
optional.

* Delete—Delete the run data of the selected run or runs.

Assign PCR Plate

Genexus™ Software lets you track and associate a run with the PCR plate used in the run. The

PCR plate is the 96-well plate that is used for library preparation and templating. You can assign a
unique identifier, a PCR Plate Number, to runs that have a status of Library Preparation Completed,
Sequencing Completed, or Run Completed. The PCR plate number that you enter is shown in the
Run Results screen and if needed, can help you track libraries and troubleshoot. Later, if you sequence
the remaining libraries in a different sequencing run and assign the PCR plate number to the run, you
can easily search for and find all run results associated with the libraries in the PCR plate.

Note: You should assign a PCR plate to a run if there are leftover libraries that you want to use at a
later time to perform a Library to Result run. You can look up the PCR plate number on completed runs
to get the library and barcode mapping, then enter the same Barcode information into the Library to
Result run.
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For more information to find a run with a search of the PCR Plate Number, see the Genexus™ Software
6.8 User Guide (Pub. No. MAN0026409) or the Genexus™ Software help system.

1. In the menu bar, click Results » Run Results.

2. In the Run Results screen, place the pointer over the row of a run of interest, then click Assign
PCR Plate number.

3. In the Assign PCR Plate Number dialog box, confirm, edit, or enter the PCR Plate Number.

The PCR plate number must be between 1 and 10 characters. Only alphanumeric characters
(numbers 0 to 9 and letters A to Z), period (.), underscore (_), or hyphen (-) are allowed. Spaces are
not allowed.

4. Click Submit to associate the PCR plate with the run.

View assay metrics and the run report

The run report provides detailed information about a run, such as the Total Bases and Final Reads. For
runs with multiple assays, metrics are provided for each assay in the run. The run report contains the
assay metrics for all assays in the run.

For runs with only one assay, the run report and assay metrics show the same information for assay
metrics. In addition to the metrics for the assay, the run report shows information about the run and the
instruments used in the run.

1. Click Results » Run Results to view sequencing results for a particular sample.

2. In the Run Name column, click the run name of interest.

Action Procedure

View the run report Click the Run Report tab.

View the assay metrics for a single | In the Select Assay dropdown list at the top of the screen,
assay select the assay of interest.

For more information, see “View assay metrics and the run report” on page 129.

Assay metrics and the run report

The run report provides detailed information, such as chip metrics for the run, well, and lon Sphere™
Particles (ISPs) statistics. For runs with multiple assays, metrics are provided for each assay in the run.
Sequencing metrics are shown at the top of the screen, followed by sample-specific metrics in the Run
Samples table. Read data for individual samples for the assay are listed in the Run Samples table.

Barcode-specific metrics for barcodes that are included in the run are listed in the Barcodes With
Reads Reported table, which follows the Run Samples table. The CSA file for the run contains
information for barcodes that are not assigned to samples in the run. Information in the CSA file can
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help you troubleshoot results, if needed. For more information, see “Download a Customer Support
Archive” on page 172.

Table 30 Run Report

Metric Description
Loading The number and percentage of total addressable wells on the chip that contain an ISP.
Enrichment The number and percentage of wells ISPs that contain live ISPs.

Library

The number and percentage of wells with live ISPs that contain Library ISPs.

Combined Final
Reads

For runs that include resequencing, the combined final reads is the sum of library reads from
both sequencing and resequencing.

Final Reads Library reads passing all filters that are recorded in the output BAM files. This value can be
different from the total number of reads due to technicalities associated with read trimming
beyond a minimal requirement.

Total Bases The number of filtered and trimmed base pairs that are reported in the output BAM file.

Combined Total
Bases

For runs that include resequencing, the combined total bases is the sum from sequencing
and resequencing.

Raw Read Accuracy

The raw read accuracy across each individual base position in a read calculated as, (1-
[total errors in the sequenced reads]/[total bases sequenced]) x 100. Raw read accuracy

is measured at each base across the length of the read and is based on 1x sequencing
coverage; raw read accuracy is not based on consensus accuracy across multiple reads for
the same base position.

Wells with ISPs

The number of wells that contain an ISP.

Unenriched

The number and percentage of wells with ISPs that do not contain live ISPs.

Total Addressable
Wells

Wells on the chip that can be physically reached by a library.

Empty Wells

The percentage of total addressable wells on the chip that do not contain an ISP.

Wells with Live ISPs

Loaded wells with ISPs with a signal of sufficient strength and composition to be associated
with the library or control fragment key.

Wells with Library
ISPs

Loaded wells with live ISPs with a key signal that is identical to the library key signal.

Control ISPs Loaded wells with live ISPs with a key signal that is identical to the control fragment key
signal.

Filtered out The total percentage of filtered reads, or the sum of the percentages of polyclonal, low
quality, and adapter dimer reads.
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Table 30 Run Report (continued)

Metric Description
Polyclonal Wells with a live ISP that carries clones from two or more templates.
To view polyclonal metrics, mouse over the first low quality portion (gray) of the Final Reads
bar plot.
Final Reads 58.39% (@) Filtered out 41.61%
30,735,120
Final Reads(30,735,120) / Wells with Library 5P:[52,l§-35,12i}% Palyclonal: 13935706 (30.27%)
Low Quality Loaded wells with a low or unrecognizable signal.
To view polyclonal metrics, mouse over the second low quality portion (gray) of the Final
Reads bar plot.
Final Reads 58.39% (3 Filtered out 41.61%
30,735,120
Final Reads(30,735,120) / Wells with Library I5Ps(52,635,124) L\“ Low Quality: 3208258 (6.1%5)
Adapter Dimer Loaded wells with a library template of an insert size less than 8 bases.

To view adapter dimer metrics, mouse over the lightest gray portion of the Final Reads bar
plot.

Final Reads 43.57% @ Filtered out 56.44%
52,494,934 N

Final Reads(52,494,934) / Wells with Library ISPs(120,492,758)

Adapter Dimer: 10862794 (9.02%)

Note: In assays using lon AmpliSeq™ HD library chemistry, adapter dimer reads represent a
small proportion of total reads and can be seen by hovering the pointer over the right end of
the Final Reads bar.

Loading Density

A visual representation of chip loading. Red color indicates areas of higher density of
loading. Blue color indicates areas of lower density of loading. The following example shows
a sequencing experiment where two lanes on the chip are uniformly loaded with ISPs.
Loading Density

5 o,
N
\
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Table 31 Run Samples

The Run Samples table lists read data for each individual sample in the assay.

Column

Description

Sample Name

The unique identifier created when the sample was entered in the software.

Nucleic Acid Type The sample nucleic acid type, such as DNA, RNA, or TNA.

Barcode The unique identifiers of the dual barcode pair assigned to the DNA and/or RNA library for
a sample.

Total Reads The total number of filtered and trimmed reads with the listed dual barcodes assigned to

the sample.

Mean Read Length

The average length, in base pairs, of usable library reads for each sample.

=Q20 Bases

The total number of called bases that have =99% accuracy (or less than 1% error rate)
aligned to the reference for the sample.

Mapped Reads

The number of reads that are mapped to the reference file.

On Target Reads

The percentage of sequencing reads mapped to any target region of the reference.

Mean Depth

The average number of reads of all targeted reference bases.

Uniformity

The percentage of bases in all targeted regions (or whole genome) with a depth of
coverage =20% of the mean read coverage.

Read Length
Histogram

A histogram that presents all filtered and trimmed library reads that are reported in the
output BAM file (Y-axis) and the mean read length in base pairs (X-axis).

0 50 0o 150 200 250 300

Click the Read Length Histogram to open an expanded view.

Table 32 Barcodes with Reads Reported

The Barcodes with Reads Reported table lists barcode-specific metrics

Column Description
Barcode The unique identifiers of the dual barcode pair assigned to the DNA and/or RNA library for a
sample.
Total Reads The total number of filtered and trimmed reads with the listed dual barcodes assigned to the

sample. The reads are independent of length reported in the output BAM file.

Mean Read Length

The average length, in base pairs, of usable library reads for each sample.

=Q20 Bases The total number of called bases that have =99% accuracy (or less than 1% error rate)
aligned to the reference for the sample.
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Table 32 Barcodes with Reads Reported (continued)

Column Description
Read Length A histogram that presents all filtered and trimmed library reads that are reported in the output
Histogram BAM file (Y-axis) and the mean read length in base pairs (X-axis).

0 50 oo 150 200 250 300

Click the Read Length Histogram to open an expanded view.

View resequencing metrics

For assays that include resequencing, you can view resequencing metrics when a run is complete.

1.

2.

In the menu bar, click Results » Run Results.
In the Run Results screen, in the Run Name column, click the run name of interest.

In Select Assay, select the assay name of interest.
The assay metrics for the sequencing run are shown.

Click Resequencing Metrics.
The resequencing assay metrics are shown. For more information, see “View assay metrics and the
run report” on page 129.

Download a run report

You can download a run report summary in PDF format. The run report includes assay metrics and the
record of reagents that were used in a run. For information about the contents of the run report, see
“View assay metrics and the run report” on page 129. If you entered extraction kit barcodes for samples
when you prepared library batches or when you planned the run, the extraction kit barcodes are listed in
the run report.

—
.

In the menu bar, click Results » Sample Results.
In the Sample Results screen, in the Sample Name column, click the sample name of interest.

Click the Reports tab.
Multiple panes including a Run Report pane, a Variant Report pane, and any panes for
customized reports that have been generated are shown.

In the Run Report pane, click Download Report to download a run report summary in PDF
format.
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View sequencing results

1.

Click Results » Sample Results to view sequencing results, including variant and fusion calls, for
a particular sample.

In the Sample Name column, click a sample name.

In the Results screen, click the tabs to view the different types of sample-specific results and data.

Tab

Description

QC

The quality metrics for the sample sequenced in the run. For more information, see “QC results” on
page 135.

Key
Findings

An overview of the results for the sample, including Sample Details, Key Metrics, Genes,
and Coverage graphs. For more information, see the Genexus™ Software 6.8 User Guide
(Pub. No. MAN0026409) or the Genexus™ Software help system.

Variants

Detailed variant results for SNVs Indels, Fusions, and CNV. For more information, see “View SNV/
INDEL results” on page 144 and “View fusion results” on page 148.

Plugins

Results generated from the plugins associated with the assay used to analyze the sequenced
sample. For more information, see “Plugins for data analysis” on page 166.

Reports

You can download and generate summaries of run results. There are two types of reports:
* Run reports — include assay metrics and the record of reagents that were used in a run.

¢ Variant reports — include the variant results for each sample in a sequencing run, reagents used,
and QC evaluation metrics.

For more information, see “Download a run report” on page 133.

View the QC results

You can view the quality control (QC) metrics for each sample that was sequenced in a run in Genexus™
Software.

1.

2.

134

In the menu bar, click Results » Sample Results.
In the Sample Name column, click the sample name of interest.

Click the QC tab.
The QC metrics are shown.

Review the QC metrics.
For more information, see “QC results” on page 135.

lon AmpliSeq™ & lon AmpliSeqg™ HD Custom Assay User Guide



https://www.thermofisher.com/search/results?query=MAN0026409

QC results

Chapter 9 Review data and results 248
View sequencing results

The quality control (QC) metrics for each sample that was sequenced in a run are displayed in

Genexus™ Software.

If a sample fails a single test metric, the sample fails that QC test. A sample must meet all QC
parameter thresholds of a particular QC test in order to pass. The QC status is divided into the following

categories.

. (Passed) indicates the sample passed all QC metrics.

¢ X (Failed) indicates the sample failed a QC metric.

®* — (Not Calculated) indicates a sample did not undergo QC analysis.

Note: If a sample fails to meet one or more QC parameters, you can reanalyze a run after adjusting the
parameter or parameters. For more information, see “Reanalyze a run” on page 164.

The data shown in the screen depend on the assay that was used in the run. Not all metrics are shown

for every assay.

Metricl!l Description
Run QC General run quality control information.

Final Reads Library reads passing all filters that are recorded in the output BAM files. This value
can be different from the total number of reads due to technicalities associated with
read trimming beyond a minimal requirement.

Key Signal The average signal after software processing for library ISPs that identically match

the library key (TCAG).

Key Signal — Resequencing

The average signal after software processing for library ISPs that identically match
the library key (TCAG) for the resequencing run. This metric is only shown for assays
that include resequencing.

Percent Loading

The number of wells with ISPs divided by the number of the total addressable wells
in a run.

Percent Loading -
Resequencing

The number of wells with ISPs divided by the number of the total addressable
wells in the resequencing run. This metric is shown only for assays that include
resequencing.

Raw Read Accuracy

The average raw accuracy across each individual base position in a read, where raw
read accuracy is calculated as 100 * (1 - (sum(per base error)/sum(per base depth))).

Templating QC—CF-1
Control

Sequencing quality metrics of the control fragment. These metrics indicate
templating success.

Average Reads Per Lane

The number of CF-1 reads divided by the number of chip lanes used in the run.

Base Call Accuracy

The probability that a given base is called correctly.

1 - (total number of errors for all positions in CF-1) / (total number of CF-1 base
reads).
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Metricll

Description

Mean AQ20 Read Length
(bp)

Average length, in base pairs, at which the accuracy rate is 299% for CF-1 reads.

Key Signal

The average signal after software processing for CF-1 ISPs that identically match the
CF-1 key.

Sample QC—DNA

Sequencing quality metrics of the sample DNA library.

Deamination score

Deamination is reported as the estimated SNP proportion consistent with
deamination (low allele frequency C:G>T:A SNVs). The deamination score can be
used to determine the quality of the FFPE sample.

MAPD

MAPD (Median of the Absolute values of all Pairwise Differences) is a quality metric
that estimates coverage variability between adjacent amplicons in CNV analyses. A
MAPD value of 0.4 indicates an acceptable level of coverage variability. High MAPD
value typically translates to a lower coverage uniformity. Lower coverage uniformity
can result in missed or erroneous CNV calls. If the MAPD QC threshold is not met,
CNVs are not called. The MAPD metric does not affect SNVs/INDEL calls.

Mapped Reads

The total valid mapped reads.

Mean AQ20 Read Length
(bp)

The average length, in base pairs, at which the accuracy rate is =299% for all aligned
reads of a library.

Mean Read Cov

The number of average reads per amplicon.

Molecular Uniformity

Uniformity of molecular coverage for all amplicons.

Mean Read Length (bp)

The average length, in base pairs, of final library reads for the sample.

Mean Read Cov

The average number of reads per amplicon calculated over all amplicons in the
assay.

Number of bases used in
calculating TMB

Number of variant calls

Uniformity of Amplicon
Coverage

The percentage of amplicons that had at least 20 percent of the average number
of reads per amplicon. Cumulative coverage is linearly interpolated between nearest
integer read depth counts.

Median Mol Cov

The median number of functional molecule reads per amplicon calculated over all
amplicons in the assay.

This metric is applicable to lon AmpliSeq™ HD library chemistry only.

Uniformity of Base
Coverage

The percentage of reads with a depth of coverage =20% of the mean read coverage
at each position.

This metric is applicable to lon AmpliSeq™ HD library chemistry only.
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Metricll

Description

Read Length Histogram

The histogram presents all filtered and trimmed DNA library reads that are reported
in the output BAM file (Y-axis) and the mean read length in base pairs (X-axis). The
shape of the histogram should closely resemble the library size distribution trace
without the adapter sequences.

Read Ratio for Inline
Controls (Endogenous to
Spike-ins)

The ratio of genomic sample reads to control reads for each inline control amplicon.

_ Read Ratio for Inline Controls (Endogenous to Spike-insh

34
od
70 100 125 18 266 374
inding ]

Control Amplicon Size (bp

Read Ratio

Note: The Read Ratio for each inline control amplicon is expected to be
approximately 3 with 10 ng DNA input for both lon AmpliSeq™ and lon AmpliSeq™
HD chemistries.

Sample QC - RNA

Sequencing quality metrics of the sample RNA library.

Mapped Fusion Reads

The total valid mapped reads. That is, the mapped reads that pass the thresholds
and filters across all of the RNA targets in the reference file. This number is a subset
of the mapped reads shown in the Run Samples table in the Assay Metrics.

Mean Read Length (bp)

The average length, in base pairs, of the final library reads for the sample.

RNA Expression Ctrls
Detected

The number of expression control genes detected for the sample. This metric
measures the RNA input integrity, input amount, and the fidelity of the reverse
transcriptase that was used in library preparation.

Fusion panels include primer pairs that cover control housekeeping genes.

Mean AQ20 Read Length

The average length, in base pairs, at which the accuracy rate is 299% for all aligned
reads of a library.

Read Length Histogram

The histogram presents all filtered and trimmed library reads that are reported in the
output BAM file (Y-axis) and the mean read length in base pairs (X-axis).

Read Ratio for Inline
Controls (Endogenous to
Spike-ins)

The ratio of genomic sample reads to control reads for each inline control amplicon.
You can use this metric to measure the level of contaminating genomic DNA in RNA
libraries when you select the RNA checkbox for Include Inline Controls in assay set
up. Using inline controls in RNA assays will reduce the total number of panel reads.

Note: The Read Ratio for each inline control amplicon is expected to be
approximately 3 with 10 ng DNA input for both lon AmpliSeq™ and lon AmpliSeq™
HD chemistries.
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Metricll

Description

NTC QC - DNAPI

DNA Sequencing quality metrics of the no-template control.

Average Base Coverage
Depth

The average number of DNA reads of all targeted reference bases.

Mean Read Length (bp)

The average length, in base pairs, of final DNA library reads for the no-template
control.

Read Length Histogram

The histogram presents all filtered and trimmed reads for the no-template control that
are reported in the output BAM file (Y-axis) and the mean read length in base pairs
(X-axis).

Read Ratio for Inline
Controls (Endogenous to
Spike-ins)

The ratio of no-template control sample reads to control reads for each DNA inline
control amplicon.

NTC QC - RNAR

RNA Sequencing quality metrics of the no-template control.

Mapped Fusion Reads

The total number of valid mapped reads for the NTC.

Mean Read Length (bp)

The average length, in base pairs, of final RNA library reads for the no-template
control.

Read Length Histogram

The histogram presents all filtered and trimmed reads for the no-template control that
are reported in the output BAM file (Y-axis) and the mean read length in base pairs
(X-axis).

Read Ratio for Inline
Controls (Endogenous to
Spike-ins)

The ratio of no-template control sample reads to control reads for each RNA inline
control amplicon.

' For BAM to Result runs, only the Sample QC—DNA or Sample QC—RNA metrics are shown.
[l Metrics are shown only if NTC is included in the run plan.

MAPD copy number QC metric

The Median of the Absolute values of all Pairwise Differences (MAPD) score is reported on Aneuploidy
run results and other runs that detect CNVs.

MAPD is one of the metrics that we define to assess whether the panel data are useful for copy number
variation (CNV) run results.

MAPD is defined as the Median of the Absolute values of all Pairwise Differences between log2 ratios

138

per tile for a given run. Tiles roughly correspond to amplicons in an lon AmpliSeq™ assay. Each pair is
defined as adjacent in terms of genomic distance. Tiles corresponding to copy number amplicons and
other amplicons are being treated equally as no differences in variability are seen between these types.
Then, any two log2 ratios that are adjacent on the genome are a pair. Except at the beginning and the
end of a chromosome, every log2 ratio belongs to two pairs.

Formally, if x1 is the log2 ratio at position i, with i ordered by genomic position:

MAPD = median ( | x(i - 1) - x(i) | )
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MAPD is a per-sequencing run estimate of copy number variability, similar to standard deviation
(SD). If one assumes the log?2 ratios are distributed normally with mean 0 and a constant SD, then
MAPD/0.95 is approximately equal to SD. However, unlike SD, using MAPD is robust against high
biological variability in log2 ratios induced by known conditions such as cancer.

Regardless of the source of the variability, increased variability decreases the quality of CNV calls.

View key findings

You can view Sample Details, a summary of the metrics for the run, and the Key Variants matrix for
genes assayed in the run in Genexus™ Software.

1. In the menu bar, click Results » Sample Results.
2. In the Sample Name column, click the sample name of interest.

Review the key findings. For more information, see the Genexus™ Software 6.8 User Guide
(Pub. No. MAN0026409) or the Genexus™ Software help system.

Key findings

The Key Findings tab shows details about the sample, a summary of key metrics for the run, and key

variants for genes assayed in the run.

Note: The Key Findings tab is by default the first view that is first shown for sample results.

The information that is displayed depends on the assay that was used in the run.

Table 33 Sample details

Section

Description

Sample Name

A unique identifier representing the sample.

Collection Date

The date that the sample was collected.

Gender

The biological sex of the sample: Female, Male, or Unknown.

Sample Type

A term that describes the sample, for example, FFPE, DNA, DNA & RNA.

Application Category

The application type of the sample.

Cancer Type

The type of cancer that is represented by the sample.

Cancer Stage

The stage of the cancer from which the sample was collected.

%Cellularity

The percentage of tumor cellularity in the sample. This is a whole number between
1 and 100. The % Cellularity attribute is entered when a sample is created.

This attribute applies only to FFPE samples.
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Table 34 Key metrics

Section

Description

Target Coveragel'l

Target base coverage
at Nx

The percentage of reference genome bases covered by at least N reads.

Amplicon Summary

Average Base
Coverage Depth

The average number of reads of all targeted reference bases. This is the total number of
base reads on target divided by the number of targeted bases, and therefore includes any
bases that had no coverage.

Uniformity Of Base
Coverage

The percentage of bases in all targeted regions (or whole genome) with a depth of
coverage =20% of the mean read coverage. Cumulative coverage is linearly interpolated
between the nearest integer base read depths.

Percent Reads On
Target

The percentage of filtered reads that are mapped to any targeted region relative to all
reads mapped to the reference. A read is considered on target if at least one aligned
base overlaps at least one target region. If no target regions (file) was specified, this value
will be the percentage of reads passing uniquely mapped and/or non-duplicate filters, or
100% if no filters were specified.

[ Metrics are shown only for analyses that run the coverageAnalysis plugin.

The Key Variants matrix

The Key Variants matrix provides a color-coded visual representation of the variant results. When the
application category of the sample is Cancer or Cancer (Germline) the genes that are shown in the
Key Variants matrix are determined by the filter chain and the gene list applied to the results. You can
change the filters that are applied to expand or restrict the genes that are shown. For more information,
see “View the Key Variants matrix” on page 140.

Each tile in the Key Variants matrix represents one gene and indicates whether a variant is detected
or not. Note that a single gene is represented with multiple tiles when there are multiple mutations
detected in that gene.

View the Key Variants matrix

The Key Variants matrix provides a color-coded visual representation of the variant results. When the
application category of the sample is Cancer or Cancer (Germline) the genes that are shown in the
Key Variants matrix are determined by the filter chain and the gene list applied to the results. You can
change the filters that are applied to expand or restrict the genes that are shown.

Each tile in the Key Variants matrix represents one gene and indicates whether a variant is detected
or not. Note that a single gene is represented with multiple tiles when there are multiple mutations
detected in that gene.

140
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You can view a color-coded visual summary of variant results in Genexus™ Software.

1. In the menu bar, click Results » Sample Results.

2. Click a sample name.
The Results screen opens to the Key Findings tab, which shows the Sample Details, Key
Metrics, the Key Variants, and the Coverage Graphs.

3. Refine the genes that are shown in the Key Variants matrix.

Action Procedure

Hide genes that were | Select or deselect the Not Assayed checkbox.
not included in an
assay but are in a
gene list.

Refine the genes that | 5 jick Edit Filters.
are shown in the Key

Variants matrix. b. To refine or expand the genes, change one or both of the filters.

* Select a different filter chain or no filter chain.
For more information, see the Genexus™ Software 6.8 User Guide
(Pub. No. MAN0026409) or the Genexus™ Software help system.
* Select a different gene list or no gene list.
For more information, see the Genexus™ Software 6.8 User Guide
(Pub. No. MAN0026409) or the Genexus™ Software help system.

c. Click Save.
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SRTestSample®l  c KeyFindings  Variants Plugins  Reports
Sample Details
SRTestSampledl 29APR 2018 Male FFPE Cancer Mon-Small Cell Lung Cancer Primary
Key Metrics

Amplicon Summary

1705 G4 14% 4T .05%%

Key Variants (‘P (? (:P
l KepVortants Detecred | | Othes arigres Demsers | Mone Desected Bt Rasayed l Not Assayed (4] OncomineVariants (5.14) filter chain and Non-Small Cell Lung Cancer gene list applied Edit Filters

SNV/Indel ALK ERAF EGFR

MET MTRK2 NTRK3 ERBE2
NTRK1 RET ROS1

Example Key Variants matrix

@ Color coded legend to the variant tile matrix.
Key Variants Detected —A gene is present in the gene list, variants are called by the Oncomine™ Variant Annotator,
and the variants are Key Variants. Genes that are called are listed in the Variants tab with Present in the Call
column. Key Variants are listed in the Variants tab, with a value of Yes in the Key Variant column. For more
information about gene lists, see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the Genexus™
Software help system.
Other Variants Detected —A gene is present in the gene list and variants are called by the Oncomine™ Variant
Annotator, but the variants are not Key Variants. Genes that are called are listed in the Variants tab with Present
in the Call column. Variants that are not Key Variants are listed in the Variants tab, with a value of No in the Key
Variant column.
None Detected —A gene is present in the gene list but no variants are called by the Oncomine™ Variant Annotator.
Not assayed —A gene is present in the gene list, but is not included in the panel used in the assay.

@ Checkbox to hide or show genes that are not assayed.

@ Edit filters —Allows you to select an available filter chain and gene list. Changes of the filter chain or gene list change
the genes that appear in the Key Variants matrix.

@ Variant Name —The name of the variant. The Variant Name is a hyperlink to the pileup for the variant in the
Variants tab.
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Gene tiles in the Key Variants matrix

Each blue tile in the Key Variants matrix represents a variant and summarizes information for the
variant.

SNV/lndeI|—®
(2)——cosm19940
@——N\ Change: p.K117N

Allele Frequency: 0.047
|

®

@ The gene name. @ The number of variant read counts divided by the total
() The Variant Name - link to the variant details in the number of read counts for the sample.
Variants tab. @ The variant type.

@ The amino acid change using Human Genome
Variation Society (HGVS) nomenclature.

View the amplicon coverage

You can view DNA exon amplicon coverage in Genexus™ Software to help you determine whether

the sequencing reads across a gene are uniform and sufficient. The default genes that are shown are
determined by the gene list that is designated as default for the cancer type of the sample. You can also
view amplicon coverage graphs for more genes. These amplicon coverage graphs provide a high-level
overview of coverage. More detailed coverage information is also available in the software.

1. In the menu bar, click Results » Sample Results.

2. Click a sample name to open the Key Findings tab in the Results screen.
3. Scroll to the amplicon Coverage Graphs.

4. Review the coverage graphs.

5. To show coverage graphs for more genes, scroll to the bottom of the screen. Click Show
Coverage for Gene, then select the gene of interest.

6. You can adjust the amplicon coverage graph with the pointer and the buttons in the upper right
corner of each graph. The coverage graphs change to show coverage for the selected gene.

Action Procedure
Zoom in on a region of interest. Click @ one or multiple times.
Zoom out for an expanded view. Click @ one or multiple times.
Revert to the default view. * (Click @ one or multiple times.
¢ Click Reset.
Move the image left or right in the screen. | After you zoom in, click-drag at any position in the image.
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Example amplicon coverage graph

Here is an example of an amplicon coverage graph for the KRAS gene.

KRAS Coverage

L
]
comsn

o
|
D

5 5

@ Base coverage is shown on the y-axis on a logarithmic scale.
@ The location of the known hotspots are denoted with gray bars.

@ The location and span of the amplicons are represented with orange bars. You can hover the mouse over an orange
bar to view the amplicon name.

@ The location and span of the transcript track is denoted with green bars. You can hover the mouse over the green bar
to view the exon number.

(® The line along the x-axis is broken to indicate that the graph is discontinuous to show exons.
@ The genome coordinate position is shown on the x-axis.

@ Called variants are indicated with a vertical line above the blue coverage plot. The variants noted in the graph depend
on the filter chain applied to the results in the Key Variants matrix. For more information, see “View the Key Variants
matrix” on page 140.

You can place the pointer over the hotspots that are represented with gray lines to view the hotspot name.
@ You can adjust the amplicon coverage graph. For more information, see “View the amplicon coverage” on page 143.

View SNV/INDEL results

The SNVs/Indels table lists the calls and other information for the SNV and INDEL variants that are
analyzed in each sample in a run.

1. In the menu bar, click Results » Sample Results.
2. Click a sample name to open the Results screen.
3. Click the Variants tab.

4. Click SNVs/Indels to view the SNVs/Indels table.
For more information about the data shown in the table, see “SNVs/Indels table” on page 145.
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5. Click Export in the upper right corner of the screen to export the results data in XLS or TSV format,

if needed.

The information that is included in the file is based on the gene list, the filters that are applied to
each column, and filter chain that is applied.

* The file in XLS format contains the information that is shown in the SNV/Indels variant table.

* The file in tab-separated value format (TSV) format contains the information that is shown
in the SNV/Indels variant table, and information for table columns that are available but not
currently shown in the SNV/Indels table. The file also includes information that is listed in the
Annotations table.

SNVs/Indels table
The data displayed in the SNVs/Indels table depends on the assay that was used in the run.

You can filter the results list in the table using filtering tools and filter chains. For more information,
see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the Genexus™ Software help

system.

Column

Description

User Classifications

User-defined classification to select from the list.

For more information, see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409)
or the Genexus™ Software help system.

Variant ID

The name of the hotspot as defined in the Browser Extensible Data (BED) file.

Click the link to view more annotation information. For more information, see “View more
annotations and annotation sources” on page 151.

Variant Name

The name of the variant.

Key Variant Indicates whether the variant is a key variant.
Possible values are Yes or No.
This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Locus The chromosome and position of the detected variant.

Oncomine Variant
Class

The type of SNV or INDEL at the locus based on Oncomine™ annotations.

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Oncomine Gene Class

The change in molecular function of the altered gene product due to the mutation, based
on Oncomine™ annotations:

* Gain-of-function—The altered gene product has a new molecular function or pattern
of gene expression compared to the wild-type gene

* Loss-of-function—The altered gene product lacks the molecular function of the wild-
type gene

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.
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(continued)
Column Description
Gene The gene name.
AA Change Identification of the amino acid change using Human Genome Variation Society (HGVS)
nomenclature.
Ref The reference base or bases at that locus.
Alt The alternate base or bases at that locus.
Type The type of variant that is detected.
* snp (single nucleotide polymorphism)
*  mnp (multi-nucleotide polymorphism)
* ins (insertion)
* del (deletion)
e complex
* FLT3-ITD
Call Indicates the presence or absence of an SNV/Indel variant. When the default filter chain
is applied, only the variant calls that are designated with PRESENT (HOMOZYGOUS) or
PRESENT (HETEROZYGOUS) are displayed in the results table. To view all calls, including
calls that do not pass the required filter thresholds, apply the No Filter option or download
the Variants (VCF) file (see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409)
or the Genexus™ Software help system).
* PRESENT (HOMOZYGOUS) or PRESENT (HETEROZYGOUS)—Indicates a high
confidence call that passes all filter thresholds at a given variant position.
—  When the default filter chain is applied, PRESENT (HOMOZYGOUS) or PRESENT
(HETEROZYGOUS) indicates the presence of the ALT (alternative) allele.
— When the No Filter option is applied or when viewing the Variants (VCF) file,
Present does not imply the presence of the ALT (alternative) allele. To infer the
presence of the ALT allele, see the Alt column.
* NO CALL—Although some evidence for the presence of a variant exists, the call does
not pass one or more filters that are required for a high confidence variant call.
* ABSENT —Indicates that the variant is unlikely to be present in the sample.
Call Details The reason why a variant is reported as NO CALL.

Phred QUAL Score

The relative probability of either the "reference" hypothesis interval [0,cutoff], or the
"variant" hypothesis interval [cutoff,1], Phred-scaled (-10*log10). A higher score means
more evidence for the variant call.

Raw Read Depth

Total read coverage across amplicon containing SNV/Indel hotspot locations. Count of
chip-level reads aligned at this locus that participate in variant calling.

Effective Read Depth

The number of reads covering the position.

Alt Allele Read Counts

The number of reads containing the alternate allele.

Coverage

The number of total reads at a locus, wild-type + alt allele.
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(continued)
Column Description
Nuc Change The position and identity of the nucleic acid change.

Allele Frequency

The number of variant read counts divided by the total number of read counts for the
sample.

Allele Frequency (%)

The allele frequency, represented as a percentage.

Allele Ratio The relative frequency of each allele.
Mut/WT The ratio of mutant allele to wild-type allele.
Zygosity Describes whether the variant is homozygous (0) or heterozygous (1).

Filtered Read
Coverage

Coverage at the position considering only filtered reads.

Allele read Count

The number of reads detected for the allele. The Allele Read Count filter sets the minimum
count of the genotype alleles.

Raw Alt Allele Read
Counts

The number of unfiltered reads containing the alternate allele.

PPA Possible Polyploidy Alleles (PPA).
A value of Yes indicates variants that are PPA alleles. A value of No indicates variants that
are not PPA alleles.

P-Value The probability value for the detection of variant calls.

Mol Depthl'] The reports number of interrogated DNA molecules containing target. This metric defines

the limit of detection at a hotspot position in a particular run and sample. For reference
calls, molecular depth provides a measurable metric that serves as confirmation of variant
absence among a large number of interrogated molecules. For instance, if molecular depth
is 21,500, you can have high confidence that no variant is present at =0.2% variant allele
frequency. If molecular depth is =2,500, you can have high confidence that no variant is
present at =0.1% variant allele frequency.

WT Mol Countsl']

The number of detected molecules containing the wildtype allele.

Alt Allele Mol
Countsl!l

The number of detected molecules containing the alternate allele.

Mol Freq %!

Molecular frequency percentage. The percentage of alternate allele reads over total reads
at the locus.

% LoD

the limit of detection (LOD) of a variant allele expressed as a percentage of the WT allele.
LOD is the lowest possible variant frequency in the sample that can be detected by the
system with a true positive rate greater than 98% for FFPE samples or 95% for cfTNA
samples. LOD is dependent on the molecular read depth at the locus. %LOD is reported
when there are no variant calls for the gene.

' Column appears only in analyses of lon AmpliSeq™ HD sequencing data.
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View fusion results

You can view calls and other information for the fusions that are analyzed within each sample in a run.

1. In the menu bar, click Results » Sample Results.
2. Click a sample name to open the Results screen.
3. Click the Variants tab.

4. Click Fusions to view the Fusions table.
For more information about the data displayed in the table, see “Fusions table” on page 148.

5. Click Export in the upper right corner of the screen to export the results data in XLS or TSV format,
if needed.

The information that is included in the file is based on the gene list, the filters that are applied to
each column, and filter chain that is applied.
* The file in XLS format contains the information that is shown in the Fusions variant table.

* The file in tab-separated value format (TSV) format contains the information that is shown in
the Fusions variant table, and information for table columns that are available but not currently
shown in the Fusions table. The file also includes information that is listed in the Annotations
table.

Fusions table

The data displayed in the Fusions table depends on the assay that was used in the run.

You can filter the results list in the table using filtering tools and filter chains. For more information,
see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the Genexus™ Software help
system.

Column Description

User Classifications | A user-defined classification selected from the list.

For more information, see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409)
or the Genexus™ Software help system.

Variant ID The name of the fusion target as defined in the BED file.

Click the link to view more annotation information. For more information, see “View more
annotations and annotation sources” on page 151.

Variant Name The name of the variant.

For more information, see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409)
or the Genexus™ Software help system.

Key Variant Indicates whether the variant is a key variant.
Possible values are Yes or No.

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.
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Column

Description

Locus

The chromosome positions in the reference genome that define the fusion junction.

Oncomine Variant
Class

Oncomine variant class annotation that indicates fusion type based on Oncomine™
annotations. This information is available if the Apply Oncomine Variant Annotations
checkbox is selected in the assay that is used in the run.

Oncomine Gene
Class

The change in molecular function of the altered gene product due to the mutation, based on
Oncomine™ annotations:

* Gain-of-function—the altered gene product has a new molecular function or pattern of
gene expression compared to the wild-type gene

* Loss-of-function—the altered gene product lacks the molecular function of the wild-
type gene

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Genes (Exon)

The name of fusion target and representative acceptor and donor exons.

Read Counts

The frequency that the fusion was detected in the sample.

Type

Assay type (for example, Fusion, RNA exon variant (exon skipping), RNAExon Tile, Proc
Control).

Call

Indicates the presence or absence of a fusion or RNA exon variant. When the default filter
chain is applied, only the fusion/RNA exon variant calls that are designated with PRESENT
are displayed in the results table. To view all calls, including calls that do not pass the
required filter thresholds, apply the No Filter option or download the Variants (VCF) file (see
the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the Genexus™ Software
help system).

* PRESENT—indicates a high confidence call that passes all filter thresholds at a given
variant position.

e ABSENT—indicates the absence of a fusion due to a variant call that falls below
thresholds.

* NO CALL—although some evidence for the presence of a fusion exists, the call does
not pass one or more filters that are required for a high confidence fusion call.

Call Details

The reason for reporting a fusion as NO CALL or ABSENT.

Read Counts Per
Million

The number of fusion read counts detected per million total reads.

Oncomine Driver
Gene

The gene believed to be associated with increased oncogenic properties. The gene is
inappropriately activated by the fusion.

Gene Isoform

The name of the fusion target as defined in the BED file.

Mol Cov. Mutantl']

The median molecular coverage across a fusion amplicon.
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(continued)

Column

Description

Imbalance Scorel?]

Each fusion gene exhibits a characteristic Imbalance Score threshold. Scores that exceed
the threshold value indicate a high likelihood of the presence of the fusion in the sample.
Imbalance score calculation starts with the normalization of reads in the exon-tiling
amplicons of the gene, followed by correction with a baseline that represents expression
values in normal samples. Reads for observed imbalance scores come from samples.
Baseline scores come from normal, fusion-negative samples and are stored in the exon
tile assay baseline file for the assay.

Imbalance score = Observed imbalance (in samples) / Expected imbalance (in the baseline)
where

Observed imbalance = 3' of breakpoint (in samples) / 5' of breakpoint (in samples)

¢ 3' of breakpoint is the sum of the normalized reads of amplicons 3' of a predicted
breakpoint for the gene in the sample.

* 5' of breakpoint is the total normalized reads of the amplicons for the gene in the
sample.
Expected imbalance = 3' of breakpoint (in the baseline) / 5' of breakpoint (in the baseline)

* 3' of breakpoint is the sum of normalized baseline values of amplicons 3' of the
breakpoint for the gene.

¢ 5'of breakpoint is the total normalized baseline values of the amplicons for the gene.

Imbalance P-Valuel?!

The statistical significance of measure of imbalance relative to a control gene.

Predicted Break-
point Rangel?

The exonic range for predicted fusion break point in exon tiling assays.

Ratio To Wild Typel

The molecular ratio for exon skipping assays relative to wild type control amplicons.

Norm Count Within
Genel2

Exon skipping assay coverage normalized to molecular coverage of wild type (WT) MET
control amplicons.

' Column appears only in analyses of lon AmpliSeq™ HD sequencing data.
] Column appears only in analyses that use the exon tiling fusion detection method.

View RNA Exon Variants

The RNA Exon Variant data view displays a bar graph summary of intragenic exon rearrangements or
fusions. The displayed RNA exon variants are defined in the BED file that is associated with an assay.
The RNA Exon Variant data view is available for all RNA and fusion assays.

1. In the menu bar, click Results » Sample Results.

2. In the Sample name column, click the name of the sample of interest.
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3. Click the Variants tab, then click Fusions.

The Fusions table opens to display fusions results. For more information, see “Fusions table” on
page 148.

4. In the top right corner of the screen, click Visualization » RNA Exon Variant, then review the RNA
Exon Variants plot.

Representative RNA Exon Variant plots
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The X-axis represents specific exon variants, where each variant is labeled with a gene ID followed by a sequence of adjacent
exons. The Y-axis measures the read counts for each variant, normalized to the wild type.

@ Example result where only the wild type EFGR (EFGR.EGE7) was detected.

@ Example result where RNA exon 2-7 deletion occurred in the EFGR gene. The deletion of exons 2-7 resulted in an increase of
normalized read counts for the EFGR variant that contains the intragenic fusion of exon 1 and exon 8 (EFGR.E1E8.Del1) and a
decrease of normalized read counts for the wild type EFGR (EFGR.EGE7?).

To return to the table view of fusions, click XX (Remove) next to the Visualization dropdown menu.
View more annotations and annotation sources

In addition to the annotations that are included with Genexus™ Software, you can view annotations and
annotation source information from public websites for each variant.

1. In the menu bar, click Results » Sample Results.
2. Click the sample name in the Sample Name column in the row of a sample of interest.
3. Click the Variants tab.

4. |n the Variants table, click the Variant ID of the variant of interest.
You can click the row even if a Variant ID is not listed.

The Pileup view is shown below the variants table. For more information, see “Review the variant
pileup view” on page 152.
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5. Click the Annotations tab.

6.

Review annotation information in the Annotations tab, and if available, click a link in the row of an
annotation to open a website with information about the annotation.

Review the variant pileup view

You can review variant tracks with the pileup view in Genexus™ Software. The pileup view is a figure
that the software generates to show each BAM track represented by a single bar, with the sequence
variation or variations denoted in each track. The BAM tracks are aligned against a reference track. The
variant pileup view can be used to identify potential variants.

1.

2.

3.

4.

In the menu bar, click Results » Sample Results.
Click a sample name to open the Results screen.
Click the Variants tab.

In the variants table, in the Variant ID column, click the identifier of the variant of interest.

The pileup view is shown below the variants table.

Change the view of the variant pileup

You can zoom and pan the variant pileup view and add or remove guides and track labels to more
easily understand the data. You can also adjust the view of the individual pileup tracks. For more
information, see “Adjust pileup tracks” on page 153.

1.

2.

152

In the menu bar, click Results » Sample Results.
Click a sample name to open the Results screen.
Click the Variants tab.

In the variants table, in the Variant ID column, click the identifier of the variant of interest.

Action Procedure

Track the position as you place the pointer over the variant | Click Cursor Guide.
pileup.

Mark the center of the variant pileup. Click Center Line.
Remove the track labels. Click Track Labels.
Zoom in to increase the magnification of the image. Click @ (Zoom in) one or more times, or

double-click the image.

Zoom out to decrease the magnification of the image. Click @ (Zoom out) one or more times.

Pan across the image to move the view to another location | Click and drag the pointer over the image.

on the screen with its current magnification.
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Adjust pileup tracks

You can adjust the BAM read coverage track, the reference track, hotspot tracks, the target region
track, and annotation tracks in Genexus™ Software to make it easier to view the data. When you adjust
a track, it changes the amount of data that is shown in the plot. For example, you can see more tracks
when you use the Squish setting.

Note: For best results, click the Expand option to view details about variants and base calls that are
shown in each read coverage track

1. In the menu bar, click Results » Sample Results.

2. Click a sample name to open the Results screen.

3. Click the Variants tab.

4. In the variants table, in the Variant ID column, click the identifier of the variant of interest.

5. In the Variants tab, in the Pileup subtab, click £# (Actions) next to a track, then select an option to
adjust the view of the track.

Option Description

Expand | Select this option to view the tracks with the maximum visible height.

Squish | Select this option to view the tracks with the minimal height for each track.

Collapse | Select this option to view the tracks with overlapping transcripts shown along a single
line. When Collapse is selected for BAM tracks, the BAM tracks are not shown; only the
coverage density is shown.

Adjust the view of the reference track

You can adjust the view of the reference track in Genexus™ Software to view or hide the three-frame
translation of the reference track sequence. You can also view the forward or reverse reference track
sequence.

1. In the menu bar, click Results » Sample Results.
2. Click a sample name to open the Results screen.
3. Click the Variants tab.

4. In the variants table, in the Variant ID column, click the identifier of the variant of interest.
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5. In the Variants tab, in the Pileup subtab, click £ (Actions) next to the reference track.

Option

Description

View the reverse strand

Click Reverse.
This option is available only when the forward strand is shown.

View the forward stand

Click Forward.
This option is available only when the reverse strand is shown.

View the reference sequence
translation

Click Three-Frame Translate.

This option is available only when the amino acid sequence is not
shown.

Hide the reference sequence
translation

Click Close Translation.
This option is available only when the amino acid sequence is shown.

Adjust the view of the BAM tracks

You can adjust the view of the BAM tracks in Genexus™ Software to dynamically customize the view of

the data.

1. In the menu bar, click Results » Sample Results.

2. Click a sample name to open the Results screen.

3. Click the Variants tab.

4. In the variants table, in the Variant ID column, click the identifier of the variant of interest.

154

lon AmpliSeq™ & lon AmpliSeqg™ HD Custom Assay User Guide



Chapter 9 Review data and results
View sequencing results

In the Variants tab, in the Pileup subtab, click £ (Actions) next to the BAM tracks.

Option

Description

View all BAM tracks in
monochrome gray

In Color By, deselect the checkmark next to Read Strand.

This option is available only when the BAM tracks are colored by read
strand.

Distinguish between the
direction of the BAM tracks
with color

In Color By, click Read Strand.

This option is available only when the BAM tracks are not colored by
read strand.

Expand, squish or collapse
the BAM tracks

For more information, see “Adjust pileup tracks” on page 153.

Show all the bases in the

Click Show all bases.

e

Y H

BAM tracks This option is available only when all bases in the BAM tracks are not

shown.

Change the minimum
threshold for the visibility of
BAM tracks

a. Click Set visibility window.

b. In the Set visibility window dialog box, enter the minimum
number of bases needed to show the BAM tracks.

When you zoom in and out to view the variant pileup, the scale of
the tracks shown in the screen changes. For more information, see
“Change the view of the variant pileup” on page 152. You can adjust
the visibility window according to the scale shown in the screen.

Examples of a variant pileup view

The following figure is an example of a variant pileup view, shown in the Gene Browser in the Variant
tab. The variant pileup view graphically represents the sequencing tracks, the reference track, and the
annotation tracks, and can help you understand the variant data and analyze results. The reference
allele and the alternate base for the selected variant are indicated in the image, both in the variant table
and the in the pileup view. You can customize your pileup view. Reorder the tracks displayed by clicking
a gray bar on the right edge of a track, then dragging the track to a different location. You can also
click-drag the cursor at any position in the image to move the image left or right in the screen. For more
information, see “Adjust pileup tracks” on page 153.
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@ The reference track. When zoomed out, the nucleotide sequence is no longer displayed, but the sequence is
represented by colored bars.

@ The three-frame translation is shown in this example (not by default). For more information, see “Adjust the view of
the reference track” on page 153.

@ The coverage track.

(@) The BAM track.

@ Click the coverage track to see detailed information, such as the total count, the number of reads, and the number of
molecules.

@ Click a BAM track to see detailed information, such as the Mapping Quality and Base Quality.

@ Use the sliders to view more tracks.

Deletion.

@ Insertion.

@ Alternate base in the BAM read coverage track.

The following figure is an example of the reference tracks and annotation tracks shown beneath the
BAM tracks in the Gene Browser.
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Chr 9

Pos 5073770

Names 29763

Ref G

Alt A

Qual .

Filter

ALLELEID 38718

CLNDISDB MedGen:C3281125,0MIM:614521
CLNDN Thrombocythemia_3

CLNHGVS NC_000009.11:9.5073770G>A
CLNREVSTAT no_assertion_criteria_provided
CLNSIG Pathogenic

CLNVC single_nucleotide_variant

CLNVCSO 50:0001483 M

@ The hotspot track.
@ The target region track.
@ Annotation tracks (COSMIC and ClinVar). In this example, only ClinVar is shown.

@ Click the annotation track for additional details; for example the CLNHGVS (the top-level genomic HGVS expression
for the variant).

(® Click a hotspot track for additional details, such as the start and end positions.
@ Click the target region track for additional details, such as the start and end positions.

Coverage histogram

When you zoom in on the variant pileup view, you see the coverage histogram and reads from the .bam
track. The histogram in gray shows read depth at that location and reads from the .bam track show read
direction and location of variants.

I O]

@ Read depth
(2) Read location and direction of variants

lon AmpliSeq™ & lon AmpliSeq™ HD Custom Assay User Guide 157



P2 Chapter 9 Review data and results

Q)
View sequencing results

View the variants from an lon AmpliSeq™ HD-Library Chemistry run

You can view a summary of data about the identified variants, and toggle to other views that provide
more details about the same variants.

1. In the menu bar, click Results » Sample Results.

2. Click a sample name to open the Results screen.

3. Click the Variants tab.

4. In the variants table, in the Variant ID column, click the identifier of the variant of interest.

5. Review detailed variant data and read coverage tracks.

Pileup

Gene Browser 40bp

180355005

Example visualization

lon AmpliSeg™ HD sequencing runs group consensus reads into families. A family is a group of reads that are
associated with the same DNA molecule before library amplification. Each family is identified using the molecular
tags, and consensus reads with the same molecular tags are grouped into the same family. The color of the
consensus reads is used to indicate a family.

Within each read track, each nucleotide variant is indicated by a different color. T, A, C, and G are red, green, blue,
and orange, respectively. An "I" indicates insertion, and white color with a dash indicates deletion.

6. You can sort, adjust, and view details about variants and base calls that are visualized in each read

coverage track.

Option

Description

View the read coverage
tracks sorted by family

Click £* (Actions) next to the read coverage track, then select
Color » Molecule.

Adjust the BAM tracks

Click £# (Actions) next to the read coverage track, then select an option
to adjust the view of the track. For more information, see “Adjust pileup
tracks” on page 158.

Review detailed data
about a BAM read

Single-click the read track to obtain information such as the mapping
quality, the strand, and the read base.

Review distribution of
base calls at a selected
position

Click the density plot (the gray bar at the top of the read coverage tracks)
to view information about the total count, total reads, and total number of
molecules, the distribution of single nucleotides at that position, and the
number of insertions and deletions.

158

lon AmpliSeq™ & lon AmpliSeqg™ HD Custom Assay User Guide



Chapter 9 Review data and results @
View sequencing results

Create and assign variant classifications

You can create and assign user-defined variant classifications in the SNVs Indels, Fusions, and CNV
tables in the Variants tab of the Results screen.

1. In the menu bar, click Results » Sample Results.

2. Click a sample name in the Sample Name column in the row of a sample of interest to open the
Results screen for the sample.

3. Click the Variants tab.

4. To refine the list of variants shown in the table, select a variant type to display: SNVs Indels,
Fusions, or CNV.

5. In the Variants table, in the User Classification column, perform any of the following actions.

* To assign an existing classification to a variant, select it from the list. The Classification menu
changes to the name of the classification, as shown in this example.

Results / OCAv3MultiCustom7198771Y / DFOCC# Results / OCAv3MultiCustom7198771 ¥ / DFOC Results / OCAv3MultiCustom7198771 ¥ / DFOCC
SRTestSample01 Summary oc — SRTestSample0l Summary QC — SRTestSample01 Summary QC —

SNVs/Indels Filter ~ Oncomine m Fitter  Oncomir M Filter = Oncomine

User Classification Y Locus Y | User Classification Y Locus i User Classification 'Y Locus T

P ’ ) chr13:32911442 | Likely Pathogenic =
Classification chr13:32911442 | chri3:32011442
x
811442
chr13:32911442 1

Classification ~ chrl3:32911442

Benign
@ Benig

Likely Benign

u

o

o

@ Likely Pathogenic 1
@ Pathogenic mw
o

@ Uncertain Significance
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* To create a new classification, enter a name for the classification in the text box, select a color
for the new classification, then click Add.

Results / OCAv3MultiCustom7198771Y | DFO Results /| OCAVEMultiCustomT1987T1 Y | DFOC: Results / OCAv3MultiCustom7198771LY / DF(
SRTestSample0l OC = SRTestSample0l - SRTestSample0l  summary qQc -
m Fur Filter Oncomir SNVs/Indels Filter Oncon
SNVs/indels s Filter Oncom . .
User Classification T Locus T User Classification T Locus h
User Classification Y Locus Y
chrl3:32911442 chr13:32911442
Classification = chri3:32911442
a911442 ‘ Protective 911442
911442
— ==Im
Other._.

* To remove a classification from a variant, click )X (Remove).

¢ To delete a classification from the list, click [l Delete next to the classification name. The
classification will be removed from all variants in all results.

Filter results

You can filter results in the SNVs/Indels, Fusions, and CNV tables in the Variants tab of the Results
screen in two ways. You can apply filters to columns of information that appear in the screen. The
filters, available at the top of each column, immediately narrow the list of information in any columns to
which filters are applied.

You can also apply a filter chain, a set of filters that Genexus™ Software uses to narrow the list of
variants that are included in results. A manager-or administrator-level user creates filter chains from
system-installed filters.

Search and filter the list of variants

You can search and filter to immediately narrow the list of results that are shown in the variant tables.
You can apply filters to columns of information that appear in the screen. The filters, available at the top
of each column, immediately narrow the list of information in any columns to which filters are applied.

1. In the menu bar, click Results » Sample Results.
2. Click a sample name in the Sample Name column.
3. In the Results screen, click the Variants tab.

4. Select the variant class to display the results: SNVs/Indels, Fusions, or CNVs.
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| A

View sequencing results
5. In the table of variants, in the column heading of @ v
interest, click Y (Filter). Type call

* |n the search field, enter at least 3 characters, then

click Filter. snp
® Select the checkbox in the row of each filter that ¢ o

you want to apply, then click Filter. snp .

del

The options that are available depend on the column
and variant class. For example, you can filter data in snp
the Type column to show one specific variant type.

del
6. Click {x] Clear Filters to remove all filters and view )

the full list of run results.

The column or columns to which you applied a filter change Clear Filter
to reflect the filter and selected options. @

Filter results with a filter chain

You can filter the results that are listed in the Results screen with a system-installed or a custom-
designed filter chain. A filter chain is a set of filters that Genexus™ Software uses to narrow the list of
variants that are included in results.

Select a filter chain to change the list of variants that are included in the results. You can apply the filter
chain temporarily, then review the results before you decide whether to save the updated results, or
discard the changes.

If you save the filter chain to a result, the variants that are included reflect the filtered results when the
results are later opened.

For information about system-installed filter chains, and how manager- and administrator-level users
can create custom filter chains, see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or
the Genexus™ Software help system.

1. In the menu bar, click Results » Sample Results.

2. In the Sample Results screen, in the Sample Name column, select a sample of interest.

3. In the Results screen, click the Variants tab.
4. To refine the list of variants shown in the table, select a variant type.
* SNVs/Indels
* Fusions
* CNVs
5. Above the variant table in the Results screen, click Edit Filters, then select a filter chain.

¢ Click @ Edit to make changes to a draft filter chain, if needed.
¢ (Click [C Copy to copy, then edit the selected filter chain, if needed.
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The list of results changes to reflect the selected filter chain. If you made edits to the filter chain, all
sample results to which the edited filter chain is applied are also updated with the changes.

6. Click Save if you want the filter chain to be applied to the results when the results are later opened.
The filter chain is selected and applied to the results when the results are reopened.

Variant report

The variant report is a PDF report of the results for each sample in a sequencing run. You can use
a system-installed report template to generate a variant report, or you can customize the layout and
contents of a variant report.

To make a variant report available for each sample result upon completion of a sequencing run, enable
Generate Report in the Setup step when you plan the run. For more information, see the Genexus™
Software 6.8 User Guide (Pub. No. MAN0026409) or the Genexus™ Software help system). To generate
a variant report after a run is complete, see “Generate a variant report” on page 163.

When a variant report has been generated for a sample result, it is available for download in three
places:

* In the Results / Sample Results screen when you place the pointer over the row for that sample,
then click the Report link to download the PDF.

* In the variant report pane for the sample results in the Reports tab when you click
: (More) » Download Report.

* In the Results screen for the sample when you click --- (More Options) » Download Files.

Variant reports can be electronically or manually signed by users. Electronic signatures are shown in the
Electronically Signed By section of the report, if the section is included in the report template.

For information about the sections that can be included in a variant report, see the Genexus™ Software
6.8 User Guide (Pub. No. MAN0026409) or the Genexus™ Software help system.

View a variant report

You can view a variant report in Genexus™ Software. A variant report includes details of sample results.
The results depend on the filter chain applied to the results.

A variant report must be generated before you can view the report. If a report template is set as

the default template for the assay associated with the run, one or more variant reports are generated
after a run completes successfully. For more information, see the Genexus™ Software 6.8 User Guide
(Pub. No. MAN0026409) or the Genexus™ Software help system. Alternatively, you can generate one or
more variant reports after a run completes successfully. For more information, see “Generate a variant
report” on page 163.

1. In the menu bar, click Results » Sample Results.

2. In the Sample Results screen, click the sample name of interest in the Sample Name column.
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3. Click the Reports tab.

A pane for the run report and each variant report that has been generated is shown. The pane for a
variant report includes the following information.

Report name

Report template name

Date that the report was generated

Username for the user who generated the report
Language used for the report

If a variant report has been electronically signed at least once, the signature information is
listed in the pane for the variant report. If multiple users have signed the report, you can place
the pointer over the electronic signature information to view more details. If the electronic
signature that is used is associated with a lock-level signature type, the report is locked.

If a variant report is locked, & (Lock) is shown in the upper right corner of the pane.

4. In the pane of the report of interest, click (More) » Download Report.

The report opens in a new browser tab. You can download variant reports as PDF files.

Generate a variant report

The Lab Report is generated in the language that is selected in the report template. You can customize
this report by generating it in another language.

You can generate a new variant report for sample results after a run is complete. A & (Lock) in the
variant report indicates that the electronic signature option for the report is locked. After a variant report
is locked, the report cannot be electronically signed by any other user.

You can generate multiple reports for a sample result, if each report is named uniquely, and is
generated in a different language, or uses a different report template.

1. In the menu bar, click Results » Sample Results.

2. In the Results / Sample Results screen, click the sample of interest in the Sample Name column.

3. Select the Reports tab, then click + Generate Variant Report.

4. In the Generate Report dialog box, change the name of the report that is generated by the
software, if needed, then select the report template and language of the report.

a.

If the report template includes the option to include custom images from the results, click
Upload Image, then select the images to include in the report, and enter a title for the image,
and if needed enter a description and footnote for the image.

If the option to make custom text Editable on Report Generation was selected when the
report template was created, enter a title in the Custom Text section and if needed, a
description.

Report templates that are associated with the assay that was used in the run are included in
the Report Template list. For more information, see the Genexus™ Software 6.8 User Guide
(Pub. No. MAN0026409) or the Genexus™ Software help system.
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If you select the same report template that was used to generate a variant report, and have not
locked that report, the new selections you make override the previous variant report.

5. Click Generate.
A draft version of the report is added to the Reports tab.

A pane for the new report is added next to the Run Report pane in the Reports tab. Reports that have
been generated are available for download in the Reports tab, in the Sample Results screen, and in
the ZIP package that contains results files.

Reanalyze a run

164

If a sequencing run fails to meet one or more QC parameters defined by the assay, you can adjust
the assay parameters and reanalyze a run. For more information, see the Genexus™ Software 6.8 User
Guide (Pub. No. MAN0026409) or the Genexus™ Software help system.

Reanalysis of runs can start from the alignment, basecalling, or signal processing steps. When you
reanalyze a run, the reanalysis is applied to all samples in the assay.

Reanalysis from

the Description

Signal processing | The option to reanalyze a run from the signal processing step is available only when
step the following conditions are met.

*  When a run fails during the basecalling step or earlier.
* When the run has not already been successfully reanalyzed.

Reanalysis at the signal processing step uses DAT files.

Basecalling step The option to reanalyze a run from the basecalling step is available only when a run or
reanalysis successfully completes the signal processing step.

Reanalysis at the basecalling step uses .wells files.

Alignment step The option to reanalyze a run from the alignment step is available only when a run or
reanalysis successfully completes the basecalling step.

Reanalysis at the alignment step uses BAM files.

Note:

. Manager- and administrator-level users can reanalyze a sequencing run only if the run completed
without any critical alarms or errors. If the run aborted or produced major alarms or errors, the run
cannot be reanalyzed.

. QC parameters at the limits of stringency cannot be adjusted further. If samples fail QC and you
cannot adjust the QC parameters further, you can sequence the sample library again. For information
to find, recover, and purify the leftover library preparations, see the Genexus™ Integrated Sequencer
User Guide (Pub. No. MANOO17910). Alternatively, you can prepare a new library for sequencing.
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The files needed for the stage of reanalysis that you select must be present in the software. For
example, if the .wells files for the run have been removed from the software, you cannot reanalyze from
basecalling. Instead, reanalyze the BAM files at alignment. Administrator-level users can manage the
settings and schedule to backup and delete files and data. For more information, see the Genexus™
Software 6.8 User Guide (Pub. No. MAN0026409) or the Genexus™ Software help system.

You can reanalyze a run with any compatible assay that exists in the software. Alternatively, you can
create a new assay or copy the original assay that was used in a run and modify assay parameters
if needed. For more information, see “Create an assay in Genexus™ Software for use with a custom
panel” on page 56.

—

In the menu bar, click Results » Run Results.

2. In the Results / Run Results screen, in the Run Name column, click the run name of interest.

1

In the upper right corner of the screen, click --- (More Options) » Reanalyze.

b

In the Reanalyze dialog box, enter or select the following information.
a. In Reanalysis Run Name field, enter a reanalysis run name.

b. In Start Reanalysis from dropdown list, select Alignment, Basecalling or Signal
Processing.

c. In the Current Assay in Run column, select the checkbox in the row of each assay that you
want to reanalyze, then in the Choose Assay to Reanalyze column, select an assay that you
want to use for each reanalysis from the dropdown list.

5. Click Reanalyze.

Follow the progress of the reanalysis in the Results / Run Results screen in the Run Status column,
and in the Results / Sample Results screen in the Sample Status column. When reanalysis is
complete, the new results can be viewed by clicking the run name corresponding to the reanalysis
assay in the Results / Run Results screen. Runs that have been reanalyzed are appended with & after
the run name.

Reanalyze a sample

If a sample fails to meet one or more QC parameters defined by the assay, you can adjust the assay
parameters and reanalyze a sample. A sample can be reanalyzed starting only from the alignment
step. You can reanalyze all samples in a run from the basecalling or signal processing steps. For more
information, see “Reanalyze a run” on page 164.

Reanalysis at the alignment step uses BAM files.

Note: Manager- and administrator-level users can reanalyze a sample only if the run completed without
any critical alarms or errors. If the run aborted or produced major alarms or errors, the sample cannot
be reanalyzed.

The option to reanalyze a sample from the alignment step is available only when a sample or reanalysis
successfully completes the basecalling step.
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You can reanalyze a sample with any compatible assay that exists in the software. Alternatively, you
can create a new assay or copy the original assay that was used in a run and modify assay parameters
if needed. For more information, see “Create an assay in Genexus™ Software for use with a custom
panel” on page 56.

1. In the menu bar, click Results » Sample Results.

2. In the Sample Results screen, place the pointer over the row of a sample of interest, then click
Reanalyze.

Alternatively, you can reanalyze a sample when you click a sample name, then click
.-+ (More Options) » Reanalyze.

3. In the Reanalyze dialog box, enter or select the following information.
a. In Reanalysis Run Name field, enter a reanalysis run name.

b. In the Current Assay in Run column, select the checkbox in the row of each assay that you
want to reanalyze, then in the Choose Assay to Reanalyze column, select an assay that you
want to use for each reanalysis from the dropdown list.

4. Click Reanalyze.

Follow the progress of the reanalysis in the Results / Sample Results screen in the Sample Status
column. When reanalysis is complete, the new results can be viewed by clicking the sample nhame
corresponding to the reanalysis assay in the Results / Sample Results screen. Samples that have
been reanalyzed are listed in the table of sample results with the run name appended with ©&.

Plugins for data analysis

You can expand the analysis capabilities of Genexus™ Software with plugins that are preinstalled with
the software. The plugin results are added to the report summary and can be used for a various
purposes.

An administrator-level user can download and install more plugins from the Thermo Fisher™ Connect
Platform.

Review coverageAnalysis plugin results

166

The coverageAnalysis plugin generates a Coverage Analysis Report. This report includes read
statistics and several charts. The statistics and charts that are presented depend on the library type
for the analysis.

The report summary lists the barcode, the sample, the number of mapped reads, the percentage of on
target reads, mean base coverage depth, and base coverage uniformity.

You can download coverageAnalysis plugin output files from the Results screen for a sample. For more
information, see “Output files generated by the coverageAnalysis plugin” on page 167.

1. In the menu bar, click Results » Sample Results.

2. In the Sample Results screen, in the Sample Name column, click the sample of interest.
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3. Click the Plugins tab.
A summary table of the coverage analysis, by barcode, is included in the coverageAnalysis
summary pane.

4. (Optional) From the Executed At dropdown list, select an alternate timestamp, if available, to view
additional reports.

5. (Optional) Click [3 View Log to view the coverageAnalysis log.

6. (Optional) Click Ti] Delete to delete the coverageAnalysis plugin output for the selected timestamp.

IMPORTANT! If you click Ti] Delete, the report is deleted without the appearance of the

confirmation window. Ensure that you intend to delete the report before clicking [il Delete.

7. Click --- (More) » Download Files to download coverageAnalysis plugin results files.

Note: Sometimes the file name can be too long to open in applications such as Microsoft™
Excel™. To resolve this problem, right-click the file and click Save As to rename the downloaded
file.

8. In the coverageAnalysis summary pane, in the Barcode Name column, click the link in the row of
the barcode of interest.
The detailed Coverage Analysis Report for the barcode opens in a separate window.

Output files generated by the coverageAnalysis plugin

You can download coverageAnalysis plugin results files from the Results screen for a sample. For
more information, see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the Genexus™
Software help system.

Note: Sometimes the downloaded file name can be too long to open a file in applications such
as Microsoft™ Excel™. To resolve this problem, right-click the file, click Save As, then rename the
downloaded file with a shorter name.

The following tables describe the files that can be generated by the coverageAnalysis plugin. The list of
files depends on the type of assay that was selected during assay creation.

Table 35 File download selections in the Genexus™ Software

Selection File Name
DNA Coverage Statistics <DNA Barcode><ExpName>.stats.cov.txt
DNA Chromosome base coverage summary <DNA Barcode><ExpName>.chr.cov.xls
DNA Base depth of coverage <DNA Barcode><ExpName>.base.cov.xls
DNA Amplicon coverage summary <DNA Barcode><ExpName>.amplicon.cov.xls
DNA Coverage Analysis Summary (.pdf) <DNA Barcode><ExpName>.summary.pdf
RNA Coverage Statistics <RNA Barcode><ExpName>.stats.cov.txt
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Table 35 File download selections in the Genexus Software (continued)

Selection File Name
RNA Amplicon coverage summary <RNA Barcode><ExpName>.amplicon.cov.xls
RNA Coverage Analysis Summary (.pdf) <RNA Barcode><ExpName>.summary.pdf
TNA Coverage Statistics <TNA Barcode><ExpName>.stats.cov.txt
TNA Chromosome base coverage summary <TNA Barcode><ExpName>.chr.cov.xls
TNA Base depth of coverage <TNA Barcode><ExpName>.base.cov.xls
TNA Amplicon coverage summary <TNA Barcode><ExpName>.amplicon.cov.xls
TNA Coverage Analysis Summary (.pdf) <TNA Barcode><ExpName>.summary.pdf

Table 36 File contents

File Description
Coverage A summary of the statistics presented in the tables at the top of the plugin report. The first line is
Statistics the title. Each subsequent line is either blank or a particular statistic title followed by a colon (:)
and its value.
Chromosome Base reads per chromosome summary data that is used to create the default view of the
base coverage Reference Coverage Chart. This file contains the following fields.
summary o

chrom: the name of the chromosome or contig of the reference.

start: the coordinate of the first base in this chromosome. This is always 1.

end: the coordinate of the last base of this chromosome. Also its length in bases.

fwd basereads: the total number of forward strand base reads for the chromosome.

rev_basereads: the total number reverse strand base reads for the chromosome.

fwd trg basereads (if present): the total number of forward strand base reads that
mapped over at least one target region.

rev_trg basereads (if present): the total number of reverse strand base reads that
mapped over at least one target region.

total reads: the total number of sequencing reads that are mapped to individual

contigs.
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Table 36 File contents (continued)

File Description

Base depth of Coverage summary data used to create the Depth of Coverage Chart. This file contains the
coverage following fields.

* read depth: the depth at which a (targeted) reference base has been read.

* base_cov: the number of times any base was read (covered) at this depth.
Note: Lines (read depths) for which base cov is 0 are omitted to avoid excessively large
files being produced in specific situations.

®* base_ cum_cov: the cumulative number of reads (coverage) at this read depth or greater.

®* norm_ read depth:the normalized read depth (depth divided by average base read
depth).

®* pc base cum_cov:same as base_cum_cov but represented as a percentage of the total
base reads.
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Table 36 File contents (continued)

File Description
Amplicon Coverage summary data used to create the Amplicon Coverage Chart. This file contains the
coverage following fields:
summary o

contig_id:the name of the chromosome or contig of the reference for this amplicon.
®* contig srt:the start location of the amplicon target region.
Note: This coordinate is 1-based, unlike the corresponding 0-based coordinate in the
original targets BED file.
®* contig end: the last base coordinate of this amplicon target region.

Note: The length of the amplicon target is given as tlen = (contig_end - contig_srt + 1).
®* region_id:the ID for this amplicon as given as the fourth column of the targets BED file.

®* gene_ idorattributes: the gene symbol or attributes field as provided in the targets
BED file.

®* gc_count: the number of G and C bases in the target region. The %GC that is uses this
count divided by the amplicon (insert) length.

* overlaps: the number of times this target was overlapped by any read by at least one
base.
Note: Individual reads might overlap multiple amplicons where the amplicon regions
themselves overlap.

* fwd e2e:the number of assigned forward strand reads that read from one end of the
amplicon region to the other end.

* rev_e2e:the number of assigned reverse strand reads that read from one end of the
amplicon region to the other end.

®* total reads: the total number of reads assigned to this amplicon. This value is the sum
of fwd_reads and rev_reads and is the field that rows of this file are ordered by (then by
contig id, srt, and end).

* fwd reads:the number of forward strand reads that are assigned to this amplicon.
* rev_reads: the number of reverse strand reads that are assigned to this amplicon.

* covNx: the number of bases of the amplicon target that had at least N reads. There are
3 such columns for the specified coverage tiers, which by default are cov100x, cov350x,
and cov500x.

Coverage A PDF file that contains the Coverage Analysis Report, including read statistics and charts that
Analysis are generated by the coverageAnalysis plugin.
Summary (.pdf)

Review molecularCoverage Analysis plugin results

The molecular Coverage Analysis plugin generates a Molecular Coverage Analysis Report. This report
includes molecule statistics and several charts. The report summary lists the barcode, the sample, the
median molecular coverage, the molecular uniformity, the median reads per functional molecule, and
the median percentage of functional reads. Additional details regarding molecular coverage are also
provided on a per-barcode basis, along with amplicon information that is included in the BED file.
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You can download molecular Coverage Analysis plugin output files from the Results screen for a
sample. For more information, see “Output files generated by the molecular Coverage Analysis plugin”
on page 171.

1. In the menu bar, click Results » Sample Results.
2. In the Sample Results screen, in the Sample Name column, click the sample of interest.

3. Click the Plugins tab.

A summary table of the coverage analysis, by barcode, is included in the molecularCoverage
Analysis summary pane.

4. (Optional) From the Executed At dropdown list, select an alternate timestamp, if available, to view
additional reports.

5. (Optional) Click 2 View Log to view the molecular Coverage Analysis log.

6. (Optional) Click Ti] Delete to delete the molecular Coverage Analysis plugin output for the selected
timestamp.

IMPORTANT! If you click Ti] Delete, the report is deleted without the appearance of confirmation

dialog window. Ensure that you intend to delete the report before clicking [i] Delete.

7. Click + (More) » Download Files to download coverageAnalysis plugin results files.

Note: Sometimes the file name can be too long to open in applications such as Microsoft™
Excel™. To resolve this problem, right-click the file and click Save As to rename the downloaded
file.

8. In the molecularCoverage Analysis summary pane, in the Barcode Name column, click the link
in the row of the barcode of interest.

The detailed Molecular Coverage Analysis Report for the barcode opens in a separate window.

Output files generated by the molecularCoverage Analysis plugin

You can download plugin results files from the Results screen for a sample. For more information,
see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the Genexus™ Software help
system.

Note: Sometimes the file name can be too long to open in applications such as Microsoft™ Excel™. To
resolve this problem, right-click the file, then click Save As to rename the downloaded file.

The following tables describe the results files that can be generated by the molecular Coverage Analysis
plugin. The list of files depends on the type of assay template that was selected during assay creation.
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Customer Support Archive

The Customer Support Archive is a downloadable archive that a technical support representative can
use to troubleshoot and diagnose issues with sequencing runs or with Genexus™ Software. The archive
contains log files and other technical data about the software and other files from sequencing runs on a
Genexus™ Integrated Sequencer.

For more information, see “Download a Customer Support Archive” on page 172.

Download a Customer Support Archive

When you download a Customer Support Archive (CSA) in Genexus™ Software, files are included for all
samples for a specific assay. If the run includes only one assay, files for all samples are included. If the
run includes more than one assay, you can specify the assay of interest when you download the CSA.

1. In the menu bar, click Results » Sample Results.

2. In Sample Results screen, place the pointer over the row of the sample result of interest, then
click CSA.

Alternatively, you can download CSA files three other ways.
* (Click Results » Sample Results. Click the sample name of interest. Then, click
-+« (More Options) » CSA.

* C(Click Results » Run Results. Click the run name of interest. Place the pointer over the run of
interest, then click CSA. In the Download CSA dialog box that appears, select the assay of
interest, then click Download.

¢ (Click Results » Run Results. Click the run name of interest. Then, click
-+« (More Options) » CSA. In the Download CSA dialog box that appears, select the assay of
interest, then click Download.

An XZ compressed TAR archive (TXZ) file is downloaded to the folder that you specified to download
files from the browser. This location depends on the browser settings. You can attach the archive to an
email to send to Customer Support.
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Upload results files to another Genexus™ Integrated
Sequencer

When a run completes successfully in Genexus™ Software, you can upload the results (BAM files) to
another Genexus™ Integrated Sequencer.

Tip: To automatically upload BAM files when a run is complete, select the Upload BAM files to Server
checkbox in the Setup step of planning a run.

Before you can upload results files to another Genexus™ Integrated Sequencer, you must link the
accounts that you can use for data uploads. For more information, see the Genexus™ Software 6.8 User
Guide (Pub. No. MAN0026409) or the Genexus™ Software help system.

1. In the menu bar, click Results » Run Results.

2. In the Run Results screen, place the pointer over the row of a run of interest, then click BAM
Uploader.

3. In the Upload Samples to Server dialog box, make the following selections.

a. From the Configured Account list, select the Genexus™ Software account and the software
version.

b. In the Select column, select one or more assays from the list to upload the results files from
the selected assays.

c. In the Genexus Workflow column, select whether you want analysis to start on the selected
Genexus™ Integrated Sequencer immediately.

* Select Upload Only to upload the sample results (BAM files) to the software.

® Select an assay of interest to upload the sample results (BAM files) and automatically
start analysis with the selected assay on the Genexus™ Integrated Sequencer.

d. Click Upload.

The results are uploaded to another Genexus™ Integrated Sequencer.
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Troubleshooting and FAQs

Visit our online Support Centers and FAQ database for tips and tricks for conducting your experiment,
troubleshooting information, and FAQs. The online FAQ database is frequently.

* For the Next—-Generation Sequencing Support Center: thermofisher.com/ngssupport

¢ To browse the FAQ database and search using keywords: thermofisher.com/faqgs
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Expand any lon AmpliSeq™ panel by adding a spike-in
panel

Any lon AmpliSeq™ Custom panel can be modified by using a spike-in panel. Spike-in panels enable
addition of new content, control assays, and improvements in coverage uniformity (for example, by
adding the same primer pair to two or more primer pools). Spike-in panels come as pooled amplicons
at 50X (2500 nM) concentration.

1. If needed, prepare a 50X (2,500 nM) spike-in panel with individual primer pairs from a panel
provided in 384-well plate format.

2. Add the spike-in panel (at 2,500 nM) to a primary lon AmpliSeq™ panel using the following

guidelines.
Number of primer pairs/pool Target
Primary | Spike-in | Combined | Concentration Instructions
panel | panel panel (Combined)

lon AmpliSeq™ On-Demand Panels!'!

Add 6.4 pL of the spike-in panel directly into the lon AmpliSeq™ On-Demand Panel in the lon Chef™ Library Sample
Tube.

All other types of primary panels

<96 <123 <96 400 nM Add 16 pL of the spike-in panel per 100 pL of the primary panel

<96 <123 >96 100 nM Dilute parent panel from 400 nM to 100 nM, then add 4 pL spike-in
panel per 100 pL of primary panel

>96 <123 >96 100 nM Add 4 pL spike-in panel per 100 pL primary panel

' Each lon AmpliSeq™ On-Demand Panel is provided in lon Chef™ Library Sample Tubes and must be transferred into Genexus™ Primer Pool
Tubes for loading on the instrument.
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Table 37 Examples of spike-in volumes for different categories of parent and spike-in panel

Number of primer pairs/pool Concentration (nM) Volumes for spiking | Final concentration
(ML) (nM)

Parent | Spike-in | Combined Parent | Spike-in Tarqet Parent Spike-in | Parent | Spike-in
panel panel panel (combined)

50 20 70 400 2,500 400 160 25.6 345 345

80 60 140 100 2,500 100 160 6.4 96.2 96.2

(diluted)

3,000 120 3,120 100 2,500 98.5 160 6.4 96.2 96.2

3. Mix thoroughly by vortexing, then centrifuge briefly to collect contents.

4. Pipet the needed volume of combined panel into a Genexus™ Primer Pool Tube.
* 4 reactions ( GX5™ Chip)—add 140 pL
® 4 reactions (GX7™ Chip)—add 168 pL
® 6 reactions (GX5™ or GX7™ Chip)—add 168 pL

For more information, see “Fill Genexus™ Primer Pool Tubes” on page 101.

lon AmpliSeq™ Sample ID Panel

The lon AmpliSeq™ Sample ID Panel is a versatile, cost effective, and easy-to-use human SNP
genotyping panel containing 9 specially designed primer pairs that generate a unique ID during

post-sequencing analysis of human gDNA research samples. The panel can be spiked into any lon
AmpliSegq™ Custom panel.

Approx. library size

Panel Concentration (with adapters)

Amount Storagel'!

lon AmpliSeq™ Sample ID Panel 20X 150-220 bp 1 tube (96 rxns) | -30°C to -10°C
(Cat. No. 4479790)

[ Shipped at ambient temperature. Store as indicated.

Add the lon AmpliSeq™ Sample ID Panel to a DNA Custom panel

The lon AmpliSeq™ Sample ID Panel can be added to any lon AmpliSeq™ Custom DNA panel.

Note: The lon AmpliSeg™ Sample ID Panel is provided at 20X concentration and must be diluted 1:10
into the primary custom DNA panel at 2X concentration for use.

1. Add the lon AmpliSeg™ Sample ID Panel to each DNA panel pool using the following guidelines.

® 4 reactions—add 15 pL lon AmpliSeq™ Sample ID Panel to 135 pL of the main lon AmpliSeq™
Custom panel

® 6 reactions—add 17 pL lon AmpliSeq™ Sample ID Panel to 153 pL of the main lon AmpliSeq™
Custom panel
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2. Vortex the combined panel to mix thoroughly, then centrifuge briefly to collect the contents.

3. Pipet the needed volume of combined panel into a Genexus™ Primer Pool Tube.
* 4 reactions ( GX5™ Chip)—add 140 pL
® 4 reactions (GX7™ Chip)—add 168 pL
® 6 reactions (GX5™ or GX7™ Chip)—add 168 pL

For more information, see “Fill Genexus™ Primer Pool Tubes” on page 101.

samplelD plugin

The lon AmpliSeg™ Sample ID Panel is a human genotyping panel consisting of 9 primer pairs that
identify the gender and eight high-frequency noncoding SNPs of human samples. The panel can be
added to any lon AmpliSeq™ Custom panel.

The samplelD plugin is used to analyze sequencing results from any panel containing the 9 primer pairs
of the lon AmpliSeg™ Sample ID Panel to generate a unique identification code (SamplelD) for each
sample.

Use the SamplelD to monitor samples and identify any misassignments or mix-ups between samples
and barcodes during a sequencing run.

The samplelD plugin does not run by default. You must select the samplelD plugin in the Plugins step
when you create an assay to have the samplelD plugin run during analysis. For more information, see
“Create an assay in Genexus™ Software for use with a custom panel” on page 56.

Review samplelD plugin results in Genexus™ Software

After the sequencing run completes, review the plugin results.

—

. In the menu bar, click Results » Sample Results.
2. In the Sample Results screen, in the Sample Name column, click the sample of interest.

3. Click the Plugins tab.
A summary table of the samplelD results is shown.

4. Click a barcode name to open the Sample ID Report.

5. To return to Genexus™ Software, click back in the browser.
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Sample ID Report

The Sample ID Report that is available when you select a barcode in the SamplelD plugin summary
for a run includes a variety of read statistics.

The statistics that are displayed in your report depend on the type of library that is used in your
sequencing experiment. Definitions are in tooltips. Almost every statistic, plot, link, and functional
widget in the report provides a tooltip with definitions. Place the pointer over a heading or description in
the report to view the tooltip.

Statistic Description
Number of mapped reads The total number of reads mapped to the reference genome.
Number of reads in sample ID The total number of reads mapped to Sample ID regions.
regions
Percent reads in sample ID The percent of all reads aligned to the reference that covered bases in
regions Sample ID regions.
Total base reads in sample ID The total base reads aligned to the reference that covered bases in
regions Sampile ID regions.

Percent base reads in sample ID | The percent of all bases covered by reads aligned to the reference that

regions covered bases in Sample ID regions.

Male sample ID region reads Number of reads mapped to the specific male (Y) identification target
or targets.

Female sample ID region reads Number of reads mapped to the specific female (X) identification target
or targets.

Sample ID Regions and Sample ID SNPs

Bases in target regions The total number of bases in all specified target regions of the
reference.

Average base coverage depth The average number of DNA reads of all targeted reference bases.

Uniformity of coverage The percentage of target bases covered by at least 0.2x of the average

base coverage depth.

Coverage at 1x The percentage of target bases covered by at least 1 read.
Coverage at 20x The percentage of target bases covered by at least 20 reads.
Coverage at 100x The percentage of target bases covered by at least 100 reads.
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Output files generated by the samplelD plugin

You can download samplelD plugin results files from the Results screen for a sample. For more
information, see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the Genexus™

Software help system.

Note: Sometimes the file name can be too long to open in applications such as Microsoft™ Excel™. To
resolve this problem, right-click the file and click Save As to rename the downloaded file.

Table 38 describes the files that can be generated by the samplelD plugin. The list of files depends on
the application type that was selected during assay creation.

Table 38 File download selections in the Genexus™ Software

Selection

File Name

Tracking Loci Regions (SNPs) File

tracking loci.bed

Aligned Tracking Reads Index (BAl) File

<DNA Barcode><ExpName>.bam.bai

Hard-copy A4 PDF Image Of This Report Page

<DNA Barcode><ExpName>.samplelD.pdf

Tracking Target Regions File

tracking regions.bed

Aligned Tracking Reads (BAM) File

<DNA Barcode><ExpName>.bam

All Variant Calls As a Table File

allele counts.xls

Quantify FFPE DNA with the Qubit™ Fluorometer

When using the lon AmpliSeq™ Direct FFPE DNA Kit, the DNA concentration can be estimated using a
Qubit™ Fluorometer and the Qubit™ dsDNA HS Assay Kit (Cat. No. Q32851). See the Qubit™ dsDNA HS
Assay Kits User Guide (Pub. No. MAN0002326) for more information.

1. Set up the needed number of 0.5-mL Qubit™ Assay tubes for standards and samples. The Qubit™

dsDNA HS Assay requires 2 standards.

2. Prepare sufficient Qubit™ working solution for all samples and standards by diluting Qubit™ dsDNA
HS Reagent 1:200 in Qubit™ dsDNA HS Buffer.

3. Combine 2 pL of the FFPE DNA sample with 198 pL (200-pL final volume) of working solution, mix
well, then incubate for at least 2 minutes.

4. Prepare each Qubit™ standard as directed in the user guide.

5. Measure the concentration of each sample and standard on the Qubit™ Fluorometer.

6.

(Qubit™ 2.0 Fluorometer only.) Calculate the concentration of the undiluted sample by multiplying

by the dilution factor. Alternatively, use the Calculate Stock Conc. feature on the instrument.
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Centrifuge library and templating reagent strips using the Genexus™ Strip Centrifuge Adapter

Proceed to “Dilute or concentrate the samples, if needed, then load the sample plate—Nucleic Acid to
Result run” on page 95.

Centrifuge library and templating reagent strips using the
Genexus™ Strip Centrifuge Adapter

180

You can use the Genexus™ Strip Centrifuge Adapter as a holder for centrifuging library and templating
strips to collect contents after vortexing the strips. Vortexing and centrifuging strips is recommended
to decrease errors in the workflow due to air bubbles in strip wells or beads trapped near the foil seal.
Users can request this part from a Thermo Fisher Scientific Field Service Engineer.

Note: The Genexus™ Strip Centrifuge Adapter can also be used to centrifuge Genexus™ Primer Pool
Tubes.

Use of the adapter requires a centrifuge with buckets that support the height of the adapter at 44 mm
so that buckets swing freely in the centrifuge rotor when loaded with strips. For more information, see
“Required materials —general laboratory equipment and supplies” on page 22.

Genexus™ Strip Centrifuge Adapter
(D 44 mm height

To use the Genexus™ Strip Centrifuge Adapter, follow these steps.

1.

After thawing, vortex each strip at maximum speed for 5-10 seconds while rocking the strip from
side to side.

Load the strips in the adapters in a balanced orientation, then place each adapter loaded with
strips in the centrifuge. The centrifuge buckets must support the height of the adapters loaded
with strips.

Centrifuge the strips at 300 x g for 15 seconds.

Remove strips from the adapters, then inspect the strips to ensure that contents have been
collected and air bubbles are not present.
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5. If brown magnetic beads are still visible in the tube keyhole near the foil seal, invert the strip to
resuspend the contents, then repeat step 3.

Note: It is not necessary to dislodge all the beads trapped in a keyhole—dislodging most beads is
sufficient.

6. Repeat step 1 through step 4, if needed, for the remaining library and templating strips to be
loaded in the sequencer.

7. After centrifugation, keep each strip on ice or 4°C until you are ready to load the strips in the
sequencer.

Genexus™ consumables use tables

Table 39 GX5™ Chip One-pool assay, 4 reactions per strip (32 barcode plate), requiring 500K reads per
sample

Sample number 1|46 |8|10|12|16 /18|20 |24 |28 |30 321 36|42 |48
Tube carriers with primer pool 1 1 2 3 4 5 6 |7 8 N/A
Sets of strips 1 and 2-AS 1 2 3 4 5 6 |7 8 N/A
Sets of strips 3 and 4 1 2 N/A
Lanes used (12-15 M reads per lane) 1 2 N/A

' Maximum of 32 samples, limit of 8 Genexus™ Library Strips 1 and 2-AS.

Table 40 GX5™ Chip One-pool assay, 6 reactions per strip (48 barcode plate), requiring 500K reads per
sample

Sample number 1/4|6 |8 |10/12|16|18 20|24 28|30 32|36 42 48
Tube carriers with primer pool 1 1 2 3 4 5 6 718
Sets of strips 1 and 2-AS 1 2 3 4 5 6 7.8
Sets of strips 3 and 4 1 2
Lanes used (12-15 M reads per lane) 1 2

lon AmpliSeq™ & lon AmpliSeq™ HD Custom Assay User Guide 181




Appendix B Supplemental procedures
Genexus™ consumables use tables

Table 41 GX5™ Chip Two-pool assay, 4 reactions per strip (32 barcode plate), requiring 1 M reads per
sample

Sample number 1,14 |6 |8|10 12 16[1|18|20 |24 |28 30|32 36|42 48
Tube carriers with primer pool 1 1 2 3 4 N/A
Tube carriers with primer pool 2 1 2 3 4 N/A
Sets of strips 1 and 2-AS 2 4 6 8 N/A
Sets of strips 3 and 4 1 2 N/A
Lanes used (12-15 M reads per lane) 102 2 N/A

' Maximum of 16 samples, limit of 8 Genexus™ Library Strips 1 and 2-AS and 32 barcodes.
@' Limit of 12 samples per lane due to 1 M read per sample requirement.

Table 42 GX5™ Chip Two-pool assay, 6 reactions per strip (48 barcode plate), requiring 1 M reads per
sample

Sample number 1|46 |8|10|12|16 /18|20 | 241 |28 |30 |32 36 |42 |48
Tube carriers with primer pool 1 1 2 3 4 N/A
Tube carriers with primer pool 2 1 2 3 4 N/A
Sets of strips 1 and 2-AS 2 4 6 8 N/A
Sets of strips 3 and 4 1 2 N/A
Lanes used (12-15 M reads per lane) 10 2 N/A

' Maximum of 24 samples, limit of 8 Genexus™ Library Strips 1 and 2-AS and 48 barcodes.
[ Limit of 12 samples per lane due to 1 M read per sample requirement.

Table 43 GX5™ Chip 2 x two-pool assay, 4 reactions per strip (32 barcode plate), requiring 8 M reads per
sample (DNA + fusions)

Sample number 1 2 3 4 5 6l 7
Tube carriers with DNA primer pool 1 1 2 N/A
Tube carriers with DNA primer pool 2 1 2 N/A
Tube carriers with RNA primer pool 1 1 2 N/A
Tube carriers with RNA primer pool 2 1 2 N/A
Sets of strips 1 and 2-AS 4 8 N/A
Sets of strips 3 and 4 1 2 3 4 N/A
Lanes used (12-15 M reads per lane) 1 2 3 4 N/A

01 Limit of 6 samples due to 8 M read per sample requirement.
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Note: Seven samples at 8 M reads per sample exceed the capacity of the GX5™ Chip. You can

proceed with the run using eight pairs of library strips and four pairs of template strips, but you may not

achieve the minimum reads per sample set for the assay.

Table 44 GX5™ Chip 2 x two-pool assay, 6 reactions per strip (48 barcode plate), requiring 8 M reads per

sample (DNA + fusions)

Sample number 1 2 3 4 5 6l 7
Tube carriers with DNA primer pool 1 1 N/A
Tube carriers with DNA primer pool 2 1 N/A
Tube carriers with RNA primer pool 1 1 N/A
Tube carriers with RNA primer pool 2 1 N/A
Sets of strips 1 and 2-AS 4 N/A
Sets of strips 3 and 4 1 2 3 4 N/A
Lanes used (12-15 M reads per lane) 1 2 3 4 N/A
01 Limit of 6 samples due to 8 M read per sample requirement.
Table 45 GX7™ Chip One-pool assay, 6 reactions per strip, requiring 1 M reads per sample
Sample number 1|46 |8|10|12|16 /18|20 |24 |28 | 30" |32 36|42 |48
Tube carriers with primer pool 1 1 2 3 4 5 6 7|8
Sets of strips 1 and 2-AS 1 2 3 4 5 6 7|8
Sets of strips 3 and 4 1 2
Lanes used (20-25 M reads per lane) 12 2
" When using a 32 barcode plate, barcode 31 & barcode 32 cannot be used and are discarded after the run.
' Limit 24 samples per lane due to 1 M read per sample requirement.
Table 46 GX7™ Chip Two-pool assay, 6 reactions per strip, requiring 2 M reads per sample
Sample number 1,146 |8|10 12/16|18|20| 24 |28 30|32 36|42 48
Tube carriers with primer pool 1 1 2 3 4 N/A
Tube carriers with primer pool 2 1 2 3 4 N/A
Sets of strips 1 and 2-AS 2 4 6 8 N/A
Sets of strips 3 and 4 1 2 N/A
Lanes used (20-25 M reads per lane) 1 2 N/A
' Maximum of 24 samples, limit of 8 Genexus™ Library Strips 1 and 2-AS and 48 barcodes.
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Table 47 GX7™ Chip 2 x two-pool assay, 6 reactions per strip, requiring 16 M reads per sample (DNA +
fusions)

Sample number 1 2 3 4 5 el 7
Tube carriers with DNA primer pool 1 1 N/A
Tube carriers with DNA primer pool 2 1 N/A
Tube carriers with RNA primer pool 1 1 N/A
Tube carriers with RNA primer pool 2 1 N/A
Sets of strips 1 and 2 4 N/A
Sets of strips 3 and 4 1 2 3 4 N/A
Lanes used (20-25 M reads per lane) 1 2 3 4 N/A

' Limit of 6 samples due to 16 M read per sample requirement.

lon AmpliSeq™ HD consumables use tables

Table 48 GX5™ Chip One-pool assay, 4 reactions per strip (32 HD barcode plate), requiring 1.5 M reads
per sample

Sample number 1 4 | 6 | 8 10|12 |16 |18 | 20 | 24 | 28 | 30 | 32
Tube carriers with primer pooll'l 1 2 3 4 5 6 7 8
Sets of strips 1 and 2-HD 1 2 3 4 5 6 7 8
Sets of strips 3 and 4 1 2 3 4
Lanes used (12-15 M reads per lane) 1(2] 2 3 4

[ Forward (FWD) primer in tube position 1, reverse (REV) primer in tube position 2.
[ Limit of 8 samples per lane due to 1.5 M reads per sample requirement.

Table 49 GX5™ Chip Two-pool assay, 4 reactions per strip (32 HD barcode plate), requiring 1 M reads per
sample

Sample number 1 4 | 6|8 |10|12| 16" |18 |20 | 24 | 28 | 30 | 32
Tube carriers with primer pool 1[ 1 2 3 4 N/A
Tube carriers with primer pool 2[2 1 2 3 4 N/A
Sets of strips 1 and 2-HD 2 4 6 8 N/A
Sets of strips 3 and 4 1 2 N/A
Lanes used (12-15 M reads per lane) 1 2 N/A

' Genexus™ Barcodes 1-32 HD plate limits the run to a maximum of 16 samples. Each pool requires a unique barcode.
[ Forward (FWD) primer in tube position 1, reverse (REV) primer in tube position 2.
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Table 50 GX7™ Chip One-pool assay, 4 reactions per strip (32 HD barcode plate), requiring 2 M reads per

sample
Sample number 8 |10 |12 |16 |18 |20 | 24 | 28 | 30 | 32
Tube carriers with primer pooll! 2 3 4 5 6 | 7 8
Sets of strips 1 and 2-HD 2 3 4 5 6 | 7 8
Sets of strips 3 and 4 1 2 3
Lanes used (20-25 M reads per lane) 1 2 3

' Forward (FWD) primer in tube position 1, reverse (REV) primer in tube position 2.

Table 51 GX7™ Chip Two-pool assay, 4 reactions per strip (32 HD barcode plate), requiring 1.5 M reads per

sample
Sample number 8 |10 /12| 16l |18 | 20 |24 |28 30| 32
Tube carriers with primer pool 1(2] 3 4 N/A
Tube carriers with primer pool 22! 3 4 N/A
Sets of strips 1 and 2-HD 6 8 N/A
Sets of strips 3 and 4 1 N/A
Lanes used (20-25 M reads per lane) 1 N/A

[ Genexus™ Barcodes 1-32 HD plate limits the run to a maximum of 16 samples. Each pool requires a unique barcode.
@ Forward (FWD) primer in tube position 1, reverse (REV) primer in tube position 2.

Table 52 GX7™ Chip Two-pool DNA + 1-pool RNA assay, 4 reactions per strip (32 HD barcode plate),

requiring 3 M reads per sample

Sample number 8l 10 12|16 |18 |20 |24 28|30 | 32
Tube carriers with DNA primer pool 1[4 2 N/A
Tube carriers with DNA primer pool 2 2 N/A
Tube carriers with RNA primer pool 12 2 N/A
Sets of strips 1 and 2-HD 6 N/A
Sets of strips 3 and 4 1 N/A
Lanes used (20-25 M reads per lane) 1 N/A

' Maximum of 8 tube carriers limits run to 8 samples. Four reactions per set of three tube carriers.
[l Forward (FWD) primer in tube position 1, reverse (REV) primer in tube position 2.
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& WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, visit thermofisher.com/support.
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Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with

sufficient ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer

cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

A AVERTISSEMENT ! PRECAUTIONS GENERALES EN CAS DE MANIPULATION DE PRODUITS

' ' CHIMIQUES. Pour minimiser les risques, veiller a ce que le personnel du laboratoire lise attentive-
ment et mette en ceuvre les consignes de sécurité générales relatives a I'utilisation et au stockage
des produits chimiques et a la gestion des déchets qui en découlent, décrites ci-dessous. Consulter
également la FDS appropriée pour connaitre les précautions et instructions particulieres a respecter :

. Lire et comprendre les fiches de données de sécurité (FDS) fournies par le fabricant avant de
stocker, de manipuler ou d’utiliser les matériaux dangereux ou les produits chimiques. Pour obtenir
les FDS, se reporter a la section « Documentation et support » du présent document.

. Limiter les contacts avec les produits chimiques. Porter des équipements de protection appropriés
lors de la manipulation des produits chimiques (par exemple : lunettes de slreté, gants ou véte-
ments de protection).

. Limiter I'inhalation des produits chimiques. Ne pas laisser les récipients de produits chimiques
ouverts. lls ne doivent étre utilisés qu’avec une ventilation adéquate (par exemple, sorbonne).

. Vérifier régulierement I’absence de fuite ou d’écoulement des produits chimiques. En cas de fuite
ou d’écoulement d’un produit, respecter les directives de nettoyage du fabricant recommandées
dans la FDS.

. Manipuler les déchets chimiques dans une sorbonne.
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. Veiller a utiliser des récipients a déchets primaire et secondaire. (Le récipient primaire contient les
déchets immédiats, le récipient secondaire contient les fuites et les écoulements du récipient pri-
maire. Les deux récipients doivent étre compatibles avec les matériaux mis au rebut et conformes
aux exigences locales, nationales et communautaires en matiére de confinement des récipients.)

. Une fois le récipient a déchets vidé, il doit étre refermé hermétiquement avec le couvercle fourni.

. Caractériser (par une analyse si nécessaire) les déchets générés par les applications, les réactifs et
les substrats particuliers utilisés dans le laboratoire.

. Vérifier que les déchets sont convenablement stockés, transférés, transportés et éliminés en res-
pectant toutes les réglementations locales, nationales et/ou communautaires en vigueur.

. IMPORTANT ! Les matériaux représentant un danger biologique ou radioactif exigent parfois une
manipulation spéciale, et des limitations peuvent s’appliquer a leur élimination.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by the instrument is
potentially hazardous. Follow the guidelines noted in the preceding General Chemical Handling
warning.

WARNING! 4L Reagent and Waste Bottle Safety. Four-liter reagent and waste bottles can crack
and leak. Each 4-liter bottle should be secured in a low-density polyethylene safety container with the
cover fastened and the handles locked in the upright position.

Biological hazard safety
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WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 6th Edition, HHS Publication No. (CDC) 300859, Revised June 2020
www.cdc.gov/labs/pdf/CDC-BiosafetymicrobiologicalBiomedicalLaboratories-2020-P.pdf

. Laboratory biosafety manual, fourth edition. Geneva: World Health Organization; 2020 (Laboratory
biosafety manual, fourth edition and associated monographs)
www.who.int/publications/i/item/9789240011311
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Documentation and support

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
¢ Worldwide contact telephone numbers

* Product support information
- Product FAQs

- Software, patches, and updates
— Training for many applications and instruments
* Order and web support

* Product documentation
— User guides, manuals, and protocols

— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.

Limited product warranty

Life Technologies Corporation and its affiliates warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/
home/global/terms-and-conditions.html. If you have questions, contact Life Technologies at
www.thermofisher.com/support.
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